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Limited Warranty on Media and Replacement

If you discover physical defects in the manuals distributed with an Apple product or in the media on which a software
product is distributed. Apple will replace the media or manuals ar no charge to you, provided you return the item to be
replaced with proof of purchase to Apple or an authorized Apple dealer during the 90-day period after you purchased the
software. In addition, Apple will replace damaged software media and manuals for as long as the software product is
included in Apple’s Media Exchange Program. While not an upgrade or update method, this program offers additional
protection for two years or more from the date of your original purchase. See your authorized Apple dealer for program
coverage and details. In some countries the replacement period may be different; check with your authorized Apple dealer.

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90)
DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentation, APPLE MAKES NO WARRANTY OR
REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALITY,
PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE
IS SOLD “AS IS,” AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND
PERFORMANCE.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the
possibility of such damages. In particular, Apple shall have no liability for any programs or data stored in or used with Apple
products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR
WRITTEN, EXPRESSED OR IMPLIED. No Apple dealer, agent, or employee is authorized 1o make any modification,
extension, or addition to this warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential
damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you
may also have other rights which vary from state to state.

Warning

This equipment has been certified to comply with the limits for a Class B computing device in accordance with the
specifications of Part 15 of FCC rules. Only peripheral devices (computer input/outpur devices, terminals, printers. and
so on) certified to comply with Class B limits may be attached to this computer.

Operation with noncertified peripheral devices is likely to result in interference to radio and television reception.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus set out in the radio interference regulations of the Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique német pas de bruits radioélectriques dépassant les
limites applicables aux appareils numeriques de fa Classe B prescrites dans les réglements sur le brouillage radioélectrique
édictés par le Ministére des Communications du Canada.
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Radio and television
interference

The equipment described in this manual generates and uses radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with
Apple’s instructions—it may cause interference with radio and television
reception.

This equipment has been tested and complies with the limits for a Class B
computing device in accordance with the specifications of Part 15 of FCC
rules. These specifications are designed to provide reasonable protection againsc
such interference in a residential installation. However, there is no guarantee
that the interference will not occur in a particular installation.

You can determine whether your computer is causing interference by turning it
off. If the interference stops, it was probably caused by the computer or one of
the peripheral devices.

If your computer system does cause interference to radio or television
reception, try to correct the interference by using one or more of the following

measures:

m Turn the television or radio antenna until the interference stops.

= Move the computer to one side or the other of the television or radio.
s Move the computer farther away from the television or radio.

m  Plug the computer into an outlet that is on a different circuit from the
television or radio. (That is, make certain the computer and the television or
radio are on circuits controlled by different circuit breakers or fuses.)

m  Consider installing a rooftop television antenna with a coaxial cable lead-in
between the antenna and the television.

If necessary, consult your authorized Apple dealer or an experienced
radio/television technician for additional suggestions. You may find helpful the
following booklet, prepared by the Federal Communications Commission:
How to Identify and Resolve Radio-TV Interference Problems (stock number 004-
000-00345-4). This booklet is available from the U.S. Government Printing
Office, Washington, DC 20402.

Important: This product was tested for FCC compliance under conditions that
included the use of shielded cables and connectors between system components,
It is important that you use shielded cables and connectors to reduce the
possibility of causing interference to radios, television sets, and other electronic
devices. For Apple peripheral devices, you can obtain the proper shielded cables
from your authorized Apple dealer. For non-Apple peripheral devices, contact
the manufacturer or dealer for assistance.



Preface

About This Book

Tle Macintosh Reference is your sourcebook for using the
Macintosh® computer. This manual is a “working reference”
—that is, it provides step-by-step instructions for all the tasks
you are likely to perform with the computer.

No matter which Macintosh model you use, the primary
operations and tasks you perform with the computer work the
same way, and all of them are covered in this book.

One procedure not covered here, however, is the setup of your
Macintosh system. Consult the booklet Serting Up Your
Macintosh for the instructions you need to set up your computer
hardware.

XV
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What you should
know to use
this book

How to use
this book

Complete information
for each task

You can use the Macintosh Reference most efficiently if you are
already familiar with the Macintosh, because this book’s
instructions are concise and specific. If you're new to the
Macintosh (or to using any computer), it’s a good idea to go
through the tutorial book, Getting Started With Your Macintosh,
or the training disk, Macintosh Basics, or both.

But even if you're not familiar with the Macintosh, this reference
book will give you the information you need to perform a wide
variety of tasks. By simply following the prominenty numbered
steps, you can work your way through any task—whether it’s
new to you or a task you've done before for which you need a
quick review.

As noted previously, the Macintosh Reference is organized
according to a variety of tasks that you perform when working
with your Macintosh.

Each task is presented as a set of steps. Each step consists of
boldface text and an illustration, side by side; the steps are
numbered with large numerals.

When you turn to a task in this book, the numbered steps
provide the complete instructions you need to accomplish that
task.

Preface: About This Book



Two ways to locate tasks

Review of

Macintosh fundamentals

Summaries for expanding
vour Macintosh system

A note about illustrations

The tasks in this book are grouped in major categories according
to the work you do with the Macintosh—creating and editing
documents, managing files, printing documents, working with

disks, and so forth.

Two parts of the book will help you quickly locate the tasks you
want to do: (1) the table of contents, which lists the major
categories of information and the names of all tasks, and (2) the
comprehensive index, which lists each task under several
different terms that you might think of in relation to that task.

Chaprer 1, “Standard Macinrosh Operations,” provides a brief
p p p

review of the fundamentals—using the mouse, working on the
desktop, using menus, basic editing, and so on.

If your Macintosh experience is limited, you can use Chapter 1
as a “refresher course” any time you need its help.

Chapter 7, “Using the Macintosh on a Computer Network,”
and Chapter 9, “Expanding Your Macintosh System,” provide
summaries of the procedures involved in adding your computer
to a network and adding new components to your computer
system. The instructions in these chapters are intended for quick
review, and should be used with the documentation for the
components you're adding to your system or network.

Some illustrations of the Macintosh screen include lists of
options, such as the choices available for your Macintosh model
when you install the system software or partition a hard disk. The
lists reproduced in this book may differ from those that appear
on your screen when you perform a task, because the options
available vary from one model to another.

How to use this book xvii
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Some conventions
used in this book

The primary information in this book is presented as step-by-
step instructions for each task. All steps are numbered, and all
actions are described in boldface type.

The Macintosh lets you do many actions in more than one way,
such as choosing a command from a menu or typing a
combination of keys on the keyboard to initiate the command.
This book provides step-by-step instructions for one method
and advises you of other methods.

% Another way to perform this action: Check paragraphs that
begin with this symbol () for alternative methods of taking
an action. **

Because many tasks are related to other tasks, this book contains
numerous cross-references. These cross-references always appear
at the end of the related section, and they are preceded by their
own typographic symbol, an arrowhead. Here is a sample.

P Seealso: * “Changing the Highlight Color™ in Chapter 8

Look for these other visual cues throughout the manual:

Important: Text set off in this manner presents important
information.

A Warning: Warnings like this one alert you to situations in

which you might damage your equipment or lose data if you
don’t follow the instructions carefully. A

Preface: About This Book



About the other
learning materials

The Macintosh Reference is part of the learning materials provided
with your Macintosh. The other books and disks in this set include

the booklet Setting Up Your Macintosh, which provides
instructions for hardware setup for the Macintosh model
you have.

the tutorial book Getting Started With Your Macintosh, which
provides instructions for novice users and explains many of the
concepts associated with using a Macintosh computer.

the training disk Macintosh Basics, which provides hands-on
instruction and practice for new users of the Macintosh. The
training disk and the tutorial book cover much of the same
material; you can use one or both, according to your preferred
style of learning.

the booklet Special Features of Your Macintosh, which describes
the special options and technical specifications of your
Macintosh model.

If you have a Macintosh Portable, you'll find the information
about your computer’s special features in the Macintosh Portable

Handboo.

one or more additional training or information disks, depending
on the Macintosh model.

You can choose from these learning materials as your experience and

information needs require.

About the other learning materials Xix






Chapter 1

Standard Macintosh
Operations

Tm Apple® Macintosh® computer is designed for ease of use
and learning. It presents you with a simulated desktop on your
screen, where you can see and manipulate zeons—graphic
depictions of documents, disks, file folders, and the other parts
of your system and the information you work with. (See

Figure 1-1.)

Folder icon
Application
program icon Hard disk
LT o
TeachText Staffing Hard [rizk
Document Floppy
icon disk icon
Memo 3/12/90 Trash Floppy Disk
Trash icon

Figure 1-1  Examples of Macintosh icons
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Most important, you use about two dozen simple operations to
work with your Macintosh, and these operations are the same
regardless of the program you’re using or the task you're
performing.

This chapter introduces the standard Macintosh operations and
provides bricf, illustrated instructions for performing each one.
If you are new to the Macintosh, you will probably want to use
the wutorial, Getting Started With Your Macintosh, or the training
disk, Macintosh Basics, before reading this chapter. If you are
familiar with the Macintosh, you may want to review this
chapter before beginning your work.

You use the mouse—a kind of pointing device—to initiate most
operations-on the Macintosh. When you move the mouse on
vour desk, a corresponding pointer—such as the arrow pointer
makes the same movement on the screen.

or I-beam pointer

(See Figure 1-2.)

Figure 1-2 Mousc and pointer movement

Chapter 1 Standard Macintosh Operations



To initiate an action with the mouse, you place the pointer
where you want the action to take place, then press and release
the mouse button (the mechanical button near the top of the
mouse). This action is called ¢licking. (See Figure 1-3.)

Figure 1-3  Initiating an action with the mouse

Pointing  Pointingis simply moving the pointer onto an object or area on
the screen.

To point, first grasp the

mouse and slide it across
the table top, as you watch
the pointer on the screen.

The pointer’'s movement
corresponds to that of the
mouse.

Using the mouse

o



2 Continue moving the

mouse until the tip of the
.Y pointer is on the item you

Project want.

If you run out of room, you
can pick up the mouse and
place it at another spot. The
pointer on the screen will not
move while the mouse is off
the pad or other surface.

Clicking Clicking initiates an action at the pointer’s location.

To click, first point to
a > an object on the screen by

moving the mouse.

\/ 2 Without moving the

mouse, quickly press and

« “Z  release the mouse button with

your index finger.

Chapter 1: Standard Macintosh Operations



Double-clicking — Double-clicking is a way to display the contents of an icon or
document or to start an application by opening a window for it.

0

1 To double-click, first
point to an object on the
screen by moving the mouse.

Without moving the

mouse, press and release
the mouse button twice in
rapid succession.

Dragging an icon  Dragging allows you to move an icon on the screen as you move

the mouse.

TeachText

Using the mouse

graphics
s

stacks

To drag an icon, first
1 point to the icon you
want to move and press and
hold the mouse button.

The object becomes
highlighted when you press the
mouse button; that is, its
appearance changes, usually
from outline form to solid
black (or other color).

il
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Move the mouse while
— continuing to hold down
the button.

An outline of the
icon heing dragged
shows its movement.

graphics
Vi

An outline of the icon moves
The highlighted
icon stays in its

original position TeachText
while you drag. 3

with the pointer, indicating the

location of the icon as you drag,

Release the mouse
The highlighted

- N button when the move
object jumps to

4 new position A 18 COmplete.
when vou release TeachText
the mouse bution, . The object remains
Fapes highlichted when vou
— ghlig )
release the burton.
stacks

Selecting an icon Selecting designates an object for action. When selected, the
or other object — object appears highlighted.

To select an object, first
point to the object you
want to select.

backup 2/4./20

2 Click the object.

When you press the mouse

button, the object becomes
highlighted to show thac it is
selected.

P Coubor & “Changing the Highlight Color™ in Chaprer 8

Chapter 1: Standard Macintosh Operations



Selecting multiple icons or - you can drag the pointer to select a group of icons or other
objects in one area objects thar are located in one area of the screen. A dashed
rectangle indicates the arca covered as you drag.

R To select multiple
objects in one area, place
the pointer near one edge of
addresses the group of objects, then

drag diagonally over them.

A dashed outline encloses the

objects as vou drag across
them. Dragging diagonally

from one corner of the area is

most efficient.

e i — - Release the mouse
button when the objects

I
I
}
I you want to select are
I . l . -d
i completely or partially inside
addresses : the dashed outline.
I
I
I
I
|
I
I
|

1

When you release the mouse
burtton, the selected objects
become highlighted.

* Dragging is also used for: (1) selecting a group of items
together in a list; (2) selecting text when editing; and

e

(3) choosing a command from a menu.  *

> See also: * “Basic Editing on the Desktop” in this chaprer
* “Using Menus” in this chaprer

Using the mouse



Selecting multiple objects  You can select objects that are not near each other by clicking
in separate areas  each one while holding down the Shift key (called Shift-clicking).

To select multiple

objects in separate areas,
press down the Shift key (on
either side of the main
keyboard area).

While holding down
= the Shift key, click each

= object that you want to select.
budgeta0

Each object becomes
| highlighted when you click it.
Project Clicking an already-selected
TeachText object with the Shift key held

down deselects (removes the
highlighting from) that object.

< Shift-clicking is also used for: selecting multiple items in
separate places when the contents of a window are displayed

-,

as alist.

Chapter 1: Standard Macintosh Operations



W()fking OI1  You use the standard mouse operations to manage the objects on
[he deSk[Op the desktop. Most icons can be opened as windows, and you can

have multple windows displayed at the same time. You can also
move the windows, change their size, and change the window in

which you are working. (See Figure 1-4.)

Icon dimmed.
indicating that it’s
open, and
v highlighted,
indicating that its
L window is active

Zoom box (used to open
window to full sizes

Close box (used to

close window) o= IR ﬁ.
12 items 11,498K in disk 7,521K available

Title bar (used 1o =

move window: El
lines show that Systarm Foldir Apetisaioen Prag o
window is active) (]

1 fcon dimmed,
indicating that

For Channing Hotes-Kate j[.ﬁ ()PCH
lﬂ__l 134 avalable ||
From Andy
Sarab's report ! 4 Inactive window

showing contents of

Chooser /priport
: the =art” icon

Active window displaying Size hox (used 1o
contents of “Trees™ icon change window size)

Figure 1-4  Two open windows on the deskiop

Opcning an icon  The quickest way to open an icon is to double-click it.

To open an icon, first

ﬁ point to the icon.

Froject

Working on the desktop
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2 Double-click the icon.

If the icon does not open, you
may not have clicked quickly
enough. Double-click again,
with the second click
following the first as rapidly as
possible.

@ Another way to open an icon: You can also select an icon and
use the Open command in the File menu. — «

» Seealso:  *"Setting the Double-Clicking Speed” in Chaprer 8
Moving a window  You drag a window’s title bar to move the window.

1 To move a window,
point to the window’s title

bar and drag,.

1
I
fl
3
3
n

The pointer and an outline of
the window move as you drag,
FROM: Program direc  indicating the new location.
The window remains in its

original position until you
complete step 2.

Outline of __{ Release the mouse

the window

button when the outline

EDE Memo

reaches the location you want.

The window moves to the

TO: All Staff location of the outline when

FROM: Program diree  you release the button,

Chapter 1: Standard Macintosh Operations



RCSiZing a4 window  You use the size box in the lower-right corner to change a

window’s size or shape.

Outline of
the window

Working on the desktop

To resize a window,
point to the size box in
the lower-right corner and

drag.

Dragging vertically changes
height; dragging horizonrally
Ch;lngcs width; dragging
diagonally changes both
dimensions. The pointer and
an outline of the window’s
borders move as you drag,
indicating the new dimensions.

Release the mouse
button when the outline
indicates the size you want.

The window changes to the
size of the outline when you
release the butron.



En]l“}lm“l a4 Window  The zoom box at the right end of a window’s title bar offers a
to full size quick way to resize a window to its largest standard size (it
covers most of the screen).

1 To enlarge the window
to full size, point to the
zoom box at the upper-right

corner of the window.

1,636K available

Click the zoom box
& to expand the window.

To return the window rto its
previous dimensions, click the
zoom box again.

Making a window active  The active window is where your actions take place. When two
or more windows are displayed, only one of them can be active
at a tme.

You can tell an active window by the horizontal lines in its
title bar.

To make a window

EIE} active, first place the
1,636K available |3 . here inside th
ez nd  Ppointer anywhere inside the
window.
pha & )
A Any part of the window

will do, even if most of the

q . P
window is hidden.

Chapter 1: Standard Macintosh Operations



Click in the window
to make it active.

The window moves to the top
layer on the screen. Lines
appear in the title bar.

% Another way to make a window active: 1f you can’t see the
window you want to make active, you can double-click the
icon it belongs to. (You may have to make the currently
active window smaller to see the icon.)

Closing a window  You use the close box in the upper-left corner to close a window.

] [TI]

=————— To close a window,
E point to the close box at

78 items the upper-left corner.

Application Programs

Click the box

to close the window.

The icon remains selected after
the window closes.

% Another way to close a window: You can use the Close

-,

command in the File menu to close the active window.

Working on the desktop 13
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!)Escarding AN ICON  You can clear an icon from the desktop by dragging it to the
Trash, located at the bottom-right corner of the desktop. To
erase that icon’s content, however, you have to choose the Empry
Trash command from the Special menu.

A Warning: The Trash is emptied automatically when you shut
down or turn off the computer, when you start a program, or
when you eject a floppy disk from which you discarded any
items. A

Teon outline (shows movement) To remove an icon, first

drag the icon over the
Trash so that the Trash icon is
highlighted.

Selected icon

Highlighted

Trash container
(shows the pointer S
has reached iv :

The pointer and an outline of
the icon move as you drag; the

Trash icon becomes highlighted

The pointer must touch the icon for when the pamter reaches ir.

the Trash to accept the item.
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Trash

Special
Empty Trash
Trave sk
Set Startup...

Release the mouse
button when the Trash
icon is highlighted.

When you release the button,
the Trash icon bulges to show
that something is inside it; the
icon is no longer highlighted.

If you change your mind,
simply open the Trash as you
would any other icon, and
drag the icon you discarded
back to its original window.

To erase the contents,
choose Empty Trash from

the Special menu.

Once you empty the Trash,
the discarded icon and its
content are gone.

If you attempt to throw away a program or a locked document,

you'll see a message on the screen. You have to confirm that you

want to throw away any unlocked program, and the system
won't let you discard a locked document or a program that’s

currently being used.

+ Another use for the Trash container: You can eject a floppy
disk from a disk drive by dragging the disk icon to the Trash.

This action does not erase the disk. =

°,

P Seealso: “Ejecting a Disk From the Desktop” in Chapter 6

Working on the desktop



Vl@W’II’]g When you're working within a window, you can easily change
(_ l. . .
| your view of the content by scrolling. The amount you see in
the content . . _ . E . o
the window at any one time depends on the window's size. (See

Of d WindOVV Figure 1-5.)

® File Edit Uiew Special
= Trees

12 items 11,498K in disk
B = Scroll box
Swmr Apcation Frogrims (shows relative
D location in window’s
For Channing  TlesKate = ttal content)
B 2K indisk 134K availsble |-
From Andy o -
Sarah's report D ]
R'Qm ‘ <;,¥ " Chaoser Tpr tpert
El TeachText
For Mirnd
Seroll arrow 1]
(used o view the
content beyond the Every window has two scroll bars, one for vertical scrolling and
window’s borders) one for horizontal serolling. (For both, gray indicates more content

beyond window’s borders: clear bar indicates all content is visible,)

Figure 1-5  Scrolling areas in an active window

Scrolling through  You can see the complete content of a window by scrolling
a window through it. To scroll continuously, use the scroll arrows.

The up arrow displays content above the window’s top border;
the down arrow displays content below the window’s bottom
border. The left and right arrows display content to the left and
right borders of the window, respectively.

16 Chaprer 1: Standard Macintosh Operations



b=
1 ,636K available
 BEEEH|
Accounts
1|
1 ,636K available
Accounts

.,

To scroll through the

content of a window, first
place the pointer on one of
the scroll arrows and hold
down the mouse button.

The window’s content moves
to show the part that had
previously been beyond the
border in the direction the
arrow points. The scroll box
also moves in the direction of
the arrow.

Release the mouse

button when the part of
the content you want is
visible.

*  Another way to use the scroll arrows: Simply clicking a scroll

arrow scrolls in increments of about one-half inch.

Viewing the content of a window



Scrol]ing tod SPL’L‘iﬁL‘ part  You use the scroll box to see the window content corresponding
of a window  to the box’s position in the scroll bar. For example, when the
scroll box is near the bottom of a window, you'll see what’s near
the end of the window’s content.

To scroll to a specific
part of a window, drag the
1,636K available scroll box in the direction of

[

Accounts

the content you want to see.

The pointer and an outline of
the scroll box move as you
drag.

Release the mouse
=l button when the scroll
1,636K available box is where you want it.

The scroll box appears in the
PP
position where its outline had

At dept.
been when you released the

butron, and the window’s
content moves to reveal new
content.
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Scrolling the length or  If the right or bottom scroll bar is white, then the entire content
width of a window  of the window vertically or horizontally is visible. But if the scroll
bar is gray, then there’s more to see. A gray scroll bar is active, and
you can click in the gray area to see content beyond what's visible.

= To display the next
HIE

screenful of content, place
the pointer in the gray area
on the side of the scroll box

206K available

' where you want to see items
Ta Do that are not presently visible.
e 2 Click once to display
- the next windowful of
206K available

content.

When you click, a new
windowful of content is
displayed and the scroll box
moves to a new position.

Done

o,

@ Another way to see more of a window'’s content: Resizing the
window to larger dimensions, if possible, displays more of its
content. **

Viewing the content of a window 19



LSIHg MENUS  Another of the standard Macintosh operations is using menus.
Whether you are working on the desktop or in a program, you
Use menus in a consistent way.

In addition, certain menus and core commands are provided as
part of all Macintosh software. These core elements include the
Apple, File, and Edit menus and commands such as Cut, Copy,
and Paste. (See Figure 1-6.)

Menu titles

- l l *EE Y Menu bar
2 H — et "7 U "
O ccaalilet | i T Trieme o ears Bl (menus pulldown
(not available) i I ]
i 5 B2 from here)
: Copy #C
TO
FRo. | Paste ®U
Edit menu Clegy M |
e Menu commands
||)U]|L'\| down) ¥e are ha select Al #A g .‘Tl Hant
kis, whig ~===""" TV atfect whatever
Please col_Show Clipboard i o noed sdditionsl copres of the kit you've selected—

in this case.
text 1o be edited.

el

Figure 1-6  Menu bar with the Edit menu pulled down
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Pulling down a menu

Choosing a
menu command

The principal type of Macintosh menu is called a pull-down
mentt.

-

% File Efgt View 1 To pull down a menu,

first point to the title of
the menu you want in the

menu bar at the top of the

screen.
Press and hold the
se button to open

i s mouse bu p

the menu.
= vih The menu closes when you
S o release the mouse button
Paste e || g : :
Clear
Select All %A
Show Clipboard

You choose a command with the menu pulled down.

1 To choose a menu

fidain command, first pull down

the menu by pointing to its

cut % H title and holding down the
Copy %C mouse button.

Paste 3D

Clear

Select All #A

Show Clipboard

L'sing menus 21



Menu title —m 2 Drag the pointer to the

Dimmed commund — e command you want.
(unavailable)

As you drag, a command that

Highlighted LUt %H is not dimmed becomes
c )m‘n‘l;mxl e highlighted when the pointer
iee Clear is on it. (Dimmed commands
Select All %A are not available and thus
cannot be chosen.)
Show Clipboard
Release the mouse button
%— 3 to choose the highlighted
command.
Blinking indicates The command blinks in the
that the command Paste Sl menu, then the menu closes
has been chosen Clear and the command takes effect.
Select All %A
Show Clipboard

.,

«  Another way to choose a command: Many commands have a
keyboard equivalent, usually made up of the Command key
(indicated by a propeller symbol), which is held down with
one other key. Each of these keyboard shortcuts is displayed
to the right of the command it represents in the menu.

»  Seeabo: o “Using Special Keys and Indicators on the Keyboard” in this
chapter
* “Adjusting the Blinking of a Selected Menu Item” in
Chaprer 8
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Using a submenu

Submenu indicators

Some menus have submenus associated with them. You use a
variation of dragging to choose commands from the submenus.
A submenu is indicated by a small black triangle pointing to the
right, next to the command name. The submenu is displayed
when you drag over the menu item to which it is subsidiary.

To use a submenu,

Style'’ b | first pull down its
Justify 4 corresponding menu.
Spacing L_p i
A small triangle at the right of
0 peind a menu item shows that the
10 item has a submenu.
12

2 Drag the pointer to the

item with a submenu you

. vPlain want to open.
Justify Bold
Spacing Fratic When the item is highlighted
.............................................. i il in the menu. the submenu
Logomt | guilioe | opens.
12 Shadom

Drag diagonally onto
the submenu until the
command you want becomes

highlighted.

Bold
fiefic
Underline
® polot Dutline

Shadom

Justify
Spacing P

Using menus 23



Release the mouse
button to choose the
highlighted submenu

Blinking indicates dl.lStl_fl_:[ Bold
that the command Spacing  p[E=onr command.
Wisheenelionef. o bt

Underline The command blinks in the

0 peint o)
miline
A0 submenu, then the submenu
S
12 Shadem and menu close and the

command is initiated.

Using @ pop-up menu Pop-up menus are similar to pull-down menus, but they don’t
reside in the menu bar. A common example is the pop-up menu
that indicates levels of folders on a disk, in the on-screen box
called a directory dialog box with which you sometimes open and
save documents. (Sce Figure 1-7.)

Bold shadow indicates that
Pop-up menu (closed) this is 1 pop-up menu.

Select a Document: /
lcon indicating _—WI |
an open folder -
[ ABA 6/90
3 ALA 10/90
O Mkt analysis
[0 New policy

— Main Disk
12478K available

[cancel] ( prive |

Figure 1-7 A pop-up menu in a directory dizlog box

This type of menu is used in some programs to choose settings
or variables such as color or units of measure.

A pop-up menu can extend above or below its title, and some
extend in both directions. The item displayed as the menu title
is the item that is currently in effect.

24 Chapter 1: Standard Macintosh Operations



To use a pop-up menu,
Select a Document: first point to the menu’s

Closed pop-up

e Speh [= Speechesl title and hold down the

folder icon) mouse button.

The menu opens, showing
some or all of the items
available. (Some pop-up
menus extend up as well as
down from the title; you drag
upward to see the additional
items in such menus.)

Drag the pointer to the
Select a Document: item you want in the

Open pop-up menu

5] Speech pop-up menu.
Levels of files o 1+ To Do

— Main Disk

S

The item becomes highlighted
when the pointer is on it.

which the open

folder is subsidiary

Release the mouse
Select a Document: button to select the

highlighted item.
S HLEL, The pop-up menu closes and

= Main Disk

the item selected now appears

as the menu ritle.

P Seealso:  *“Moving Quickly Through Levels of Folders When Using a

Program” in Chapter 5

Using menus 75
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RGSPondlng [O  The Macintosh has several standard ways of displaying messages
messaoes on  on the screen. The most common form of message is a dialog

e box, which requires that you choose an option or supply needed

the screen information before the Macintosh does what you want it to do.

Some of the most frequently used commands on the Macintosh
present dialog boxes. You can readily spot such commands,
because their names are followed by three dots in the menu. For
example, the Open command in the File menu displays a
directory dialog box, which shows a list of the files on the
current disk or in the open folder. (See Figure 1-8.)

Bold border on 2 button indicates the
choice if the Return key is pressed

Select a Document:
Disk name —.
(this is & pop-up -
menu that shows O Letter to Mom — BD’s disk
0 My Expenses 3292K available

rojects i

List box (used to i e-remodel ll UDE"RE
\L'it_'(‘i a document 3 Remodel plans :
or folder to open) | |& system Folder
l‘ O Utilities Folder

the file levels)

; ___ Buttons for option
[Cam:el] [ Drive ] (to open selection
’ in list box; change
disk drives; eject
disk: or cancel
Open commanc)

Figure 1-8 A directory dialog box

»  Seealso: “Using Menus™ in this chapter
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Using a dialog box

You select items and choose options in a dialog box with

standard operations—scrolling, pointing, and clicking. Here’s
how you would use the directory dialog box to open the
document “Projects” in Figure 1-8.

Select a Document:

D Letter to Mom

[ MacinTas Expenses
D Projects

3 Quotes-remodel

1 Remodel plans

3 System Folder

2 Utilities Folder

— BD’'s disk
3292K available

Select a Document:

D Letter to Mom

[ MaclinTas Expenses
0O Projects

OO Quotes-remodel
[ Remodel plans
O System Folder
[ Utilities Folder

— BD’s disk
3292K available

To use the directory

dialog box, first click the
name of the document or
folder you want to open.

The name appears highlighted
in the list when you select it.

2 Click the Open button.

The dialog box disappears and
the item you selected opens.

“ Another way to open a document or folder: Double-clicking the
name of a document or folder in the list opens it.

Responding to messages on the screen

[ S
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Using alert boxes

Another type of dialog box, the alerr box, is designed to keep you
from mistakenly losing some of your work or discarding an
application program. Its message warns you that you may be
doing something you didn’t intend and asks that you confirm
that you want to go ahead with the action.

Many alert boxes also add a sound to warn you of a possible
mistake.

If you drag a program icon to the Trash (thereby discarding it),
you'll see an alert box like the one in the following steps.

To use an alert box,
Are you sure you want to remove the 6 d h
application "TeachText"? 1rst read the message
displayed and make sure that
ok ) [Concer) you want to complete the
action you initiated.

Click the OK button to

complete the action, or
click the Cancel button to
cancel the action.

I3

b

* Return key shortcut: You can press Return instead of clicking
the OK button. (Pressing Return initiates the action for the
button with a bold outline.)

P Seealso: » “Setting the Alert Sound™ in Chaprer 8
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Basic edltlng The Macintosh has a number of standard editing capabilitics,
: which you can use on the desktop or in an application program.
on the desktop el ; PP Prog
These built-in features allow you to change disk and document
names with case, to copy text or graphics between programs, and
to save frequently used information for quick retrieval.

This section introduces the fundamental text-editing operations
you can use on the desktop or in programs.

P Seealso: e “Editing Documents”™ in Chapter 3

Changing all of ~ You can easily change an icon’s name.
an icon’s name

1 To change an icon’s
name, first select the icon

by clicking it.

28 backup

Selecting the icon also selects
its entire name.

2 Type a new name for
the icon.

Insertion point When you begin typing, the

(blinking) drchives 1 4"'9[1

new text appears in place of
the old. The insertion point—
a thin vertical line that marks
the place of current activity—
blinks at the end of the text
you type.

Basic editing on the desktop 29
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Selecting part of the
text in an icon’s name

I-beam pointer

Place the pointer
anywhere outside the icon

and click.

archives 1790 When you move the mouse,

the pointer reappears. When

h

you click, the insertion point
disappears and the icon is
deselected.

w  Another way to save an icon’s name change: Pressing the
Return key after typing new text for an icon’s name saves the
change; the icon remains highlighted. <

You use dragging to select part of an icon’s text. Dragging across
text is the way you select it in application programs as well as on
the desktop.

: 1 To select part of the text
in an icon’s name, first
select the icon by clicking it.

From John

2 Place the pointer over

the name.

When you place the pointer

Florn John & Jim over the text portion of the

icon, the arrow changes to an
[-beam—a vertical symbol that
resembles a capital letter T

Chapter 1: Standard Macintosh Operations
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Fram m & Jim

Frarm Mir'n

Position the I-beam
3 just to the left of the first
character in the section you
want to select, and press and
hold the mouse button.

Drag the I-beam over
the part of the name you
want to select.

Release the mouse

button when the I-beam
is just to the right of the last
character in the part you want
to select.

@ Selecting and deselecting text: When you’re editing text other
than icon names, you can extend selected text one character

by pressing Shift—Right Arrow, and you can deselect one
character by pressing Shift—Left Arrow. Repeat these actions

as necessary to change the amount of text selected. 4

Basic editing on the desktop

2,

31
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Replacing selected text  you simply type over selected text to replace it.
in an icon’s name

To replace selected text,

= first select the text you

want to replace.
station gy
Type the new text you

= want to replace the

selection.
Insertion point T :
(blinking) stationery The selected text disappears as

you begin typing. The
insertion point blinks at the
end of the new text you type.

Place the pointer

anywhere outside the icon
and click.

k stationery When you click, the insertion

point disappears and the icon
is deselected.

oo

* Another way to save an icon’s name change: Pressing the
Return key after typing new text for an icon’s name saves the
change; the icon remains highlighted.

Chapter 1: Standard Macintosh Operations



Deleting selected text  You use the Delete key to remove selected text. (On some
from an icon’s name keyboards, this key is labeled Backspace rather than Delete.)

1 To delete text from an

icon’s name, first select

London I

the text you want to delete.

Press the Delete or
2 Backspace key to delete

o . the selected text.
Insertion point

(blinking) London|

The selected text disappears;
the insertion point blinks at
the place where text was

deleted.

Place the pointer
s anywhere outside the icon

k and click.

When you click, the insertion
point disappears and the icon
is deselected.

London

o Another way to delete text: You can also use the Cut command
or Clear command in the Edit menu to delete selected text.
Cur removes text and places it in the computer’'s memory in
an area called the Clipboard, from which it can be pasted
elsewhere. Clear simply removes the text.

» Seealso:  *"Deleting Textand Images”™ in Chaprer 3

Basic editing on the deskiop 33
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Inserting text in You can easily insert text without deleting what's already there.
an icon’s name

To insert text in an
_____ icon’s name, first select
the icon.

Invoice 1271 /89

Place the I-beam pointer
at the spot in the name

. where you want to insert text
Insertion point - .

(blinking) Invoice (121 /29 and click.

A blinking insertion point
appears at the spot where you
clicked.

3 Type the text you want

to insert.

Insertion point As you type, the text on either
(blinking) Invoice #2[12/1 /89 4

g side of the insertion point
Inserted text

moves to make room for the
new characters.

Place the pointer
Y anywhere outside the icon
and its name and click.

S P " 7 &
Invoice #2 12/1/589 When you click, the insertion
point disappears and the icon

is deselected.
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USlﬂg the You can change many of the standard settings for your
Control Pane] Macintosh by using the Control Panel. This panel operates as a
desk accessory, a “mini-application” that is available no martter
what other work you're doing with the computer.

The Control Panel has several different sections; the ones
included with your system depend on the model of the
Macintosh you use. For example, if you have a Macintosh Ilci
with a color monitor, you will have sections of the Control Panel
for the monitor and for color, as well as the standard sections for
the keyboard, mouse, and general settings.

Figure 1-9 shows the General Control Panel.

ST=——= Control Panel —r——

The selected icon —_1___ @ 5]

Rate of Insertion
Point Blinking

il
O ®

indicates the

section in use—

the General section. Desktop Pattern
Slow Fast
Keyboard Menu Blinking | Time ®
UThEI’ I(:'(lﬂﬁ p— = 52049 M
represent secuons = g
of the Control Panel =] @12hr. (324 hr.
available for this
B Mouse =
Macintosh. O QO @ |Date ‘E'
off 12 3 7/29/90

(5] RAM Cache # E) ® | Speaker
n

off Yalume

Figure 1-9  The General Control Panel
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Control Panel actions The settings you can adjust in the Control Panel include:

Opening the
Control Panel

) See a !J{l.'

pattern and colors on the deskrop

speed of blinking of selected menu items

speed of blinking of insertion point for editing

date, time, and display of time as 12-hour or 24-hour clock

speaker volume

size of RAM cache

rate of character repetition when a key is pressed

movement of the pointer from one monitor to another

disk drive to be used for startup of system

sound to be used for warning from system

* "Basic Editing on the Deskrop™ in this chaprer

* “Specitying ltems to Be Opened at Startup™ in Chapter 2
* “"Adjusting the RAM Cache” in Chaprer 3
* “Installing a Desk Accessory™ in Chaprer 8

Like other desk accessories, the Control Panel resides in the
Apple menu at the far left side of the menu bar.

Chapter 1: Standard Macintosh Operations

HbSut the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
DiskInfo

To open the Control

Panel, first open the
Apple menu at the left side of
the menu bar.

»



Changing sections
of the Control Panel

Drag the pointer to
the Control Panel
command, then release the

mouse button.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

The Control Panel appears. The

General section of the Conrrol
Panel is always shown initially.

You change Control Panel sections by selecting the icon for the part
of the system you want to adjust at the left side of the panel.

To change sections of

the Control Panel, first
scroll if necessary to locate the
icon for the section you want.

E0

Click the icon of the
= Control Panel section you
f want to display.

When you click, the section of

Monitors the panel represented by the

icon appears.

@ Special sections of the Control Panel: 1f your Macintosh model has
its own special section of the Control Panel, refer to the Special
Features booklet or the Handbook that came with your computer
for details on using that panel.

Using the Control Panel 37
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Changing settings  For most seceings, you click a button to make a change.

in the Control Panel , , _ _
A few settings, such as time and date, are adjusted by selecting

one of the existing numbers (the hour or month, for example)
and then using small up and down arrows to change to the
desired number.

You adjust the speaker volume by dragging the bar up or down
the numeric scale.

Figure 1-10 shows the adjustments in the General Control Panel.

Clicking saves the
pattern displayed.

Clicking arrowheads
displavs a new
pattern.

3 Rate of Insertion

Foint Blinking

Clicking edits
the pattern,

Desktop Pattern C, @ D__.__ Buttons adjust the

By Eiot blinking rate.

| Buttons select the
12-hour or
24-hour clock.

lick | IMenu Elinking | Time @
Clicking 1 number :
displays arrows for = 9:20:49 Pl

. ] o ! v
adjustment. E @ 12 hr. O 24 hr.

Date @

S 7/29/90

Dragging adjusts the
volume level.

Buttons adjust the |
number of blinks. off 1

O = N s -
1

Clicking a number

N
RAM Cache ) @ | Speaker displays arrows for

On  Off Yolume adjustment.

Arrows adjust size of
the RAM cache

Figure 1-10  Adjustments for settings in the General Control Panel

P ook b “Adjusting the RAM Cache” in Chaprer 3
* Chaprer 8, “Personalizing Your Macintosh Work
Space”

Chapter 1: Standard Macintosh Operations



USlng [he ChOOS@T The Chooser is a desk accessory, supplied with the system
software, that you use to specify which printer you will use. You
also use the Chooser to select devices such as file servers on the
AppleTalk® network system and to adjust some settings related
to printing and network use. (See Figure 1-11.)

Close box 7 Chooser  ————  Names of available
=== 5| : Select a Laserwriter: devices (when type
i"-‘f | | [Accounting _l 3] of ldn'i\;me is selected
e Human Resources atlet
AppleShare m k
External devices | Marketing J
available Sales |
= 84 Option available
Background Printing: 3 On @ Off4— with MuliiFinder
AppleTalk Zones:
CC4 Upper % User Mame: Your name
. - CC4-5th/North | (up[ionall
Zones (ill)pl.':ll' if CC4-5th/South . el ]
several networks are CCa-6th/Morth e @ Active—— 1 AppleTalk must be
linked together) CC4-6th/South PRIETAIK  ~ Inactive active 1o use
external devices on
the AppleTalk
Figure 1-11  The Chooser network system,

Opening the Chooser Like the Control Panel, the Chooser is a desk accessory.

To open the Chooser,

first open the Apple menu
at the far left side of the menu
Alarm Clock bar.

Abbut the Finder...

Drag the pointer to the

: Chooser command, then
About the Finder...
release the mouse button.

Alarm Clock
Calculator

The menu closes and the
Chooser appears.

Chooser
Control Panel

Using the Chooser 39



Selecting a printer or other
device in the Chooser

LaserWriter is
the type of
device selected,

The network zone in
which a LaserWriter
will be selected

Sales is the name of
the printer selected.

40

You designate a printer or other device by selecting its icon, its
location (if necessary), and its name in the Chooser.

il
o]

AppleTalk .. Imagewriter

Select the type of device

you want to use by
clicking its icon in the upper-
left area of the Chooser.

3|

i=—il
_-l

L | HANEE

Laserwriter N .prleT:al...

AppleTalk Zones: [f necessary, select the

CC4 Upper
CC4-5th/North
CC4-5th/South

zone in which you want
to use a device by clicking its
| | name in the lower-left area of

the Chooser.

CC4-6th/Morth
CC4-6th/South

The list of zones appears only
if your Macintosh is on a
network that is linked to other

networks.

Select the specific

device you want to use by
clicking its name in the list at
the upper-right area of the
Chooser.

Select a LaserWriter:

Accounting
Human Resources
Marketin

It's a good idea to close the
Chooser although you can
leave it open.

Once you've selected the name of a device, such as a
LaserWriter®, your Macintosh will use that device until you
select a different one with the Chooser.

Chapter 1: Standard Macintosh Operations



Adjusting Chooser settings

Setting for
background printing
(available only when

using MultiFinder)

You also use the Chooser to adjust three settings that relate to

using a printer or a network device. You can

= make AppleTalk active or inactive

m turn background printing on or off (for MultiFinder™ use)

m cnter or change your uscr name

Figure 1-12 shows the adjustments for these settings.

EO=

(hooser

K5 Select a Laserwriter:
B Accounting i
AppleShare T Human Eesources
Marketing
Sales | |
| [
%4 i
Background Printing: O On ®0ff
AppleTalk Zones:
CC4 Upper 5] yser Name:
B
CC4-5th/South . =
CC4-6th/Morth @ Active
CC4-6th/South ApAMEalk ‘:O Inactive

L User name: some
network devices
automatically use
the name in this

Settings for AppleTalk

(must be active to use

network devices)

Figure 1-12  Adjustments for settings in the Chooser

space (if one is
supplicd).

Once you've adjusted a Chooser setting, your Macintosh

maintains that setting until you change it.

> See also: = “Managing Multiple Programs Using MultiFinder”

in Chapter 3

o “Printing While Using the Computer for Other Work”

in Chaprer 4

* “Preparing the Macintosh System Software for

Networking” in Chapter 7

¢ “Gaining Access to an AppleShare File Server” in

Chapter 7

Using the Chooser



USing SpeCial keYS The Macintosh keyboard resembles a typewriter keyboard, but

and indicators gn soweof sleyshave special pusposes. These special keysund
the keyboafd their primary uses are summarized in Figure 1-13.

‘ - Escape key—used for special | Power On key—
€SC | purposcs in some programs. L)L | s on the Macintosh,
p - S = ==
[ ] Function key—cach of these can' D lighsd }
‘unction key—uach of these can be dghts that are on when a
F1 ; ; : ; num caps scroll "8 :
) assigned a command with a special program. ocking key is engaged.
\F1 gned nd witl | prog lock lock lock  locking key is engaged
\‘ Control key—works in combination with ‘ Enter key—used in some programs:
- other keys to provide shortewts and often has the same function as the
control Sl ,
Lo madify other actions, : enter, Return key.
= Option key—used i hinati -
!]l] n]!\c )k used in c((J)mI ination : Delete key—used to
: W OMer Kevs 1o }auce s
option RIEORICE Y0 s | delete | delete selected items.
: - special characters. - /
‘a —  Commuand key—used in o Arrow keys—move the
(% ge | combination with other | (Y ) insertion point; often an
5 o 3 i ;
\ J keys to initiate commands. ; e ¥ [ - alternative o the mouse,

Figure 1-13  Special keys and indicators used on Macintosh keyboards

The location of special keys varies on the different keyboards
available for use with Macintosh models; some keyboards do not
include all of these special keys and lights.

» Secalso: Appendix A, “Keyboards and Character Sets”
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Tlll'ning the All Macintosh models have a power switch on the back of their
MaCintOSh cases. The location of the switch varies among different Macintosh

models, however, and the switch is not the principal method for

on and Off turning some models on and off.

Power switch locations  On compact models—models with a built-in monitor—the
power switch is located at the right rear side of the compurer. (See

Figure 1-14.)

/| Power switch

Figure 1-14  The power switch on the Macintosh SE/30

Turning the Macintosh on and off



Turning on a compact
Macintosh model

On modular Macintosh models—models with separate
monitors—the power switch is located on the left rear side
of the computer. (See Figure 1-15.)

Power switch
Figure 1-15  Power switch on the Macintosh Ilci

One type of Macintosh, the Macintosh Portable, does not have a
power switch. It operates on battery power.

You turn on a compact Macintosh model with the power switch.

Tirning on an external hard disk drive: 1f your system has an
external hard disk drive, you must turn the external drive on
before you turn on the Macintosh. Otherwise, the Macintosh
will not recognize the external drive.

» Secalso:  * “Troubleshooting” in Chaprer 10

Chapter 1: Standard Macintosh Operations



Turning on a modular

Macintosh model

Turning off the Macintosh

The recommended way to turn on most modular Macintosh
models is by pressing the Power On key on the keyboard. This key
is located at the top of the keyboard and has a triangle symbol on it.
On some keyboards the Power On key is rectangular; on others it is
square. (See Figure 1-16.)

Power On key, ’m\u On key,
top center of keyboard top-right corner of keyhoard
Figure 1-16  The rectangular and square Power On keys

It the Power On key does not work for your model, use the power
switch on the back of the computer to turn the Macintosh on.

< Turning on an external hard disk drive: 1f your system has an
external hard disk drive, you must turn on the external drive
before you turn on the Macintosh. Otherwise, the Macintosh
will not recognize the external drive.

» Seealo: o “lroubleshooting” in Chapter 10
* Appendix A, “Keyboards and Character Sets”

The recommended way to turn oft all Macintosh models is by using
the Shut Down command in the Special menu. This command
signals the system software to prepare all files and disks in use for
shutdown.

The Shut Down command also turns off power in some Macintosh
models. In other models, this command prepares the system for
shutdown and then displays a message that the computer’s power
switch can now be turned off.

P Seealo: ¢ “Shutting Down the Computer” in Chaprer 3
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Starting Up

Sctting up your computer has two phases: the first is
assembling the hardware components; the second is preparing
the system soffware, which the Macintosh uses for its basic
operations.

This chapter provides instructions for preparing the system
software to work efficiently with all devices in your Macintosh
system.

[f your system has a hard disk drive, you may want to review
“Installing System Software,” “Creating a Customized System,”
and “Specifing Items to Be Opened at Startup,” later in this
chaprer.

If your system has only floppy disk drives, you will probably
want to review “Installing System Software,” “Making an Extra
Startup Disk,” and “Creating a Small System.”



Preparing the
Macintosh hardware

Preparing your
system software

The precise steps in setting up your Macintosh hardware depend
on which model of the computer you have. The setup guide,
Setting Up Your Macintosh, that came with your model provides
detailed instructions for putting the system together.

If you set up the Macintosh and the computer or monitor does
not turn on, see “Troubleshooting” in Chapter 10 for assistance.

The system software manages Macintosh operations. It transmits
information to and from disks, printers, and other hardware
components, establishes and tracks files, and directs processing
inside the computer. Most system software activity is invisible,
but application programs—the software used for word processing,
spreadsheets, and other specialized work—rest on the
foundation system software provides. f

.

% System software already installed: 1f you purchased a
Macintosh model with an internal hard disk drive, the system
software was probably already installed at the factory. You'll
recognize a ready-to-run Macintosh when you turn it on;
after a few seconds you'll see a “happy Macintosh” icon, then
the desktop will appear on the screen, with icons for the hard
disk and the Trash., < n

Warning: If you received a hard disk with A/ UX” installed on it, =
do not initialize that disk; doing so will erase A/UX. Instead, see
the A/LUX Installation Guide for instructions on installing system
software. A r

You prepare the system software for your Macintosh by f
installing it on a disk and thereby creating one or more startup
disks—disks that contain the system software necessary to use
your Macintosh model and the devices connected to it.

Chapter 2: Starting Up



Installing system software creates a System Folder that contains
the system files, drivers, and other kinds of resources your
Macintosh needs. Figure 2-1 shows the icons for a system file
and a driver.

System Laser'wWriter
Figure 2-1  Icons for a system file (System) and a driver (LaserWriter)

Checking system software  If your system software is already installed, you can skip the
that is already installed  installation steps. But it’s a good idea to check the contents of
the System Folder on your hard disk to verify that it contains the
system files and drivers you need.

Open the System Folder and

check to see that it contains
The Macintosh icon E - f - d
indicates that this icons for the devices use
system has been System Folder with your Macintosh.

installed.

Preparing your system software 49



30

System files have a
Macintosh icon.

Printer drivers

Figure 2-2 shows the System Folder for a Macintosh configured
for a separate monitor and LaserWriter and ImageWriter®
printers.

=————— Systembolder=—"———""11=
25 items 11,252K in disk 7,767K available
= Background
! L=} s
printing
— - controls
System Finder General  MultiFinder  Backgrounder  PrintMonitor (using
[ I i MultiFinder)
’
L;ser pr;p Laserwriter  ImageWriter  Monitors\ Startup Device DA Handler :
Separate

monitor file

Figure 2-2  System Folder contents for a Macintosh with a separate monitor

If your System Folder does not contain drivers for optional
devices used with your Macintosh, you can add the necessary
ones.

You can add some drivers—including the ones for the
LaserWriter II, ImageWriter 11, and Apple Scanner—during che
regular installation process or by copying them into the

System Folder.

Consult the documentation for the printer, scanner, or other
devices connected to your Macinrosh for information about
which drivers they require and instructions for adding them to
your system.

Chapter 2: Starting Up



[nstalling system software  You use the program named Installer to prepare the system software
for your Macintosh model, cither when you first begin using the
computer or when you want to update your system with a new
version of system software.

To install the system software, you will need

s the System Startup disk (which contains the Installer program)
w the Systen Additions disk

= an initialized hard disk or an initialized floppy disk

If you are updating your system software with an upgrade kit, you
will need the disks called System Tools, Printing Toolks, Utilities Disk

1, and Ultilities Disk 2. (You may not need to use both Ulilities
disks, however.)

_\ Important: Apple recommends one of two minimum hardware
configurations for installation and use of System 6.0 or later
versions of the Macintosh system software: (1) a hard disk and one
floppy disk drive; or (2) two floppy disk drives. (It is possible to
install the system software on a Macintosh with one floppy disk

drive, however.)

The Installer provides two options—Easy Install and Customize.
These instructions cover the Easy Install process, which is suitable
for most Macintosh users. (To learn more about the Customize
option, see “Creating a Customized System” later in this chapter.)

\ Important: Do not use the Installer while running MultiFinder; in
some cases, doing so may cause installation to fail

Preparing your system software 51
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When you start the Installer, the software determines which

Macintosh model you are using and prepares to install the standard
software for that model. The Easy Install process installs the drivers
for all available printers on Macintosh models that have a hard disk.

You begin the installation procedure with your Macintosh turned off.

To install the system

software, first put the
System Startup disk into the
internal disk drive, and turn on
the computer.

(Use the System Tools disk if you
are updating your system
software with an upgrade kit.)

If your Macintosh has two
internal drives, use the lower
drive or the rightmost drive.

If you do not have a

hard disk, put an initialized
floppy disk in the second drive;
otherwise, go on to the next
step.

If necessary, double-
O] 3 click the System Startup
=R disk icon to open it.

System Startup (It you have inserted the System
Tools disk from an upgrade kit,

double-click the System Tools
icon.)

Chapter 2: Starting Up



Parts of the
system software
to be installed
Disk on which
system software
will be installed

o X

Installer

@ Welcome to the Apple Installer

Your Macintosh needs certain software to start up.

The Installer places this software on your disk

in the System Folder. System Folder

“Easy Install” chooses the software Apple recommends and
creates a disk which can be used to start up your Macintosh,

("Customize* if you are sure you want to override thoss

recommendations.)
l 0K B

EQsinglalle o0 e

l Click Install to place
| I-nn update to Dersion 6.0.6 of

L- Macintosh System Software —
* finy existing Printer Software [ Instan |

on the hard disk named
= Hard disk #2

Button to switch to a different] 1 Button to change to a

disk for installation customized installation

Preparing your system software

Double-click the

Installer icon to open it.

The Installer’s Welcome dialog

box appears.

Click OK to clear the

Welcome box.

The Installer’s primary dialog
box appears.

Make sure that the disk

indicated on the screen is
the one on which you want to
install the system.

If the wrong hard disk or floppy
disk is indicared, click the
Switch Disk button until the
correct hard disk’s name
appears, or click Eject Disk to
change floppy disks.



Installg

&

T

05
Od

Please insert the disk:

System Additions

Chapter 2: Starting Up

7 Click Install.

The Installer begins to install
the system software for your
Macintosh model. On-screen
messages list the disks needed
and report copying status.

‘When the System Startup
disk is ejected and you see a

message to insert the System
Additions disk, insert the disk.

(If you are updating your system
software with an upgrade kit
and the System Tools disk is
ejected, you are asked to insert a
different disk; just follow the
instructions on the screen.)

Depending on the software
needed for your system, you
may be asked to switch disks
more than once.

Clicking the Stop button
cancels the installation.



O

Installation on “Hard disk #2” was
successful. If you are finished, click
Quit to leave the Installer. If you
wish to do additional installations,
click Continue.

Continue I

Clean Up Window
FEoply Trash
Prase fisk

Set Startup...

Restart
Shut Down

»  See alse:

Chapter 4

When you see a message
reporting that the
installation was successful,

click Quit.

The Installer window closes.
(If for some reason the
installation was not successful,
vou'll see a different message,
and you can begin installation
again.)

Choose Restart from
]. O the Special menu to
begin working with your new
system.

The Macintosh restarts with
the newly installed system.

[f you do not have a hard disk,
you'll need to reinsert the
newly created startup disk into
a disk drive when you see the
blinking question mark icon.

You may see a dialog box
asking you to name your
Macintosh. Type a name and
click OK.

* “Printing Color or Gray-Scale Documents” in

* “Inidalizing and Naming a Disk™ in Chaprer 6

* “Initializing and Naming a Hard Disk for the First Time” in

Chaprer 6

“Moving Fonts and Desk Accessories” in Chaprer §
e M g Font | Desk A Chapter 8
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Creating a
customized system

If your Macintosh uses devices that are not included in the standard
software for its model, you can use the customized installation
process to create or modify your system.

Customized installation allows you to select the exact combination
of system files, drivers, and other kinds of resources you want in
your system, then installs them in your System Folder. You can use
this process for initial system installation, for updating to a new
version of system software, or for saving space on your startup disk
by eliminating drivers that aren't essential.

You begin the installation procedure with your Macintosh turned

To create a customized

system, first put the System
Startup disk into the internal
disk drive, then turn on the
computer.

(Use the System Tools disk if you
are updating your system
software with an upgrade kit.)

[f your Macintosh has two
internal drives, use the lower
drive or the rightmost drive.

2 If you do not have a

hard disk, put an initialized
floppy disk in the second drive;
otherwise, go on to the next
step.

Chapter 2: Starting Up



Systern Startup

ok

Installer

@ Welcome to the Apple Installer
Your Macintosh needs cerfain software to start up.

System Folder

The Installer places this software on your disk
in the System Folder.

“Easy Install” chooses the software Apple recommencdls and
creates a disk which can be used to start up your Macintosh.

(“Customize” if you are sure you want to override those

recommendations.)
0K
=)

Disk on which
system software
will be installed .

Button to switch

Easy Install
Click Install to place

An update to Version 6.0.6 of
® Macintosh System Software
« Any enisting Printer Software

R——
[_Instant ]

on the hard disk named
——— Hard Disk

Switch Disk

10 a different disk
for installation

Customize

Button to change to a
customized installation

Preparing vour system soltware

If necessary, double-

3 click to open the System
Startup (or System Tools) disk
icon.

Double-click to open
the Installer icon.

The Installer’s Welcome dialog
box appears.

Click OK to clear the

Welcome box.

The Installer’s primary dialog
box appears.

Make sure that the disk

indicated on the screen is
the one on which you want to
install the system.

If the wrong hard disk or floppy
disk is indicated, click the
Switch Disk button until the
correct hard disk’s name
appears, or click Eject Disk to
change floppy disks.



List of items selected —.

List of items
available for
installation

Click the items you want to selecl;
Shift-click to select multiple items.

System software for any Macintosh K
Software for all Apple printers u
fippleShare (workstation software) i
32-Bit QuickDraw
software for Imagellriter : = Hard Disk
Software for AppleTalk Imagellriter ﬁ

Eject Hisk

for installation

Click the items you want to select;
Shift-click to select multiple items.,

Software for Imagellriter

Software for AppleTalk Imagellriter
Software for Imagellriter LO

Software for AppleTalk Imagellriter LQ
Software for Personal Laserllriter SC

n‘ Install \-l

Software for Laserllriter 5.2 = Hard Disk
Eject Hisk
You have selected:
[- fppleshare (workstation software) Switch Disk
* Software for AppleTalk Imagellriter LO ST

Chapter 2: Starting Up

7 Click Customize.

The custom installation screen
appears, with a list box showing
all drivers provided with the
system software and a choice of
standard or minimal system files
for cach Macintosh model.

Scroll through the list
of items and Shift-click the

ones you want to install.

As you select items, their names
appear at the lower-left portion
of the dialog box. (If you select
only one item, details about it
appear.)

Click the Install button

to install the selected items.

The Installer begins the
installation. On-screen messages
report copying status.



Please insert the disk:
System Additions

g
(g

O

Installation on “Hard Disk” was
successful. If you are finished, click
Quit to leave the Installer. If you
wish to do additional installations,
click Continue.

Quit R

Special
Clean Up Window
Tenply frash
Proga i
Set Startup...

Restart
Shut Down

Preparing vour system software

10 If the System Startup

disk is ejected, insert the
System Additions disk as
requested.

(If you are updating your system
software with an upgrade kit
and the System Tools disk is
ejected, you are asked to insert a
different disk; just follow the
instructions on the screen.)

Clicking the Stop button
cancels the installation.

1 When you see a
message reporting that
installation was successful, click

Quit.

The Installer window closes. (1f
you see a message that the
installation was not successful,
begin the process again.)

1 Choose Restart from
the Special menu.

The Macintosh restarts with the
newly installed system.

If you do not have a hard disk,
reinsert the newly created
startup disk when you see the
blinking question mark icon. If
you see a dialog box asking you
to name your Macintosh, type a
name and click OK.
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Installing system software
on a Macintosh with
only one disk drive

Making an extra
startup disk

You can make sure that the correct items were installed by opening
the startup disk’s icon, then opening the System Folder and
reviewing its contents.

» Secalo: ¢ “Printing Color or Gray-Scale Documents™ in
Chaprer 4
* “Moving Fonts and Desk Accessories™ in Chaprer 8

You can install the system software if your Macintosh has only one
floppy disk drive (and no hard disk), but the process will involve
many disk swaps as you copy the necessary files from the four
system software disks to the disk on which the system is being
installed.

The installation process follows the same steps as those in
“Installing System Software” earlier in this chapter, except that you
will have to eject the System Startup (or System Tooks) disk and insert
an initialized disk after starting the Installer program.

The Installer automatically creates a minimum-sized system and
installs only the ImageWriter printer driver when you install on a

floppy disk.

Your Macintosh requires a startup disk—thac is, a disk with a
System Folder installed on i—whenever you turn on or restart the
computer.

If your Macintosh has a hard disk and you have installed the system
software on it or the computer came with the system on its hard
disk, you already have your startup disk and don't need to create any
floppy disks to use as startup disks.

If your Macintosh has only floppy disk drives, you may want to
create several startup disks to use with different application
programs for convenience.

Chapter 2: Starting Up
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Once you have installed the system software on one floppy disk,
you can simply copy its System Folder to one or more initialized
disks to make duplicate startup disks.

To make a new startup disk you need
» adisk with your installed system software (in one disk drive)
s an initalized disk (in the second disk drive)

If your computer has only one disk drive, you can create a
startup disk, but you will have to make several disk swaps in the
process.

To make an extra

startup disk, first double-
click the icon of a disk that
contains your installed system
software to open it.

Srnall system

Place an initialized disk
in the second disk drive.

If you have only one floppy
disk drive, ¢ject the disk
containing the installed
software and then insert an
initialized disk. This disk will

be your new startup disk.

Preparing your system software 01



Creating a sma

Drag the System Folder
3 to the icon of the startup
disk you want to create.

The System Folder is copied
onto the new startup disk.

This process will require a
number of disk swaps on a
one-floppy-drive system.

"WF startup

| system  When you install the system software on a floppy disk, the
[nstaller automatically creates the smallest practical System
Folder. This allows the maximum room on your startup disks
for application programs and your own work.

You can also create this small system by selecting the “Minimal
software” option for your Macintosh model from the Customize
dialog box of the Installer.

If you didn’t originally install the minimum-sized system or

) g Y bt

you've added drivers, fonts, or desk accessories since installation,

you can remove items that aren’t essential. You remove drivers by

dragging them out of the System Folder; vou remove fonts and
gging y i

desk accessories with the Font/DA Mover.

Chapter 2: Starting Up
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Updating to a new
version of system software

Depending on the devices connected to your Macintosh, you
should consider removing these items:

m drivers for printers or other devices you don't use (such
as ImageWriter, AppleTalk ImageWriter, LaserWriter,
LaserPrep)

s networking drivers, if you are not on a network (such as

AppleShare®)

s extra desk accessories (you will definitely need the Control Panel,
but you may not need the Alarm Clock, Calculator, Chooser,
Find File, Key Caps, or Scrapbook)

= extra fonts you have installed

P Seeabo: - “Creating a Customized System” in this chapter
* “Making an Extra Startup Disk” in this chaprer
* “Moving Fonts and Diesk Accessories™ in Chapeer 8

If you have been using an older version of the system software and
you get a newer version, you can update your system by installing
the newer software.

To accommodate all Macintosh models, the system software

upgrade is supplied on four 800K disks instead of the two
1.4 MB system disks provided with new computers.

To install the new system software, follow the special instructions in
“Installing System Software” or “Creating a Customized System”
earlier in this chapter.

Preparing your system software 03



Installing 32-Bit
QuickDraw for
enhanced color images

04

If your Macintosh can display color images, you can enhance the
computer’s color capabilities by placing the 32-Bit QuickDraw™
file in the System Folder of your startup disk.

The 32-Bit QuickDraw file is provided in the Apple Color folder
on the System Additions disk. (If you are updating your system
software with an upgrade kit, you'll find the Apple Color folder on
the Printing Tooks disk.)

To install 32-Bit
QuickDraw, first locate
its icon in the Apple Color

22-Bit QuickDraw folder.

Drag the 32-Bit
QuickDraw icon to the

System Folder of the startup
disk.

E 32-Bit QuickDraw is copied

into your System Folder.

vas, :5:”5

tern Finder:

Restart your system by
Clean Up Window choosing Restart from the
fmply Trash Special menu.

frase sk - - ;
set Sta:’tup The capabilities of 32-Bit
QuickDraw are in effect once

Restart you restart.
Shut Down

» Secabo: o “Specifying the Number of Colors or Shades of Gray™ in
Chapter 8
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Starting up the
Macintosh

Specifying items
to be opened
at startup

the desktop. icons.
and windows,

Dimmed options !

require MultiFinder.

If your Macintosh has a hard disk that’s a startup disk, you
simply turn on the computer to start up. If you're using a floppy
startup disk, place the disk in the internal disk drive and turn on
the Macintosh. To restart with a floppy disk, reinsert the disk
after it is ejected.

P Seealso: * “Installing System Software” in this chapeer
¢ “Creating a Customized System” in this chaprer
* “Turning the Macintosh On and Off” in Chapter 2
* “Inserting a Disk” in Chapter 6

You can designate one or more application programs, desk
accessories, and documents to be opened automatically when
you start up the Macintosh. To specify items for opening at
startup, you use the dialog box that appears when you choose
the Set Startup command in the Special menu. (See Figure 2-3.)

start up "harddisk" with:

The Finder manages — L&) & Finder (O % & & MultiFinder —L— MultiFinder
MANAZes two or
Upon startup, automatically open: mare programs
EO felgcied items simultaneously
(O Gpened fpplications and 88+ (including the
@® Finder Only Finder).

i Cancel 0K }

Figure 2-3  The Set Startup dialog box

The procedure for using the Set Startup command varies
somewhat according to the number and type of items you want
to open at startup.

Table 2-1, at the end of the instructions for “Selecting Multiple
Startup Items,” summarizes the procedures for opening
programs, documents, and desk accessories at starcup.
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Selecting one startup  Whether you use the Finder™ or the MultiFinder option, you
program or document can easily specify a program or document for opening at startup.

To specify a program or
document for opening at
startup, first select its icon by

clicking.

Studio /2

Special
Clean Up Window
famply Trash

frase sk
Set Startup...

2 Choose Set Startup from

the Special menu.

[ Start up "Main Disk" with: CheCk that [he Progran]
or document you selected
® & Find O % &< Multifind . .
L e is shown, then click OK.

Upon startup, aulomaltically open:

Program selected — L 54 ug10/0 . - "
O Gpenead Appllcations and Dils Changmg fTOlT] Pmder to
O Finder Only MultiFinder or vice versa will
not affect your selection of a

startup program or dOCLllTlC!'lt.

Choose Restart from
the Special menu.

Clean Up Window

Lmply frash The program or document
Erase fHek

Set Startup...
Restart
Shut Down

Your startup selection remains in effect until you change it with
the Set Startup command.

you selected is opened when
the Macintosh restarts.

06 Chapter 2: Starting Up



Selecting multiple  To open more than one item at startup, you must use MultiFinder,
startup items  the system file that permits the Macintosh to work with two or
more programs simultaneously. You use the Set Startup command
to turn on MultiFinder, as well as to specify the startup items.

Until you turn MultiFinder on, the Macintosh automatically uses
the Finder, the system file that manages the desktop, windows, and
icons. (You can still use the Finder when MultiFinder is turned on.)

The instructions that follow show how to select a group of items for
opening at startup. Consult Table 2-1 for a summary of the
procedures required to select several different types and
combinations of startup items.

1 To specify multiple startup

items, first select the

programs and documents you
want to have opened by Shift-
clicking their icons.

QuarksFPreszE

All the items must be at the
same level—on the desktop or
in the same folder.

lowa map

If you want to specify desk
accessories as startup items,
you must first turn on
MultiFinder and then open
the desk accessories.

Choose Set Startup

Special .
ElaanUpDintDin from the Special menu.
fmply Trash The Set Startup dialog box

frase Hisk

: : opens.
Set Startup...

Restart
Shut Down
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[ Start up "Main Disk" with:

@ < Finder Q@(&Q MultiFinder

Upon startup, automatically open:
Q setected Items
Q dpaened fipplicotions and His
@® Finder Only

]

With MultiFinder
wined on. the
Selected ltems

option is

automatically

[ Start up "Main Disk" with:

O < Finder  ® % & & Multifinder

Upon startup, automatically open:
@® Selected Items

Q tinened fAipphications and ORs
O MultiFinder Only

selected.

Special

Clean Up Window
Emply frash
brase fisk

Set Startup...

Restart
Shut Down

If necessary, click the
MultiFinder button to
turn it on.

Skip this step if MultiFinder is
already selected.

Check that the button

labeled “Selected Items” is !

selected, then click QK.

Choose Restart from
the Special menu.

p

The items you selected are
opened when the Macintosh
restarts.

Your startup selection remains in effect until you change it with
the Set Startup command.

> See also:

Chaprer 3

* “Managing Multiple Programs Using MultiFinder” in

* "Managing System Memory” in Chapter 3

08 Chapter 2: Starting Up
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Table 2-1  Summary of procedures for opening items at startup

To open at startup

Requires

Do before choosing Set Startup

I application program

2 Or more programs

I or more desk
ACCESsOries

1 or more desk
accessories plus
1 or more programs

1 or more documents

1 or more documents
plus 1 or more
application programs

1 or more documents
plus 1 or more desk
ACCESSOries

Finder or
MultiFinder

MultiFinder

MultiFinder
turned on®

MultiFinder
turned on®
MultiFinder

MultiFinder

Not possible

Select program icon

Open or select program icons
Open desk accessories

Open desk accessories and
program icons

select document icons

Select document icons
and program icons

*MultiFinder must already be in effect before you open any desk accessories o specity

them as startup items.

specifving items to be opened at startup

09






Chapter 3

Working With
Application Programs

Appiication programs determine what kinds of work a
Macintosh can do—such as writing, drawing, designing,
calculating, controlling a variety of processes, and managing vast
amounts of informartion.

This chapter outlines some fundamental operations common to
all application programs, regardless of a program’s specific
purpose and product.

These operations include

= preparing to use an application program

= moving text and images within a document

= copying text and images from one document to another

= saving documents—under various names, in various locations
= storing frequently used text and images for easy access

m recognizing whether you're in a program or on the desktop
and moving from one “place” to the other

This chapter also presents procedures for managing several
application programs (often just called programs for simplicity)
and summarizes the appropriate steps for ending a work session.



Pre paring O Use d  You use standard Macintosh operations to install and start most
program for programs, and to create documents with them. Once you've created
- a document with a program, you can either start the program and
YOUF \\'()l‘k then open the document, or simply open the document’s icon on

the desktop, which automarically starts the program.

[nstalling a program  In most instances, you install an application program by copying
it from its original disk to your hard disk or to a floppy disk. (A
few programs have more elaborate installation procedures.)

dpplelink

Program icon

[Lard disk icon

To install an application
program, first open the
program’s disk by double-

clicking its icon.

2 Copy the program by
dragging its icon to the

icon of the your hard disk or
startup floppy disk.

Release the mouse button
when the disk’s icon becomes
highlighted. The program is
then copied onto the disk.
(You can also copy a program
to a folder by dragging its icon
to the folder icon, or copy the
program to an open directory
window by dragging its icon to
the window.)

If your system has only one
floppy disk drive, you'll have

to swap disks several times.

Chapter 3: Working With Application Programs



If necessary, copy any
additional files the
program needs by dragging

to the startup floppy disk.

should specify whether any
such files are needed.

[t's a good idea to open the icon of the hard disk or the floppy
disk to make sure that the program and other files were copied.

Consult the program’s documentation to determine whether
additional installation steps are necessary.

» Secalso: “Installing System Software” in Chaprer 2
* “Creating a Small System” in Chaprer 2
e “Making an Extra Startup Disk™ in Chaprer 2

Starting a program  You start a program by opening it.

To start a program,
prog

g? first point to its icon.

A

FreeHand

Double-click the mouse
button to open the
program.

The program’s window
appears, usually with a new,
blank document displayed.

Preparing to use a program for vour work

their icons to the hard disk or

The program’s documentation



Creating a new document
in a program

*,

< Other ways to open programs: You can also open a program by
selecting its icon and choosing the Open command from the
File menu or by double-clicking the icon of a document
created by the program. <+

The program remains open until you quit, usually by choosing
Quit from the File menu (or by using the keyboard shortcut
Command-Q provided in many programs).

> See also:  * “Opening a Document on the Desktop” in this chapter
* “Knowing Where You Are on the Macintosh” in this
chapter

You create a new document while working in a program by
choosing the New command.

To create a new

document in a program,

Ne

Open... 20 first open the File menu.
finss A
Save s

Sapa #e,,.

Drag the pointer to
the New command and
Open : release the mouse button.

finse
Sapa
Sapa fHs...

The program opens a new
document. If anocher

document was already open,

the new one covers it. (Some
programs don’t permit more

than one open document at a
time.)
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Opening an existing
document in a program

Folder icon

Document icon

{inse

fava S
Sapa fs...
Select a Document:
3 Application Programs = HD #1
[ B Dabers 6615K available
3 BD's Books —
D Chi's lemnlalﬁ [ Open |

D For Channing
O For Kate
O For Scottie

Select a Document:

3 Application Programs
[ B Dabers

[ BD's Books

O Chi's template

D For Channing
O For Kate
3 For Scotlie

= HD #1
6615K available

(oo
|

> See also:

Preparing 1o use a program for your work

You open an existing document while working in a program
with the Open command.

To open an existing

document in a program,
first choose Open from the
File menu.

The program’s directory dialog
box appears, with a list of
documents and folders on the
disk in use.

If necessary, scroll to
locate the document, then
click its name to select it.

You can display the documents
in a folder by selecting the
folder and clicking the Open
button.

Click the Open button
to open the selected
document.

* “Knowing Where You Are on the Macintosh” in this
chaprer



Opening a document  If you are using the desktop rather than working in a program,
on the desktop  you can open a document and start the program at the same
time. (This technique may not work if the program is already
open when you're using MultiFinder.)

1 To open a document
on the desktop, first point
to its icon.

BL Motes

Double-click the mouse

button to open the
document and simultaneously
start the program.

The program starts, with the
document open in its window.

When you close the document, the program stays open until
you quit, usually by choosing Quit from the File menu (or by
using the keyboard shortcut Command-Q).

P Seealso: “Knowing Where You Are on the Macintosh” in chis
chapter
* “Managing Multiple Programs Using MultiFinder™ in
this chapter

Edl‘[lng documents The Macintosh computer’s standard operations allow you to edit
text and to copy both text and images between parts of a
document, from one document to another within a program,
and between documents in different programs.

70 Chapter 3: Working With Application Programs



Editing text  You can use the standard text-editing operations available on the
desktop when you're in a program. These include

m sclecting text
» replacing text
» deleting text

® inserting text

[f necessary, review the instructions in “Basic Editing on the

Desktop” in Chapter 1 for instructions for basic text editing,
You can also get practice editing in Getting Started With Your
Macintosh and in Macintosh Basics, the training disk.

Copying text and images  You can easily copy selected text and images.

Many graphics
programs identify a
selected item with a

moving dashed
outline.

fan't indg

Cut

Editing documents

To copy text and images,
first select the item you
want to copy.

Choose Copy from the

Edit menu.

Your selection is copied and
stored in a part of the
computer’s memory called the
Clipboard until you copy or
delete another item or you
turn off the computer.

77
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+ A keyboard shortcut for copying: You can also use the keyboard
shortcut Command-C to copy selected items.

w To check the Clipboard: You can see the current contents of
the Clipboard by choosing the Show Clipboard command
from the Edit menu. This command is available in some
programs, and it’s always available when you’re working on
the desktop. +

> See also:  *“Deleting Text and Images” in this chapter

[nserting copied text and  Once you've copied text, images, or both, you can insert that
images within a document  material anywhere in an open document.

To insert text and

Insertion point images in a document,
first click at the exact spot
White Ti ger where you want the item to
Has Twins! appear

A blinking insertion point
appears at the spot where you

click.

Choose Paste from the

Edit menu.
Undo ®2
The item you copied
Ll 3 previously is inserted.
fopi KA
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Copying text and images
between documents
in different programs

A moving dashed
outline indicates a
selected item in
many graphics
programs.

—

White Tiger
Has Twins!

Check the document to

make sure that the copied
item was inserted as you want
it.

You can paste the copied item
as many times as you wish.

<« Pasting shortcut: You can also use the keyboard shortcut
Command-V to paste copied material into a document. %

You can easily copy text and images from one document to
another in the same program or from a document in one

program to a document in another program. The instructions

that follow cover the slightly more complicated task of copying
between documents in two different programs.

o
—

The pond has rounded
stones that seem to
sit atop the water,
You can cross easily.

LW

Editing documents

To copy an item

between documents in
different programs, first select
the desired material from a
document in the first
program.

In a graphics program, a
selection is often marked by a
moving dashed outline; in a
text program, a selection is

highlighted.



fan't dndyg

Cut

| File I

New 3EN
Open... a0
Close #EL
Save #S
Save fAs...

Delete...

Page Setup...

Print... #P

picnic map

Choose Copy from the
Edit menu.

The selection is copied to the

Clipboard.

Choose Quit from the "
File menu to leave the
first program.

If you're using MultiFinder,
you don’t have to quit the first
program; you can simply
switch to the Finder or to the
second program if it’s already
open.

Double-click the icon

of the document into
which you want to paste the ¢
item you copied.

Opening the document .
automatically starts the
program.
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5 Click at the exact spot

Insertion point : i where you want the item
4 to appear in the document
N _.-* just opened.
A blinking insertion point
Highvay 1 appears at the spot you
i dughandie Pond clicked.
Choose Paste from the
Edit menu.
Undo #®2
The selected item appears at
i N . N =
L i the insertion point.
Loy

Check the screen to

be sure that the copied
material was pasted where
you want it.

bhe pond kas rounded  YOU can always delete the

1 stones that seem to 2
-~ ey pasted item, select another
N iYeueanerossessily.  ingertion point, then paste

¥
'

again.

Highway 1

If you are not making other

ughandle Bond changes in this document, save

and close it.

> Secalso: o “Switching Programs or Desk Accessories with
MultiFinder” in this chapter
* “Starting a New Program When Using MultiFinder”
in this chapter
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[)Cltl'iﬂg text and il]lllgﬁs‘ You can delete text and images from a document in either of 4

two ways.

One method, using the Cut command, places the deleted
material in an area of the computer’s memory called the

Clipboard so that you can get it back (until you copy or cut
another item).

The second method, using the Clear command, removes the
material and does not place it on the Clipboard.

for the 1990s in Norwaw.
New manufacturing centers
have been constucted, more

Undo

#2

Paste
Clear

.,

Copy ! %L

&

To delete text or images,
first select the item to be
removed.

The selection becomes
highlighted (if it’s text) or
enclosed by a moving dashed
outline (if it’s graphics).

Choose Cut or Clear
from the Edit menu. .

The selected item disappears
from the screen. .

w Another way to clear text and images: Pressing the Delete key
also clears selected material.

”,
£

Chapter 3: Working With Application Programs



Canceling an editing action

You can cancel many editing actions with the Undo command,
which reverses your most recent action (if it is possible to reverse

thar action).

The actions that you can undo with this command vary among

programs.
Undo ®2
fut 1
LoD &L
Paste 3D

To undo an action, first

open the Edit menu to see
if the Undo command is
available.

The command is black if
available; it is dimmed and
sometimes reads “Can’t undo”
if it can’t be used to reverse
your most recent action.

2 If Undo is available,
drag to it and release the
mouse button.

The Undo command reverses
your previous action. Choosing
Undo a second time restores
your original action.

s Shortcut for Undo: You can use the keyboard shortcut
Command-Z to initiate the Undo command.

Editing documents
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SZlViﬂg documents Saving your work often is the best safeguard against lost data.
Macintosh programs offer several ways to save documents,
providing great flexibility in managing and storing your work.

When you save, you can

s name the document

= change its name

= change its location

» save revisions with no change in name or location

» save all or part of a document in the Scrapbook desk
accessory for access any time

Most saving options use a form of the directory dialog box, in

which you name a document and select its storage location. (See
Figure 3-1.)

Disk (current
storage location)

Folder (holds O Accounts
documents) 01 BD letters
’ . [ Bird stacks
Document (dimmed ™ Mama
because it can't [ Tanes 89
be opened)
Save Current Document as: Disk #2
Current ——-lMU"U 8/5/90 —l 12541K available
document -
Hare Ofast ssue [ Make Backup
Cancel | Drive |

Figure 3-1 A directory dialog box for saving files
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Saving a new document When you create a new document and save it for the first time,
you must name it.

When a document has not yet been named, the directory dialog
box automatically appears when you choose the Save command.
This dialog box also appears when you choose the Save As
command.

To save a new
document, first choose
Save from the File menu.

The directory dialog box
opens. An insertion point is

Save fis... ol
blinking in the name box.

Type a name for the

document.

Folder (holds — '~ Recounts

documents) [ BD letters
[ Bird stacks

If you make a typing error, you
can use the Delete key to

2 Mema
O Taxes 89 backspace, or you can drag
Save Current Document as: across the part of the name to
Name box | be ¢ d d tl 5 »
e corrected, and then retype.
(with blinking —| | Yp
insertion point)
Click the Save button to
© ficcaunts & save the document.
£ BD letters ]
3 Bird stack T
O Memo | The program saves the
Ti 89 -
S Tones & document and the dialog box
Save Current Document as: = Disk #2
[Motly 8/5/90 ~] 12541k avaitabte closes. The name of the

COFest Snue O] Make Backup n Suueﬂ (Eject documcnt now appears in the
window’s title bar.
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« A different way to save: Some software, such as HyperCard
and many database programs, saves your document
automatically after you make a change and when you close
the document. In these programs, you name a document at
the time you open it. %

Saving a revised document  When you make changes to a previously saved document, you
can save your revisions quickly with the Save command. This
command saves your revisions without changing the document’s
name or location.

Dear Ted, Make the revision to
On [FTEETY weekerd , the New York City your document.

alumnd group plans a picnic, Mark it on your
calendar now, please. The committee will make
arrangements and advize you as 1 time, place,
and other essential information.

See you soon!

Choose Save from the
File menu.

The pointer becomes a
wristwatch while the
T T document is being saved.
(Some programs use a
different icon.)

.

<« Save command shortcut: You can save revisions most

efficiently by using the keyboard shortcut Command-S,
which is available in many programs.
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Saving a document
under a new name

Save As...

Disk I pjgk #2 |

3 Accounts
1 BD letters
[ Bird stacks
Document — 1) Memoe

[0 Taxes 89

Folder

Save Current Document as:

Existing name Molly 6/21/90

(selected with
Save As command)

= Disk *Zl

3 Accounts
2 BO letters
2 Bird stacks
0 Mema

O Tanes 89

Save Current Document as:
[Denoran 6/21/90 |

= Disk #2
12541K available

O Fast saue CIMeke Boackup

ﬂSoue*}l tiact

You can change the name of an existing document with the
Save As command.

To save a document
1 under a new name, first
choose Save As from the File
menu.

A directory dialog box opens,
with the document’s current
name selected in the name
box.

2 Type a new name for

the document.

Your typing replaces the
selected name. If you make a
typing error, you can use the
Delete key to backspace, or
you can drag across the part of
the name to be corrected, and

then retype.

save the document under
its new name.

3 Click the Save button to

The document is saved and
the dialog box closes. The new
document’s name appears at
the top of the active window.

« Return key shortcut: You can press Return instead of clicking the
Save button. (Pressing Return initiates the action for the button
with a bold outline.)  «

Saving documents



Saving a second copy
of a document

under the same name
on a single disk

When you save with a new name, the original document (with
its original name) remains intact, in the version you last saved
before changing the name. To avoid confusion with different
versions of a document, it’s a good idea to include a number,
date, or other identifying element whenever you change a
document’s name.

To rename a document without retaining a version under the
old name, change its name on the desktop.

» Seealso: “Renaming a Document™ in Chaprer 5
* “Basic Editing on the Desktop” in Chaprer 1

You can make two copies of a document with the same name by
placing them in different locations on the disk.

To save a second copy of
1 a document under the
same name, first choose
Save As from the File menu.

The directory dialog box
opens, with the document’s
current name selected.

Save As...

[Soisk#2) If necessary, scroll to

Folder selected
for saving

[ Hecamty ‘ locate the folder in which
BD letters

you want to save the second
copy of your document, then

Save Current locument as: = Disk ¥2
Deborah 6/

O Fast save [ Moke Backup SHUBR Ejact Click the Save bl.ll:torl to Open

ST TR abIe click the folder’s name and

the folder.

The folder opens, and a list of

the folder’s contents is displayed.
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Folder opened —
instep 2

 Siietters] 3 Click the Save button

T Mally 875:90 &l to save the document in
the open folder.
o ]
Save Current Document as: = Disk #2 ThC dlalog bOX CIOSCS as [he

REAK Msiable program saves the document.
O Fast Save ] Moke Backugp m

If you open a folder that already contains a document with the
same name as the one you're saving, you'll see a message alerting
you that the version you're saving will replace the one already
there. (See Figure 3-2.)

Replace existing “Tax memo
-3/90" 7

Figure 3-2  Alert box to confirm replacing old version with new

You can avoid replacing the old version by clicking No. Clicking
Yes replaces the old version with the new one.

» Seealso: “Copying a Document on the Same Disk”™ in Chaprer 5
* “Using Folders to Organize Your Work™ in Chapter 5
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Saving a document  You can easily change the disk on which you plan to store a

onto a different disk

document.

Save fAs... [

(2] Pyg Ref
168K available

[Cancel] [ [Iriuek]

Backup 8/6
57K available

o
[cancel] [ Drive |

To save a document on a
different disk, first choose
Save As from the File menu.

The directory dialog box
opens, with the document’s
name selected.

Click the Drive button
to display the name of a
different disk.

If you are using floppy disks,
you may have to eject a
disk—using the Eject
button—and then insert the

desired disk.

If necessary, select a
3 new location by double-
clicking the folder where you
want to save the document,
then click Save.

The program saves the
document and the dialog box
closes. The newly saved
document becomes the acrive
version (that is, you are now
working on a different disk,
and your changes will be saved
there).
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Saving text and images

in the Scrapbook
for casy access

If you try to save a document on a disk or in a folder that
already contains a document with the same name, you'll see a

message alerting you that the version you're saving will replace
the one already there. (See Figure 3-2.)

You can avoid replacing the old version by clicking No. Clicking
Yes replaces the old version with the new one.

The Scrapbook desk accessory provides an excellent storage

place for text and images you use frequently. The Scrapbook is
automatically included when you install system software. (See

Figure 3-3.)

Serolling displays
stored images !

Image displayed/
total images (a new
image is placed
ahead of the one
displaved)

ELE

Scrapbook

Downtown Office Occupancy Rate

100%

75

S0

25

T

L
1T
L

LT
[T
LT
LT
L

1983 1984 1985

—1 /10

| Type of

document

Figure 3-3  The Scrapbook desk accessory

Saving documents

displayed
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When the Scrapbook is open, the standard editing commands
Cut, Copy, and Clear operate on the contents of its window.

To put text or images

in the Scrapbook, first
select the material you want
to copy.

Choose Copy from the
the Edit menu.

fan't Unde 2

The selection is copied onto

the Clipboard in the

Cut 3H

Paste M computer’s memory.

n Choose Scrapbook from
fibout the Finder... the Apple menu.
Alarm Clock The Scrapbook window opens,
calculator displaying the first item in it.
Chooser
Control Panel
Diskinfo
Find File
Key Caps

Sscrapbook

Choose Paste from
ﬂ 57 the Edit menu.

£t =i
fopy i

The selection is pasted in front
of the item previously displayed
in the Scrapbook, and the
number of items is adjusted to
reflect the addition.
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[ scraphook 5 Close the Scrapbook by

clicking its close box.

1711

PET

«  Copy and Paste command shortcuts: You can use keyboard
shortcuts to copy and paste—Command-C for copy,
Command-V for paste. <

Editing operations in the Scrapbook include

» Cut—delete the item displayed and store it on the Clipboard
(see “Copying Text and Images” earlier in this chapter)

»  Copy—copy the item displayed and store it on the Clipboard
(for pasting into desired document)

n Clear—delete the item displayed

You can create more than one version of the Scrapbook, but the
system can only work with one such file at a time. If you
maintain several scrapbook files, be sure to store them under
different names so that you don’t inadvertently replace one of
them with the content of another.

To swap Scrapbook files,

» remove the current Scrapbook File from the System Folder
and give it a different name

s then rename the file you want to substitute “Scrapbook File,”
and place it in the System Folder
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Knowing where
you are on
the Macintosh

The top line of the
Apple menu names
the program in use.

When you work with programs and documents, the screen’s
“environment” changes according to the type of program you're
using. At times you may look at the screen and wonder where
you are—in a program, in a document, or on the desktop.

If you use MultiFinder, recognizing where you are from what
you're seeing can be especially tricky, because you can see parts
of the desktop even when you're using a program.

But the Macintosh has some built-in clues to help you
determine where you are. The figures that follow show some

easy ways to get your bearings.

Figure 3-4 shows the menu bar of an otherwise blank screen.

[ % File Edit Format Font Document Utilities Window

Figure 3-4  Only the menu bar is showing on the screen

Figure 3-5 shows how to determine where you are.

s
EX\file Edit Format Fon

L The menu titles

fibout Microsoft Word
flarm Clock

Calculator

Chooser

Control Panel

Find File

Key Caps

Scraphook

Figure 3-5 The menu bar's clues to what program you're in
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enough for vou to
identity the
program.




Figure 3-6 shows assorted windows and icons when using
MultiFinder.

& File Edit Search Format Font Style & |

Hard Disk
25 items 12 433K in disk 6,739k available

[ nem0 3/ 12/

| Thisis it] e

Figure 3-6  Screen with program and desktop windows open

Figure 3-7 shows how to see where you are and what else is open.

i @ile Edit Search Format Font Style &—— A small icon in this
Program in use —E_apyut Macllrite... location indicates
Herdinlzk that MultiFinder is
Alarm Clock 12 440K in disk 6,732K availble .
Calculator e : turned on; this
no = . .
Chooser - particular icon
Control Panel ’
Find File represents
Key Caps MacWrite, the
Scrapbook .
current program.
Programs open: The ] &l Finder
Finder manages the 7S Macllells
desktop, which is fibout Multifinder...
visible behind
MacWrite's active

window (the check
mark indicates the
program in use).

Figure 3-7  Clues to the programs open and the one currently active

P Seealso: o “Managing Multiple Programs Using MultiFinder” in this
chapter
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Returning to the desktop  To return to the desktop when you're using a program (and f
from a program MultiFinder is not turned on), save your work and quit the

program.

Save As...

New N
Open... 30
Close A ]
Save 38S
Save fAs...

Delete...

Page Setup...
Print... &P

P Seealso: o “Managing Multiple Programs Using MultiFinder” in this

chaprer

To return to the desktop

from a program, first save
any new work in the open
windows by choosing Save
from the File menu.

Most programs warn you if
you try to close a window or
quit the program without
saving your work.

You can also close the open
windows after saving. If you
don’t, the program will close
them when you quit.

Choose Quit from the

File menu.

The program’s window and
menu titles disappear and the
desktop appears.
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Managing Macintosh system software includes MuldiFinder, which can
Inllltiple pngl’ﬂﬂ]S open and manage multiple programs at the same time.

Using MultiFinder MultiFinder provides

automatic opening of specified programs, documents, and
desk accessories at startup

quick and easy switching between open programs

copying and pasting of text and graphics between documents
in different programs, without having to close the documents

or quit the programs

continuous access to the desktop for starting new programs,
moving or deleting documents, and changing floppy disks

background printing

To make most efficient use of MultiFinder, you should also
know how to manage your system’s memory, discussed later in
this chapter.

» Seealso: * “Managing System Memory™ in this chapter

* “Specifying Items to Be Opened at Startup™ in
Chapter 2
* “Using Background Printing” in Chapter 4

Managing multiple programs using MultiFinder
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Turning MultiFinder on  You turn MultiFinder on with the Set Startup command, which
provides several options once MultiFinder is selected. (See

Figure 3-8.)
Startup disk —_[— i
i e [ Start up "Accounts '89" with:
[ i Choice of Finder
) - or MultiFinder
® & Finder O %4 & MultiFinder (\\'i}ich inclutdcs
: the Finder as an
Upon startup, automatically open: open application)
o O selected 1tems
Options for O dpened Applications and Hfls
opening other Finder 0n
items at startup @© Finder Only

Figure 3-8  Set Startup dialog box with the Finder selected

1 To turn MultiFinder
Clean Up Windoin on, choose Set Startup
Emply Trash from the Special menu.

Frase flisk

Sat STFtD: The Set Startup dialog box

opens.
Restart
Shut Down
St b AT Click the MultiFinder
button.
__@aride RAdd HulKinder
Upon startup, automatically open: The options in the lower part
QO Salectpd Items ~ .
O tpencd Applications and Ofs Ot the dlﬁlog bOX Chaﬂge WI]cn
@ Finder Only you Cl] Cl{.
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[ Start up "Accounts '89" with:

Q@ fFinder ® &@&& Multifinder

Upon startup, automatically open:
@ Selected items
O Opened Applicativas and HAs
O MultiFinder only

3 Click the OK button.
The dialog box closes.

Special

Clean Up Window
Emply frash
frase sk

Set Startup...

Restart
Shut Down

Choose Restart from
the Special menu.

MultiFinder takes effect when
the Macintosh restarts.

You'll know that MultiFinder is in effect by the small icon
displayed at the top-right corner of the menu bar. (See

Figure 3-9.)

& File Edit View Special

ESSS===—————— fccounls '89

31 Active-application
icon (indicates the
application in use

7,521K available |:

when MultiFinder
ison)

Figure 3-9

Menu bar with active-application icon in top-right corner

Managing multiple programs using MultiFinder
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Once you have turned on MultiFinder, it goes into effect
whenever you start up the Macintosh. You use the Set Startup
dialog box to specify programs and documents to be opened at
startup as well.

MultiFinder remains in effect until you turn it off (by choosing
the Finder option with the Set Startup command) and restart
the computer.

» Secalso: “Specifying Items to Be Opened at Startup” in
Chapter 2

Switching programs  You switch between open programs or desk accessories simply by
or desk accessories  clicking the active-application icon in the right corner of the
with MultiFinder menu bar. (See Figure 3-9.)

To switch programs or
desk accessories, click the
active-application icon.

Desk accessory icon The icon chanees and a
(application currently ANges ¢

in use) different program or desk
accessory appears in the active
window.

If necessary, click the
Ek active-application icon
several more times, until the
program or desk accessory
you want is visible.

% Other ways to switch programs: You can also click in a
document window or choose the name of an active program
from the Apple menu to change programs.
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Starting a new program  When MultiFinder is in effect, you can start a program that is
when using MultiFinder not currently open by opening it from the desktop.

g To open a new program,
click the active-

application icon until the
small Macintosh appears.

The small Macintosh icon
indicates the Finder, which
manages the desktop. The
window of the icon opened
most recently on the desktop
appears.

Locate the icon of the
@ program you want and
open it by double-clicking.
QuarkiPrezs® You may have to close or resize
the windows of one or more
documents if the icon you
want is on the desktop and is

hidden by them.
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Managing
system memory

You’ll see an alert box if there is not enough RAM for the new
program to be opened. (See Figure 3-10.)

The application "QuarkHPress®" could
0 not be opened (1,024K needed, 614K

available). Try quitting from another

application to increase unused

memory.

Figure 3-10  MultiFinder alert box reporting insufficient memory

“ Other desktop operations: You can perform all the standard
operations on the desktop when the Finder is the active
program. %

> See also:  » “MultiFinder's Memory Requirements” in this
chapter

Occasionally you may have to make an adjustment in your use
of the computer’s random-access memory (RAM) to continue
working efficiently with large programs or with several programs
open at once.

Becoming familiar with the amount of memory your Macintosh
has and the memory requirements of the primary programs you
use can help you take full advantage of the computer’s
capabilities.
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MultiFinder's memory  Your computer must have 1 megabyte (MB) of RAM to use
requirements  MuldiFinder. One megabyte usually allows you to open one
program and one or more desk accessories, or two programs that are
not too complex (and thus do not require a large amount of
memory).

If you want to use two or more complex programs at the same time,
your Macintosh probably should have at least 2 MB of RAM. Most
Macintosh models can use 4 MB of system memory or more;
consult the Special Features booklet or the Handbook for your model
for its memory specifications.

Checking the amount of  You can check the amount of RAM in your system with the About
RAM in your Macintosh  the Finder command.

To check the RAM,
About the Finder... choose About:the Finder
3 from the Apple menu while
Alarm Clock | using the desktop.

The About window appears,
displaying details about the

Finder.
__E._(i[ About the Macintosh® Finder™ Click the close box to
Finder: 6,16 Larry, John, Steve, and Bruce Close the About window'
System: 606 © Apple Computer, Inc. 1983-90
RAM in this —1_Total Memory : 1,024K
computer B Finder cean B
(1024K = 1 MB)

E System 161K m

Consult your authorized Apple representative if you want to expand

the RAM in your Macintosh.
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Checking the RAM  The Finder’s About window also displays a graph depicting how
available for programs  much RAM is available for programs and how much memory each
in MultiFinder open program is currently using.

The largest block of
memory available
for a program

About the Finder...

Alarm Clock I

[ElN==== nbout the Macintosh® Finder" ===

To find out how much

RAM is available for
programs, choose About the
Finder from the Apple menu.

The About window opens,
displaying a bar graph that
indicates memory allocation.

Click the close box to

Finder: 6.16
System: 606

Larry, John, Steve, and Bruce
©Apple Computer, Inc. 1983-90

Total Memory :

5,120K

Largest Unused Block: a,éZDK

close the About window.

WA SuperPaint20 700K

@ Microsoft Wo..  1,024K | The bars show
El rinder 160K memory available
System 416K for each open

prograny; the
dark areas show
how much is
currently in use.

Clearing system memory

Arng Y Ifyou're using MultiFinder and have opened and closed a number
for efficient operation

of programs, your Macintosh memory can become fragmented so
that you can't open a large program. You may be able to alleviate
this problem by quitting all the programs you have open, then
starting them again.
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Changing the memory  On rare occasions you may need to allocate additional memory
allocation for a program  for a program. You can do this by adjusting the program’s
memory size in the Get Info window.

To change the memory

allocation for a program,
first click the program’s icon
to select it.

The program must not be in
use when you reallocate
memory.

2 Choose Get Info from

the File menu.

Nai Folder N

Open #®0 The Info window appears.
Prind
finse ki

Gt PrivHeges

3 Drag across the number

% : in the small box at the
SuperPaint 2.0 .

SuperPaint Version 2.0 bottom of the window to
Kind : application -

Size: 526,367 bytes used, 515K on disk Select 1t.

Where: Main disk, SCS1 5

Created: Wed, May 24, 1989, 12:00 PM
Modified: Thu, Oct S, 1989, 9:12 PM
Yersion: 2.0, © 1986, 1988, 1989 Silicon
Beach Software, Inc.

Program
manufacturer’s
suggested

Suggested Memory Size (K): 700—— MCMOry size

Application Memory Size (K): _ Current memory

allocation
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Suggested Memory Size (K): 700 Type the new number
Application Memory Size (K): for the memory you want

to allocate.

Close the Info window

QE Info to complete the

allocation.
SuperPaint 2.0
SuperPaint Yer:

Kind : application
Size: 526,367 bytes

— Important: Do not set the memory allocation for a program to a
size that’s smaller than the manufacturer’s suggested size. This
could cause the program to function improperly or notatall.  —

Ad]“"“““fﬁ’ the RAM cache  The number of programs and desk accessories you can use at the

same time in MultiFinder is also affected by the size of the RAM
cache, if you are using it.

The RAM cache is a specified amount of memory that helps
programs work more quickly and efficiencly. The memory
assigned to the RAM cache is not available to MultiFinder,
however.
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The maximum size of RAM cache depends on how much memory
is available at a given time. If the available memory is less than the
RAM cache size you have set, the system will temporarily reduce the
RAM cache to the maximum allowable size.

To maximize MultiFinder’s ability to handle multiple programs,
turning off the RAM cache or setting it to a very small size—such

as 32K—is advisable.

You set the RAM cache in the General Control Panel. (See

Figure 3-11).

General icon
selected
(the Control Panel
that opens
automatically)

EOI Control Panel S=———|
g Rate of Insertion
E Point Blinking
Generall el s
Desktop Pattern D @ C'
Slow Fast
Keyboard Menu Blinking | Time ®
9:29:54 AM
et
@ 12hr. () 24hr.
Mouse =y
O O0O®|pate [7]
off 1.2 3 10/4/90
)
Ll On Speaker
Sound RAM Cache O P
i _ @ @ off \olume

Size of RAM cache

(preset to 32K)

RAM cache is
preset to Off

Figure 3-11  General Control Panel showing preset RAM cache status

Managing svstem memory
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Size increases or
decreases in
increments preset at
the factory

ﬂhnut the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

@ On
RAM Cache [128K @
) off

Clean Up Window
Penply frash
frase ik

Set Startup...

‘Shut[lmun ! I

Chapter 3: Working With Application Programs

To check the RAM f

cache, choose Control
Panel from the Apple menu
while on the desktop.

The General Control Panel

appears.

2 Click the up or down
arrow to adjust the size of
the RAM cache, or click Off

to turn it off.

It’s a good idea to close the
Control Panel.

Choose Restart from
the Special menu.

The adjusted RAM cache takes
effect when the Macintosh
restarts.



Ending d  When you've finished your work—with a program or for the

1o ceeqd ay—it’s a good ide: some housekeeping before leavi
work session day—it’s a good idea to do some housekeeping before leaving

the computer.

Quitting an  If you are finished using a program, use the Quit command to

’dppﬁ(‘zl[i()l] program  return to the desktop.

Save fAs...

New 3#EN
Open... #*0
Close #EW
Save 388
Save As...

Delete...

Page Setup...
Print... #P

Ending a work session

To quit, first save any
work done since you last
saved the current document.

Even though the program will
p]‘()mp[ you Lo save ]I: you t[‘_‘,’
to quit before saving new
work, it’s good practice to save
your work regularly, rather
than relying on the program’s
safeguards.

Choose Quit from the

File menu.
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Backing up the
session’s work

Shutting down
the computer

If you haven't made backup copies of your work as part of the
saving process, be sure to copy any important documents you've
revised during the session. The safest backup practice is to copy
your work on a disk different from the one on which the
original documents are stored.

To back up your work,

first insert a backup disk
in one of the system’s disk
drives.

2 Copy the new files by
dragging their icons to the
icon of the backup disk.

You can back up on a hard
disk, of course, but making
separate copies of your work
on floppy disks is advisable as
well.

See also:  * “Backing Up a Disk” in Chaprer 6
* “Backing Up a Hard Disk”™ in Chapter 6

When you have finished work for the day and have backed up
your work, you can turn off the Macintosh. (Many people leave
their computers turned on continuously by preference; it’s a
good idea to turn off the computer if you will not be using it for
a few days.)

The procedure for turning off the Macintosh varies somewhat
depending on the model you use, but you should not simply
turn off the power switch.

Chapter 3: Working With Application Programs
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. Important: Always use the Shut Down command before
turning off your Macintosh. This command prepares the system
software for shutdown.

Choose Shut Down
Clean Up Window from the Special menu.
Emply frash |
Erase Disk You'll see a message on the
Set Startup... screen telling you that ic’s all
right to turn off the switch.
Restart

If your model turns off
with a switch, turn it off
now.

L Power switch

Macintosh 1T models that are turned off by the Shut Down
command can be turned on with the Power On key at the top of
the keyboard.

P> Secalso:  * “Using Special Keys and Indicators on the Keyboard™ in

Chapter 1
* “Turning the Macintosh On and Off” in Chaprer 1
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Getting ready
to print

Chapter 4

Printing Documents

Il1c Macintosh provides several different ways to print
documents, whether you are using a program or working on the

deskrop.

This chapter explains the preparations you make for printing,
summarizes the options you can choose for paper, image size,
and print quality, and presents brief instructions for each
printing operation.

Before you can print a document, you must connect a printer to
your Macintosh and prepare the system software to use the
printer.

P See also: = "Conncecting a Printer” in Chaprer 9
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Placing printer drivers  You must place a printer driver in your System Folder for cach type
in the System Folder — of printer you want to use. Figure 4-1 shows the printer drivers

provided with Macintosh system software.

Connects directly Connects via AppleTalk”

rPrep  LazerWwriter

LaserWriter

PrEEAer Al i P PP BT L T LT L TT T o 1R

LaserWriter SC _: Personal Lazeriwriter SC :

!

LG

ImageWriter Irnage’w'riter i AppleTalk Image'riter

*Cable in icon indicates connection o AppleTalk network.

Figure 4-1  Printer drivers supplicd with system software

If you've installed the system software with the Installer, you can
skip this procedure; the Installer’s standard installation copies the
printer drivers to the System Folder.

< Color printing: You must use a special version of the LaserWriter
drivers to print with a color printer that is compatible with the
LaserWriter. Instructions for using these drivers appear later in
this chapter.
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System Folder

To put printer drivers
1 in the System Folder, select
the icon or icons for the printer
drivers you need.

You'll find these drivers in the
Printing folder on the System
Additions disk. (If you are
updating your system software
with an upgrade kit, you'll
find the printer drivers on the

Printing Tools disk.)

Drag the driver icons to
the System Folder on your
startup disk.

If you have multiple startup
disks, repeat this process for
each one.

P Seealo: o “Printing Color or Gray-Scale Documents”™ in this

chapter
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Ch()()smg d Printer You can have several output devices, such as printers, connected
to your Macintosh—directly or by network. You select the
printers and other devices you want to use with the Chooser.

(See Figure 4-2.)

ED% Chooser % Names of individual
= devices appear here
o [&] s when an icon tor
” ) — = type of device is
Ivpes of devices AppleTalk L. Imagetriter <
e selected.
available
L LaserWriter LQ LAPpleTIal ”.éf Network indicor
(must be active to
|_AppleTalk Zones: use devices on
User Name: network orto print
Netwiork Zones CC4-Sth/North on any LaserWriter
CC4-5th/South weent the Personal
(this list appers CC4-Blh/Narth @ Active except the Persona
onlv if the Macintosh CC4-6th/South AppleTalk O nsctive :l—_ LaserWriter SC or the
is on a network that = LaserWriter [1sc)

has zones)

Figure 4-2  The Chooser

To designate a printer,

About the Finder... select the Chooser in the
Apple menu.

Alarm Clock s 5 2
Calculntor ['he Chooser window opens.

Control Panel
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Click the icon for the

I type of printer you want
- to use from the upper-left
AppleTalk | area of the Chooser.

.y

Laserwriter LG AppleTal..[F0

AppleTaik Zones: If necessary, select the
CC4 Upper network zone in which
CC4-5th/Morth
CC4-Sth/South
CE4—6thl’N0rtfk
CC4-6th/South

you want to choose a printer
in the bottom-left area.

Select a Laserwriter: Select the name of the

Fontsgalore = printer you want to use in
Graphics the top-right area of the
Quickndirty Chooser
SteadgstreE_m = ’

£
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Your choice takes effect immediately. It’s a good idea to close the
Chooser window when you've chosen a printer (although you
can leave it open if you prefer).

2 Choosing an ImageWriter: When you use the Chooser to
choose an ImageWriter that is connected directly to your
Macintosh, you follow the steps above, except that you don't
select the name of a printer. Instead. you specify which of the
computer’s two connection areas, called pors, the printer
uses. The Chooser displays a dialog box in which you select
the icon for the port to which your ImageWriter is
connected.

» Seealso:  * “Connecting a Printer” in Chapter 9

Selecting Page  The Page Setup dialog box provides a number of choices for
Setup options  paper size and printing enhancements.

[ECJ==== New branch 2/90 = First, prepate the
document you want
to print.
Narne Earliest Start | Lates
Start 3/4/87
Investigate 3/4/87
Investigate loans 3/4/87

2 To select Page Setup

New options, choose Page
Open... %0 Setup from the File menu.
Close (] )

Save a8 The preset choices (or those
save As... selected most recently) are

o et displayed when the dialog box

Print... ) opens.
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Laserlriter Page Setup Cox ) Select the paper size and
Paper: @ US Lett A4 Lett = -3 Trags
. gus ke g Sl (Cancel ) printing enhancements you
| feduce or % Printer Effects: want and click OK.
Enlarge: [ Font Substitution?
Orientation [ Text Smoothing?
@ Graphics Smoothing?
Faster Bitmap Printing?

Figure 4-3 shows the Page Setup options for the LaserWriter.

Laserlllriter Page Setup 3
Paper size —4p [
aper: @ US Letter O A4 Letter
Gus Legal O BS Letter O[ Tabloid | Cancel
Printed copy as ——Reduce or [Tz Printer Effects: (options )t Clicking the
B I niaige: [ Font Substitution? :
hercent of original Options button
perce L Orientation [ Text Smoothing? I enga dialos box
on screen 1 : Graphics Smoothing? opens i dialog box
Faster Bitmap Printing? for selecting

enhancements to
the printed image.

Paper position |l‘:l'|h:l|1t‘t'll]t‘l‘llh 1o the speed and
(vertical or horizontal) - quality of printed copy

Figure 4-3  Page Setup dialog box for the LaserWriter

The enhancements provided in the Options dialog box include
s aflipped image (vertical or horizontal)
= an inverted image (black-white reversal)

» alignment of bit-mapped areas (provides greater image
resolution but reduces the image by 4 percent)

»  alarger print area (which uses more printer memory and
therefore limits the number of downloadable fonts)

s unlimited downloadable fonts

(Downloadable fonts are type styles stored separately from the printer
and transmitted to it at the time of printing.)
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Figure 4-4 shows the Page Setup options for the ImageWriter.

Imagellriter I 0K n
) W
Papersize L paper: . @ Us Letter O R4 Letter
O US Legal O International Fanfold -[:am:el o
_ O Computer Paper {Tancer) Elimination of top
Paper position — grientation  Special Effects: Tall Ad justed and hottom
tvertical or = 50 % Reduction mareins (for
/ st No Gaps Between Pages drgins Lor
horizontah = I'|_'| R g

Printing your work

computer paper)

| Image adjustments

Figure 4-4

Page Setup dialog box for the ImageWriter

The ImageWriter LQ provides two additional choices: paper size
includes a #10 envelope, and images can be reduced to 33
percent and 66 percent of original size.

You'll see different options for each type of printer you use.
Some programs provide additional options in their version of

Page Setup.

Selections made in the Page Setup dialog box remain in effect
until you change them.

Printing while using an application program is probably the
most common method, but the Macintosh also lets you print
one or more documents from the desktop. In addition, you
can print documents on any color printer that can use the
LaserWriter drivers.

Wherever you initiate printing (by choosing the Print command
from the File menu), you use the Print dialog box to specify
printing options. Figure 4-5 shows the Print dialog box for the
LaserWriter.
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Page range (clicking All prints the entire
document; entering page numbers in the
From and To boxes prints those pages only)

Number of copies
Document report !

Paper-teed method

]

- Cover Page: (@) No O First Page ( Last Page

—Paper Source: @ Paper Cassette () Manual Feed

LaserlWriter “Wellesley ”
- Copies: ([l Pages: @ All O From: To: |

Figure 4-5  The Print dialog box for the LaserWriter

The ImageWriter models offer some different options for

printing. These include

m print quality (best, faster, draft
speed as well as quality)

a choice that affects printing

» bidirectional printing (ImageWriter LQ only)—the printing
element prints continuously as it moves back and forth across

the paper, making for very fast output

m cut sheet feeder use (ImageWriter LQQ only)

Some programs offer additional printing options, such as

printing from first to last page or from last to first page of a

document.
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Printing [rom  You can easily print a document while working in a program’s
within a program  active window.

File | 1 To print from within a

program, choose Print

New #N ;
Open... ap from the File menu.
Close ®W

The Print dialog box appears.

Save S

1 LasertUriter “IWellesley ” : 5% B m 7 Select the optlons you
( Coples:@ Pages: ® fll OFrnm:D!o: 44 want in the Print dlalog
Cover Page: @ No () First Page (O Last Page bOX then CliCk OK
3 ‘
Paper Source: ® Paper Cassette (O Manual Feed

After a moment, a status box
appears and remains on the
screen until printing is
completed.

@ Keyboard shortcuts for printing: You can use the keyboard
shortcut Command-P to initiate printing in most programs,
and you can press Return instead of clicking OK in the Print
dialog box.
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Printing from the dCSl{lU]) You can print one or more documents created in the same
application program from the desktop—without starting the
program first.

To print from the
desktop, select the
documents you want to print.

The group of documents must
all be created by the same
program and must reside on

the desktop or in the same

folder.

Choose Print from the
File menu.

New Folder 3N
Open #0
Print

The program starts
automatically after you choose
the Print command; then the
Print dialog box appears.

LaserlUriter “Wellesley ” m Select the DptiOHS you
copies{[M]  Poges:@n Ofrom:[  ro:[ | want in the Print dialog
Cover Page: @ No O First Page O Last Page b .

ox, then click OK.
Paper Source: (8 Paper Cassetle (O Manual Feed J

The printing status box
appcars, I‘Clnaini!lg on L'hc
screen until printing is
complete. The program closes,
and you see the desktop again.

ot

s Return key shortcut for printing: You can press Return instead
of clicking OK in the Print dialog box.

Printing your work 123



Printing a directory of
disk or folder contents

You can print a directory of the files in the open window on the
deskrop. Figure 4-6 shows a directory arranged by the names of

items in a folder.

New Car

Size Kind

Last Modified

0 insurance

O dealer notes

[ credit union rates

D mortgage chart

18K dooumnent
18K document
14K document
12K document

Mon, Jun 19,1
Fri, Jun 16, 1
Mon, Jun 19, 1
Fri, Jun 16,1

[ old records -- folder Sun, Mov 19,1
O service diagram 80K HyperCard document Mon, Aug 7,1
O tax info 15K document Tue, Jul 18,1

Figure 4-6

Directory arranged by name

The printed directory is a “snapshot” of the window’s entire

contents, showing icons of folders and documents in cheir

relative positions or a list of the items in the same order that

they appear in the window.

[ New Car
Hame Size Kind Last Modified
O3 credit union rates 18K document Mon, Jun 19, 1AF
D) dealer notes 18K document Fri, Jun 1€, 19
O insurance 14K document Mon, Jun 19, 1
O mortgage chart 12K document Fri, Jun 16,19
[ old records -= folder Sun, Mov 19, 1
O service diagram 80K HyperCard document Mon, Aug 7, 19
O taxinfo 18K document Tue, Jul 18, 19
| [oH

Chapter + Printing Documents

Make sure that the

directory you want to
print is displayed in the active
window on the desktop.



To print a directory,

File . "
- choose Print Directory

New Folder 38N

Open seg|  from the File menu.
A The Print dialog box opens.
Close W

Eet Prigiipges KPP
Get Info #1
Buniinaie b:id3:
Put Busay

Page Setup...
Print Directory... .,

Laseririter “Wellesley " ok k) Select the OptiOHS you

toplas:@ Pages: @ Al ) From: i To: D want f‘rom the Pl’il‘lt

Cover Page: (@ No (O First Page () Last Page dialog bOX tl’l(‘.‘l'l CliCk OK
> .

Paper Source: @ Paper Cassette (O Manual Feed

The directory is printed in the
formart currently displayed.

% Return key shortcut for printing: You can press Return instead
of clicking OK in the Print dialog box. +

> See also: = “Displaying Documents by Name, Size, Date, Kind, or
Color of Icon™ in Chaprer 5

N
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Color or
gray-scale printing

Installing the LaserWriter
drivers for color
or gray-scale printing

Some Macintosh models can create and display documents in color
or in multiple shades of gray (called gray scale). You can print these
documents on any color printer that can use the LaserWriter
drivers.

To print color or gray-scale documents, you must use special
versions of the LaserWriter drivers; these files are version 6.0
(or later) of Laser Prep and version 6.0 (or later) of LaserWriter.
You drag these drivers to your System Folder to install them.

Two sets of LaserWriter drivers are supplied as part of the system
software with most Macintosh models; only those with version
numbers 6.0 (or later) can be used for color printing. The drivers
for color or gray-scale printing are on the System Additions disk, in
a folder named “Apple Color.” (If you're updating your system
software with an upgrade kit, you'll find the Apple Color folder on
the Printing Tools disk.)

Important: If you use the 6.0 version of the LaserWriter drivers,
make certain that everyone who uses the same printer you're using
has installed the 6.0 drivers. Different driver versions will cause the
printer to reinitialize frequently.

e = Select the icons for the
== . .
""""" i LaserWriter drivers you

plan to use for color printing.

Chapter : Printing Documents



Version number

New Folder

Open 30

Print

Close W
- 0

Duplicate 3D

S

=

Size:
Yhere:
Created:

Modified:
Yersion;
/

Locked []
Laser Prep
System Software Version 6.0.5
LaserWriter document
32,581 bytes used, T2K on disk

Printing Tools, internal drive

Mon, Jan 15, 1920, 12:00 PM
Mon, Jan 15, 1920, 12:00 PM
6.0.1, Copyright Apple Computer
Inc. 1983-90

Application Memory Size (K):

Color or gray-scale printing

Choose Get Info from
the File menu.

When several icons are
selected, an Info window
opens for each one.

Check the version
number of each
LaserWriter driver.

Verify that the version
numbers are 6.0 or later for
the two LaserWriter files and

1.3 or later for PrintMonitor.

Close the Info window for
each file after you check its
number.

3



128

e =

Systémn Folder

A

Yy

Replace items with the same names
with the selected items?

If necessary, drag the
correct versions of the
LaserWriter drivers to the

System Folder of your startup
disk.

If your System Folder already
contains LaserWriter drivers,
a message will appear asking
you to confirm that you want
to replace the drivers in the

folder.

Click OK to confirm
that you want the new

drivers placed in the System
Folder.

Printing color or  You print color or gray-scale documents in much the same way as
gray-scale documents  black-and-white ones.

4/2/%0

for chef

= Train new staff/1

4/2/90

Supervise
kitchen

training ,_‘Q/:,'go 4/4/90

Dress Training
rehearsal —I |
472430 complate

Orientation
for manager

Supervise /

I——{ dining starf

training
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Prepare the color or
1 gray-scale document you
want to print and display it in
the active window.

Alternatively, you can print
from the desktop by selecting
the icon of the document or
documents you want to print.



Choose Print from the
m——- File menu.

Color option is
available only in the
0.0 LaserWriter
driver (ora

later version), —!

New 3N

Open... #0 The Print dialog box appears,

Close 381 showing options for

Joue i lot/gtay-scale and black and

save As... COh(')[' ggl}’l"SC/a can !dC é;:ll'l

white. olor/gray-scaie 1s the
Page Setup... reray
. preset selection.

Quit 0
Laserlriter “Laserllriter” \i SCIECE the OptiOHS you
anles:m Pages: @ All OFrum:]__ITn: L_I want, then C].iCk OK‘
Cover Page: @& No O First Page () Last Page

Paper Source: @ Paper Cassette (O Manual Feed

e,
Print: @ Color/Grayscale O Black & White

If you are not printing a color or gray-scale document, it’s a
good idea to select the black-and-white option in the Print
dialog box, because printing is faster when this option is
selected.

If you print a color document on a printer that prints only in
black and white, the document will be produced in a halftone
format; thar is, it will be composed of patterns of dots that vary
in intensity according to the colors they represent in the
document.

P Seealo: * “Installing 32-Bit QuickDraw for Enhanced Color
Images” in Chapter 2
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Printing while
using the computer
for other work

Using background printing

Option for
background
printing

130

By using MultiFinder, you can print on a LaserWriter while
continuing to work with one or more programs. This feature,
known as background printing, doesn’t work with the
ImageWriter.

»  See also:

Chapter 3

*“Managing Multiple Programs Using MultiFinder” in

= “Using a Print Server” in Chapter 7

With MultdiFinder in effect, you use the Chooser to turn on
background printing.

About the Finder...

Alarm Clock
Calculator
Chooser

Control Panel

Chooser e

AppleShare |8 a-:-r Writer

=5

Select a Laser'writer:
Barcelona
Capri
Honolulu
London
Paris

AppleTalk Zones:

1
Background Printing: Q On @ Off

CC4 Upper

CC4-5th/North
CC4-Sth/South
CC4d-ath/North
CC4-6th/South

User Name:
Lissy Abraham

@® Active

Appletalk O Inactive

Chapter 4: Printing Documents

To use background
printing, select the
Chooser from the Apple

menau.

The Chooser window opens.

Make sure that a

LaserWriter is selected,
then click the On button in
the middle area of the
window to turn on
background printing.

A LaserWriter must be selected

in the Chooser for the
Background Printing option to
be displayed.

It’s a good idea to close the
Chooser before you acrivare
the window containing the
document you want to print.



| File

New
Open...
Close
Save
Save As...

%N
S0
#Wy
S

Page Setup...

Print a document
as usual.

Select the icons of documents
you want to print on the
desktop, or display a
document in the active
window of a program, and
then choose the Print
command from the File menu.

The Print dialog box appears;
select the options you want

and click OK.

Background printing is under way as soon as the printing status
box disappears. You may notice an occasional pause as you
continue your work while the Macintosh processes the
document for printing.

Managing printing jobs

You can control background printing with PrintMoniror, a

resource supplied with the system software. (See Figure 4-7.)

E——== PrintMonitor

Name of the —
document being
printed and printer
currently in use

Clicking cancels the ___[ Cancel Printing ]

current printing job.
Description and
status of the current
job appear here.

Waiting

1 =2 Read Me @ Wellesley
2 &5 Banana Slug Lyrics @ Wellesley

Documents to be printed
next (selected item can be
gy removed from list)

(“set Print Time... }—— Clicking opens a dialog

-One Page To Print
status: starting job

Printing Status: Sea Lion Salute

box to set the print time.

Figure 4-7

Printing while using the computer for other work 13
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Along with the appropriate printer driver, PrintMonitor must be
in the System Folder of your startup disk. (You can drag it to the
folder or use the Installer to copy it in your System Folder.)

PrintMonitor lets you

= monitor the status of printing

= cancel a document currently printing or waiting to print

= sct printing time (date, hour) or postpone a job indefinitely

= monitor paper supply (PrintMonitor’s icon blinks over the
Apple symbol at the left of the menu bar when the printer is
out of paper)

» signal when to feed paper manually (PrintMonitor’s icon
blinks over the Apple symbol to signal that you must confirm
the manual operation)

To manage print jobs,
make sure that
_ PrintMonitor is in the System
PrintMonitor Folder of your startup disk
and that background printing
is turned on in the Chooser.

132 Chapter 4: Printing Documents



After you have started

About Microsoft Word... printing a document,

SR choose PrintMonitor from the
Calculator Apple menu.

Chooser

Control Panel i : 4

S The PrintMonitor window

Key Caps opens. (PrintMonitor is
scrapbook

available only when background

E Finder printing is under way.)
v Microsoft Word 4.0

& PrintMonitor  °

About MultiFinder..,

Printvoniter E———— Select the option you
Printing .
= SeolionSalute @ Wallesley want, then click the close
Waiting box.
| ©3 Read Me @ Welleslay K|
2 =8 Banana Slug Lyrics @ Wellesley : "
|| You can cancel printing of the
5
current document or select
[ Cancel Printing ] [ Sel Print Time.., ] J.=
Printing Status: Sea Lion Salute one of the documents waiting

One Page To Print

{atidtarting Job to print. (The Cancel button

changes to Remove from List

when a waiting document is
selected.) You can set a time
and date for printing a selected
document by clicking the Set
Print Time button and
entering the time and date in
the dialog box that appears.

% PrintMonitor shortcut: You can also open the PrintMonitor
window by clicking the MultiFinder icon in the top-right corner
of the menu bar until the PrintMonitor’s icon appears.  #

b R TR “Managing Multiple Programs Using MuldFinder” in

Chapter 3
* “Using a Print Server” in Chaprer 7

Printing while using the computer for other work 133






Chapter 5

Organizing Documents

Tie Macintosh desktop simulates an office filing system—
with icons representing documents, folders, and even a Trash
container. Other icons represent application programs, disks,
and other types of files.

The computer’s electronic environment permits rapid handling
of information, and Macintosh system software provides a
number of tools for storing and locating documents easily

and efficiently.

These include

m simple, versatile methods for naming and renaming
documents and folders

= a “visual” filing system that’s casy to move through by
opening containers such as folders or disk icons

= a powerful desk accessory, Find File, to locate items by name
or partial name

s directories of disk or folder contents arranged by icon, name,
date, size, or type of document.

s casy display of important information about a document



Hﬂndhng You use standard Macintosh operations to name and rename
documents documents, copy them, and move their icons. In addition, you
can make one or more duplicates of any document without
changing its name or location.

All these operations take place on the desktop.

Mo\-’ing a document  You drag a document to move it.

To move a document,
first point to its icon.

Dacurment 1

Drag the document’s
icon to the new location.

As you drag, an outline of the
icon moves with the pointer.

When you release the mouse
button, the icon appears at the
new location.

130 Chapter 5: Organizing Documents



Copying a document  You drag the document’s icon to the icon of a disk to copy it
onto another disk  onto that disk.

1 To copy a document

el onto another disk, first
point to its icon.
logo
L Drag the document’s
: icon to the icon of the

disk onto which you want to

= copy it.

As you drag, an outline of the
document’s icon moves with
the pointer.

Release the mouse
button when the disk icon
becomes highlighted.

Files/Folders remaining to be copied: [:]
Writing: logo
[ —

When you release the burtton,
the document is copied on the
disk. A dialog box reports the
status of copying,

Handling documents 137



Copying a document  You can make a copy of a document on the same disk by using
on the same disk  the Duplicate command.

To make a copy of a

document on the same
disk, first select the
document.

2 Choose Duplicate from

New Folder %N the File menu.

[!p_en 20 The document is duplicated; it

g::,r;:a P has the originzl‘]“s name,
preceded by “Copy of.” A dialog

Get Info %1 box reports copying status.

Duplicate :

Pisd B

If necessary, rename the
Files/Folders remaining to be copied: [ 1] ¥

Writing document or move i1t to

Copy of map
] another location on the disk.

You can’t give the duplicate
exactly the same name as the
original if you keep both of
them on the desktop or in the
same folder.

,

% Duplicating shortcur: You can also use the keyboard shortcut
Command-D to duplicate a selected document,
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Renaming a document  You use the standard desktop editing techniques to change a

document’s name.

Electronic Art List

Handling documents

To rename a document,
first select it.

Type the new name for
the document.

When you begin typing, the old
name disappears and an
insertion point blinks to the
right of the characters you type.

Click anywhere outside
the document’s icon.

The insertion point disappears
when you click, and the icon is
deselected.

139
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Using folders to
organize your work

Like traditional filing systems, the Macintosh uses folders to

store and organize documents. Unlike a bulky paper filing system,
however, the Macintosh lets you easily place folders inside

one another to create multiple levels of organization. And you

can move folders around, changing the order in which they

are nested.

Figure 5-1 shows an example of a floppy disk that contains three
levels of folders.

Work
Startup

Svstem Work in
Folder Progress
|
]
PSR T thff Eeyr e __’E
; |
i

To Do

Projects List

i
: i
Office Proposal Rovaly
Memos Proposal Work
Figure 5-1  Three levels of folders and documents on a floppy disk

Whether you use a hard disk, which can store hundreds of folders
and documents, or floppy disks for your files, you can establish an
efficient filing system with folders.

Chapter 5: Organizing Documents



(Irc:iling and  You use the New Folder command to create a new folder.
naming folders
Choose New Folder

from the File menu.

A new folder named “Empty
Folder” appears in the active

window; it is already selected,
so you can easily rename it.

Type a name for the

folder.
When you begin typing, the old

name disappears, and an
insertion point blinks to the
right of the characters you type.

3 Click anywhere outside

the folder’s icon.

k Expense reports

The insertion point disappears
when you click, and the icon is
deselected.

@ New folder shortcut: You can also use the keyboard shortcut
Command-N to create a new folder on the desktop.

Using folders to organize your work 14l
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Placing documents
inside folders

You drag documents to place them in folders.

Chapter 3: Organizing Documents

To place a document
inside a folder, first point
to the document’s icon.

Drag the icon to the
folder.

An oudine of the document’s
icon moves with the pointer as
you drag.

Release the mouse
button when the folder’s

icon becomes highlighted.

The document disappears
inside the folder when you
release the mouse button. You
can verify this action by
opening the folder and
viewing its contents.



Nesting folders  You can store folders inside other folders to create multiple levels of
storage. You nest folders by dragging them.

Ot '29

Using folders to organize your work

To place a folder
inside another folder,
point to the first folder’s icon.

2 Drag the first folder’s
icon to the folder in
which you want to nest it.

An outline of the first folder’s
icon moves with the pointer as

you drag,.

Release the mouse
button when the
destination folder’s icon

becomes highlighted.

The first folder disappears
inside the destination folder
when you release the mouse
butron. You can check this
action by opening the folder
and viewing its contents.

143



LOCﬂtlng documents  Macincosh system software provides a desk accessory called Find
and folders  File for locating documents and folders anywhere on a disk. When
you're working with documents in a program, some dialog boxes
provide menus that show levels of folders.

» Secalo: * “Installing a Desk Accessory”™ in Chapter 8

Finding documents h}' name  You can use the desk accessory Find File to locate a document or
or partial name ~ folder anywhere on a disk. It is installed as part of the standard
system software for all Macintosh models with an internal hard disk
drive.

Find File lets you specify the word or phrase for which it will search,
reporting all documents and folders whose names contain the search
text. Then, when you select a document from those listed, Find File
shows that document’s location. (See Figure 5-2.)

EOe——————=—ind file The stop button

L— harddisk L is highlighted
when the search
Search for: Caspar : .
is complete.

Disk searched

Search text

N 4
LSCampainis A Search button
O Caspar map (ks it
: s g O Caspar map in word processor clicking 1
Documents found 3 |5 Caspar taxes 12/7/88 begins a search)
[ Caspar taxes 4/6/89 I ) .
. Created:  Thu, Apr 6, 1989; 7:57 AM €3 Mortgage/house = Location of
Details of selected Modified:  Sat, Apr 15,1983, 11.59PM | = Matching devel. selected
document Sizac s doda bules; & HyperCard ¥ .
2K on disk yperCar document (icons

<l

= harddisk

represent levels
of nested folders
Figure 5-2  Find File showing scarch report and location of and (ilﬁkl
searche
selected document carched)
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About the Finder...
Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo
Key Caps !
Scrapbook
EO Findfle"en—~——
cgmaindisk i"i—.;‘\l
search for: || L4
EO Find File
Dharddisk
Search for:  |JH|

= harddisk

Search for:

ENe==—————Ffilfle=F—————

JH|

Locating documents and folders

1 To search for a file, first
choose Find File from the
Apple menu.

The Find File window opens.
A blinking insertion point is in
the text box.

If necessary, click the

disk icon at the upper-left
corner of the window to
switch disks for searching,.

Type the text you want
to locate.

The text can be the complete
name or a partial name.

Click the search button
(the icon of a walking
figure).

Find File searches for the text,
and then displays the names of
documents and folders that
contain the text.



0 JH status-1987
[ U status-1988
O s selfreview 10/12/88

D Status address bst-JH 12
Details of selected Created:  Wed, 0ct 28,1987, 715 AM [ | €2 JH status/memos =
- Modified: Fri, Oct 30, 1987;8:12 AM & Mni(hing devel.
document ke T <1 HyperCard
|__| = harddisk £

Folder levels 1o
document

About Find File...

Search Here...
Move to Desktop

Select the document you
want to locate (scrolling
if necessary).

Information about the
document and its location are
displayed in the bottom panes
of the Find File window.

6 (Optional) To move the
selected document or folder
to the desktop immediately,

choose Move to Desktop from
the Find File menu.

The Find File menu, which
appears to the right of other
menu titles in the menu bar, is
available only when the Find
File window is open.

s« Another searching feature: Find File also allows you to limit a
search to a folder’s contents with its Search Here command.
This command is also available in the Find File menu.  «

P Seealso: * “Putting Away Irems on the Desktop™ in this chapter

1\-’[()\'ing (lLliCkl"\" through When you're working in a program and want to open or save a
levels of folders when  document, you have a quick way to move around in mulriple
using 4 program levels of folders on a disk: a directory dialog box that lets you
change levels of nesting and even switch drives and eject disks.

(See Figure 5-3.)
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Select a Document:

Open folder (title of —F=To be phoned |

DOP-UP menu)
PR [0 st can 5] ©harddisk
Documents 1| B 2nd call 6898K available

D form letter
M not reached

L Disk

Figure 5-3 A directory dialog box showing a folder's contents

If the document used most recently is in a folder, the folder’s
name in the dialog box is actually the tide of a menu that “pops
up” when you place the pointer on it and press the mouse button.

The folder “To be phoned™ in Figure 5-3 and Figure 5-4 is
nested inside other levels of folders. Figure 5-4 shows those
levels of folders; “To be phoned” is inside “'89 overdue,” which
is inside “Oct. unpaid,” and so on. The last level in the pop-up
menu is the disk.

Select a Document:

<'89 uuerdueE 'ﬁ

0O 1st — harddisk
0 2ndg g gz: Il:;;pnid 6898K available
0 for 2 ;

1 Invoices '89 -: ject
D nof = harddisk

=

Figure 5-4  Open pop-up menu showing levels of folders and disk

Locating documents and folders 14



Moving to a new folder
level with a pop-up menu

Current folder level

Contents of _|

the folder
currently open

148

When a pop-up menu is available in the directory dialog box of
an application program, you can use it to move rapidly to
another level of your filing system.

Select a Document:

‘= To be phoned
0 Istﬂ '89 overdue
D Znt@ Oct. unpaid
0 for = 0ct. '89

O nof =4 Invoices '89
— harddisk

Select a Document:

= To be phoned

tﬁl ‘89 overdue
= Oct. unpaid

3 0ct. '89

= Invoices '89

— harddisk

Select a Document;

{3 Invoices '89]
2 April '89
O Aug. '89
[ Dec. '89
O Feb. '89
[ Jan. '89
3 July '89
1 June '89

Chapter 5: Organizing Documents

To move to a new level,
first open the pop-up
menu by pointing to its title
and holding down the mouse

button.

The pop-up menu opens,
showing the levels of folders
and the disk name.

Drag the pointer to the
name of the folder or disk
to which you want to move.

Release the mouse
button to move to the
new level.

When you release the button,
the folder or disk name you
chose appears as the title of the
pop-up menu in the dialog box.



Putting away items  Often the simplest way to use a program, document, or folder is
on the desktop  to drag its icon out of a window onto the desktop. Then the
icon stays on the desktop until you remove the disk on which
the program, document, or folder actually is stored.

If you've placed an icon on the desktop, you can replace it in its
original location quickly and easily with the Put Away command.

To put an item away,
U first select its icon.

Choose Put Away from
m : the File menu.

Ngap Falipy
Open %0 The selected item disappears
Print ~ from the desktop and is put
G L back at the level where it
Gl Privieges %P originated. (You can check that
Get Info E| the item has been put away by
Duplicate %D looking in its original location.)

R T—
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Getting directory
information

Displaying documents
by name, size, date,
kind, or color of icon

The Macintosh provides quick access to details abourt the
documents and disks it manages.

The View menu, which is always available from the desktop,
offers several different ways to view the contents of a disk or
folder. Two other commands—Get Info and About—present
details about individual documents and applications.

Using the View menu, you can list the contents of a window
according to name, size, date, kind, or color of icon, in addition
to by icon or small icon.

An icon view is useful when you want to move and select icons
frequently. A directory arranged by name, size, date, kind of
document, or color of icon is useful when one of those attribures
is the key information you need about the documents in the
window. For example, listing documents by the date and time of
their most recent modification makes backing up a large number
of files an orderly task.

1 To change the way you

. . L]
VICEW a WlI]CIOWS contents,

J:g ?::?]" lean first open the View menu by
by Name pointing to its title and
by Date holding down the mouse
by Size button.
by Kind

The View menu opens,
showing the choices available.
A check mark indicares the
view currently visible in the
active window.

Chapter 3: Organizing Documents



vby
by

by
by
by

Drag until the view you
want becomes

highlighted.

Small lcon
Icon

Date
Size
Kind

E0 Invoices ‘89 Release the mouse

e Sige Biond button to change to the
3 April ‘83 -- folder %
[ Aug, 89 == folder new view.
[ Dec. ‘89 -~ folder
O Feb. ‘89 — folder When you release the button,
3 Jan, '89 == folder ” . . 3
e Hol e the view in the active window
k] changes to the item you chose

Getting information
about an icon

from the View menu.

The Get Info command displays information about a single
item on the desktop or in an open window.

To get information,

first select the icon for
k which you want details.

Systern Folder

Getting directory information



o)
(%)

Choose Get Info from
the File menu.

New Folder
Open #0 The Info window appears,
Peint displaying information about
Close AL ) T

the selected icon.

Duplicate

L —— — Click the close box to
close the Info window

System Folder

= > .

e when you're finished.

Size: 1,397 314 bytesused, 1 373K on
disk, for 31 files

Where : hirddisk, external hard disk drive

Created: Fri, Aug 31, 1990, 12.00 PM
Modified: Fri, Aug 31, 1990, 12:00 PM

Text box tor
adding notes

* Get Info shorteut: You can use the keyboard shortcut
Command-I to display information about the selected item. <

* Another use for the Info window: You can also use the Info
window to lock the contents of a document.  #

> See also: » “Protecting Information on a Disk”™ in Chaprer 6

Chapter 5: Organizing Documents
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Gelting information  You use the About command in the Apple menu to get information

about a program  abour the program currendly in use. From the desktop, the Abour
command provides details abour the Finder.

Version numbers

RAM in this |
computer

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel

| _Finder: 6.16

EE About the Maciniosh® Finder™ %

Larry, Jehn, Steve, aad Bruce

System: 6056 ©Apple Compater, inc. 1983-90
— Total Memory: 1.0MK

B Finder 8e8K

B susterm 15ek R

RAM used (dark)
and available (light)

Getting directory information

To get information
1 about a program, choose
About from the Apple menu.
(The program’s name is part
of the command.)

The About window appears,
displaying derails about the
program.

Click the close box to
close the About window
when you're finished.

LS






Chapter 6

Managing Disks
and Disk Drives

Disks are the Macintosh’s principal storage medium. Every
Macintosh model has at least one internal floppy disk drive, and
many models offer an internal hard disk as well.

The system software and most applications are supplied on 3.5-
inch floppy disks, which are ideal for transporting data and
backing up important work,

Hard disks offer the advantages of large storage capacity and
speed of operation, although they are not as easily transported as

floppy disks.



USing ﬂoppy disks The floppy disks used in a Macintosh are flexible plastic disks (che
- source of the name “floppy”) inside a hard plastic case 3.5 inches
wide. A metal shutter at one end of the disk slides to one side when
the disk is in the drive, exposing the flexible plastic on which
information is stored. The plastic is coated with a magnetic layer
similar to that of recording tape (such as in tape cassettes).

Disk capacitics  The amount of information a floppy disk can store depends on the
type of disk drive in which it is used and on the way the disk is
initialized—rthat is, the way its magnetic surface is electronically
prepared to store data.

Macintosh disks have one of three capacities:
= 400 kilobytes (K)

s 800K

= 1.4 megabytes (MB)

Consult the Special Fearures booklet or the Handbook that came
with your computer for the capacity of floppy disks used in your
Macintosh model.
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High-densil‘\}: disks Disks with a capacity of 1.4 MB are high-density disks and are
and SuperDrive used in the Apple SuperDrive™ high-density disk drive. High-
density disks usually have the letters “HD” on their case or
metal shutter. High-density disks also have an extra hole in their
plastic case (on the opposite side from the disk-locking tab),
which allows the SuperDrive to recognize them.

A\ Important: Use high-density disks in the SuperDrive only. You
cannot use these disks in drives that accept only 800K or 400K
disks. (See Figure 6-1.)

(LI [0 (LT
N . . SuperDrive
| HD | | 800K | 100K |
Extra hole in
disk case

W O (LT
, ) SOOK drive

| 00K 00K
_ 100K drive

n | DOK | | 400K

Figure 6-1 Proper usce of floppy disks

The SuperDrive accepts all three types of floppy disks—400K,
800K, and 1.4 MB. This drive can also read 3.5-inch disks from
computers that use the MS-DOS operating system.

P Seealsa:  * “Locking a Floppy Disk™ in this chapter

* Appendix C, “Exchanging Disks and Files With
MS-DOS Computers”
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Inserting a disk

JH's horne disk

Slide the disk, metal end

first and label side up,
into the drive.

The disk snaps into place.

Check the screen to be
sure that the disk has been
recognized.

The screen will show either an
icon for the disk or a dialog
box reporting that the disk is
unreadable.

P Seealso: ¢ “Initializing and Naming a Disk” in this chaprer
* “Testing and Repairing a Disk” in Chapter 10
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Ejecting a disk  You can easily eject a floppy disk from the desktop.
from the desktop
Point to the icon of the
disk you want to eject.

JH's hore disk

2 Drag the disk icon to
H the Trash icon.

When the Trash icon becomes

JH's horne disk
e highlighted, release the mouse
% button. The disk is then
SR | - : €jCCth.
ORI 1 1 3 I

w  Other ways to eject a disk: You can also select a floppy disk
and choose Eject from the File menu, or use cither of two
keyboard shortcuts to eject a floppy disk. Command-E ejects
the selected floppy disk; Command-Shift-1 ejects the disk in
the internal drive (the first drive if there are two); Command-
Shift-2 ejects the disk in the second internal drive or an
external floppy disk drive.

> Secabo: o “Initializing and Naming a Disk” in this chapter
* “T'esting and Repairing a Disk™ in Chapter 10
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Ejecting a disk from  You can eject a disk when you’re working in a program by using
within a program  a command, such as Open or Save As, that displays a directory
dialog box.

Current disk With the directory
o : . .
S oLk 5.8 = Scottie’s D dialog box displayed in a
S 0 fHpplelink Heip . .
‘ |‘,|L'(l|)}|l!t;ﬂ ——( ) | program, click the Drive
is unavailable O Art ideas i s .
fora bard disk S0/ | (oivex] | button to locate the disk you
0 Hackup of chap 2 ~ ... 2
want to eject.
Save this document as: ]
U | Ctance) | Skip this step if the displayed
disk is the one you want.
Click the Eject button
O e %5 E data 2/90 to eject the current disk.
i3 5-42
B $-491 (CEject]

The disk is ¢jected. You can
then insert a different floppy

Save this document as: Csae 31 disk. (The Eject button is
|| I Cancel

&

dimmed, and thus doesn’t

operate, when a hard disk is
selected.)
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[nitializing and ~ You name a disk when you initialize it. /nitializing (also called
naming a disk  formatting) prepares a new disk to store information; if a disk
already contains data, initializing it erases that dara.

A Warning: Be sure that any disk you plan to initialize contains
no information you want to save, because you'll lose that
information during initialization. a

After placing a new disk
in the disk drive, click

Initialize (if the disk is a high-
Initializen density one), Two-Sided (for
an 800K disk), or One-Sided
High-density disk (for a 400K disk).

This disk is unreadable: 1
Do you want to initialize it?

A second dialog box appears,
advising you that initializing

This plsk e will erase the disk. (If the disk
Do you want to initialize it?

has already been initialized
(Ceiect ) (one-sided) (fwo-sideq) and is not damaged, neither
dialog box will appear—you’ll
800K dlisk just see the disk icon.)

You can click Eject if you don't
want to initialize the disk.
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This process will erase all
information on this disk.

Please name this disk:
Untitled
|

Please name this disk:
|Tirn's backup |

Click the Erase button
to continue initialization.

You can click Cancel to avoid
erasing the disk.

If you click Erase, a third
dialog box appears, asking you
to name the disk.

Type the name you
want for the disk.

If you don’t name the disk, it
will have the name “Untitled”
when it is initialized.

Click OK to complete

the initialization process.

Initialization proceeds, with a
status box reporting its
progress. When the process is
complete, the disk icon
appears on the desktop, with
the name you typed.

> Seealso: Appendix C, “Exchanging Disks and Files With MS-DOS

Computers”
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111'115111?, a disk Initializing a disk erases any information on it. To erase an
already initialized disk, use the Erase Disk command in the
Special menu; this command actually reinitializes the disk.

To erase a disk, first
select the icon of the disk
you want to erase.

Choose Erase Disk from

Clean Up Window the Special menu.

famply frash An alert box appears, giving
RrasEllisk you a chance to cancel the
Set Startup... ;

erasure and asking you to
Restart select the capacity of the disk
Shut Down after it is erased.

Click the button for the
Completely erase disk named

“Files for Kate" (internal disk CaPaCltY you want.
drive)?

The disk is erased and

(Ceancet ) (one-sided] (fwapgided) initialized for the selected
capacity (one-sided is 400K,
two-sided is 800K). A status

box on the screen reports the

progress of this procedure. (If
you're initializing a high-
density disk, the buttons are
named Cancel and Initialize.
Click Inirialize.)
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Renaming a disk  You can easily rename a disk.

1 To rename a floppy
disk, first select its icon.

Type a new name for

H the disk.
Insertion point - thn yU‘U ngl n lypl l'lg, thc
(blinking) archives 1/90f pointer disappears. The

insertion point blinks at the
end of the text you type.

Click anywhere outside
ke the disk icon.

L y When you click, the insertion
RrCIRES A0 point disappears and the icon

is deselected.
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Backing up a disk

Although floppy disks are designed to last through thousands of

hours of use, they can become damaged or worn. So it’s wise to
g

make backup copies of important work and application

programs, especially if you use only floppy disks with your

Macintosh.

You can make backup copies of individual documents as

necessary, but you probably will want to back up such essential

disks as startup disks, system software master disks, and program

master disks.

WP startup

WP startu

Using floppy disks

T'o make a backup copy,

first point to the icon of
the floppy disk you want to
back up (the source disk).

Drag the icon of the
floppy disk you want to
back up to the icon of the disk

on which the copy will be
made (the destination disk).

The destination disk can be
either a floppy disk (as
pictured) or a hard disk. If the
destination disk is a floppy
disk, an alert box appears,
asking you to confirm that the
information being copied will
replace the contents of the
destination disk.
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fAire you sure you want to completely 5 .
replace contents of make sure youre makmg

"backup WP" (external drive) the correct decision, then

with contents of
"WP startup” (internal drive)? procedure.

m (Cancat] Your disk is backed up; a

Read the message to

click OK to begin the backup

dialog box reports the progress

Using a hard disk

of copying.

(If you click Cancel rather than
OK, no backup takes place.)

< One floppy disk drive: 1f your Macintosh has only one floppy
disk drive (and no hard disk), you can use this backup
procedure, but you'll have to swap disks a number of times.

) Backing Up a Hard Disk™ in this chapter

A hard disk consists of metal disks permanently sealed inside a
drive compartment. The drive’s sealed environment permits
extremely fast reading and writing of information, and the
multiple disks inside a drive store 20 to 160 megabyrtes, or even
more.
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Hard disk precautions

Because the components inside a hard disk drive are very close
together and moving very fast when the drive is turned on, these
drives should be handled with care.

Observe these precautions when working with a hard disk:

Avoid jostling or rough handling of the drive (and thus of the
Macintosh with an internal hard disk). Never move a
Macintosh when the hard disk drive is operating,

Some models of the Macintosh are designed to operate either
sitting flac or turned on one side. Serting Up Your Macintosh
for your model includes special instructions if your model
can be placed on one side. Do not place the computer on its
side unless it is designed to operate this way; it could affect
hard disk operation.

Always keep the drive on a sturdy, level surface.

Operate a hard disk at temperatures between 50 and 104 degrees
Fahrenheit and at a relative humidity of 20 to 80 percent.

Avoid spilling any liquids on or near the drive.

Do not expose the drive to hazardous vapors, such as those
from cleaning solvents.
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Initializing and

naming a hard disk

for the first time

SCSI device
number of the
current hard disk

You use the Apple HD SC Setup program, supplied on one of
the system software disks, to initialize and name a hard disk for
the first time. /nitializing (also called formatting) prepares the
disk’s surface to store information.

The internal hard disks in many Macintosh models are
inidialized at the factory; these drives do not have to be
initialized again before you use the computer. If the disk in your
computer has been initialized, you'll see the disk’s icon on the
desktop when you first turn on the computer.

Warning: If you received a hard disk with A/UX on it, do not
initialize that disk; doing so will erase A/UX. Instead, see the
A/UX documentation for instructions. &

5

#pple HD SC Setup

To initialize a hard disk,
start Apple HD SC Setup
by double-clicking its icon.

The program’s main dialog
box appears.

If necessary, click the

Apple HD SC Setup
N\ Drive button to select the
| SCSI Device: 0 ; v o0
j disk you want to initialize.
|
‘ The current disk’s SCSI device
number is displayed above the

'_Ei_iék_-ﬂi'iﬁ-ﬁé'r'iu'rii'a'ii"c'hé'ﬁ'n'iﬁd"s Drive button; the disk’s name
1S . n
is shown in the message area at

the bottom of the dialog box.

Message arca
showing the name of
the current hard disk
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Apple HD SC Setup

Initializey TR
updaie euice:

The velume name is Hard disk
#2

0|

A

Initializing will erase all of the data
on this disk. Do you want to
initialize this disk?

[ cancel || [ 1nit k]

['sing a hard disk

When the number and
3 name of the hard disk you
want are displayed, click
Initialize to begin initializing.

A dialog box appears in which
you must confirm or cancel
your decision to initialize.

Click Init to initialize

the hard disk.

When you click, the pointer
becomes a spinning beach ball
and the message arca of the
dialog box reports the status
of initialization. After a short
while, the computer’s alert
sound signals the end of the
process, and a message reports
successful initialization. (If
you see a report that
initialization has failed, begin
the process again.)

A dialog box appears, asking
you to name the disk.
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([ Un titled

If necessary, type a name
for the hard disk, then
click OK.

Please name this disk:

If the disk has been initialized

Partitioning a hard disk

previously, the naming dialog
box will not appear.
p

Apple HD SC Setup Click Quit When the
T (R - U message reports successful
| initialization.
|

Drive initialization

‘ successfully completed,
|
|

» See also:

* “Serring the SCSI Device Number”™ in Chaprer 9
* “Testing and Repairing a Disk™ in Chapter 10

You partition a hard disk—that is, divide its storage area into
two or more separate sections—so that the disk can be used by
different types of computers, such as the Macintosh and the
Apple IIGS®, or by different operating systems, such as the
standard Macintosh system and A/UX.

Important: Apple recommends that, whenever possible, a
separate hard disk be used for cach different operating system.
This strategy is preferable to partitioning a single hard disk for
use by two operating systems.

Chapter 6: Managing Disks and Disk Drives



The instructions that follow provide a summary of the

partitioning process; be sure to consult the documentation for

the other operating system or systems you will use on the

partitioned hard disk for details regarding your choice of

partition ng options.

A Warning: If you reccived a hard disk with A/UX on it, do not
partition that disk; doing so will erase A/UX. Instead, see the

A/UX documentation for instructions on partitioning. A

SCSI device
number of the
current hard disk

&pple HD SC Setup

Apple WD SC Setup

(anitiolize) | o1 pevice: o
|

i
i
Test |
|
|
!

[ Ouit

The volume name is Andy’s HD

Message area

showing the name of

the current hard disk

Using a hard disk

To partition a hard disk,
first start Apple HD SC
Setup by double-clicking

its icon.

The program’s main dialog
box appears.

If necessary, click the
Drive button to select the
disk you want to partition.

The current disk’s SCSI device
number is displayed above the
Drive button; the disk’s name
is shown in the message area at
the bottom of the dialog box.



fipple HD SC Setup

@ | SCSI Device: 5

= ; Drive
Pamtiung
Test

The i.lBiushe IIBITVIBVIS 'Mard disk
#2

Standard partitions
fmay vary)

Select a predefined disk partitioning scheme and click 0K to partition

the entire disk. Or select Custom to make your own partitions.

Manimum Macintosh
Minimum Macintosh

50% Macintosh

A/UK 8OSC (2 Macintosh)
A/UK 160SC (20 Macintosh)
/UK 160SC (40 Macintosh)
A/UK 160SC (60 Macintosh)

Button to display

a dialog box
for adjusting
partition size

= Hard disk #2
Custom |
5

Chapter 0: Managing Disks and Disk Drives

When the number and
5 name of the hard disk you
want are displayed, click
Partition to begin the
partitioning process.

Select a standard

partition from the list, or
click Custom to adjust
partition size, then click OK
to partition the hard disk.

Consult the documentation
for the other operating system
you plan to use for specific
partitioning instructions. The
standard partitions available
may vary; the list shown here
is representative.

When you click OK, a dialog
box appears giving you a
chance to confirm or cancel
your decision to partition.



O

The data on SCSI| drive number '5' will be
lost during the repartitioning process.
Press OK to repartition.

[ 0K k] [[ Eance|_:[]

fipple HO SC Setup

Initialize

Partition

Test

Con)

SCS1 Device: 5

il

Partitioning successfully
completed.

> See also:

Using a hard disk

Click OK to partition
the hard disk.

When you click OK, the
pointer becomes a wristwatch
and the message arca of the
dialog box reports the status of
partitioning. After a short while,
the computer’s alert sound
signals the end of the process,
and a message reports successful
partitioning. (If you see a report
that partitioning has failed,
begin the process again.)

6 Click Quit when the
message reports successful
partitioning.

* “Setting the SCSI Device Number” in Chaprer 9



Erasing a hard disk

You can erase a hard disk using the Erase Disk com mand. This

command reinitializes the disk.
e

Clean Up Desktop
Pmpiy trash
Erase Disk |

Set Startup...

Restart
Shut Down

[ Completely erase disk named
"Walthrop" (external hard disk
drive)?

Chapter 6: Managing Disks and Disk Drives

To erase a hard disk,
first select the icon of the
disk you want to erase.

Choose Erase Disk from

the Special menu.

An alert box appears, asking
you to confirm that you want
to initialize the disk and giving
you a chance to cancel the
erasure.

Click the Initialize
button.

The disk is erased and
reinitialized. A status box on
the screen reports the progress
of this procedure.

(Clicking Cancel rather than
Initialize cancels the erasure.)



Renaming a hard disk

Insertion point
(hlinking)

Backing up a hard disk

You rename a hard disk wich che standard editing steps.

To rename a hard disk,

ﬁ first select its icon.

Type a new name for
the disk.
I

. J 1 7 1 o G

Sarah’s disH \X/'l'lcn you begin typing, the
pointer disappears. The

insertion point blinks at the
end of the text you vype.

Click anywhere outside
5 the disk icon.

il : When you click, the insertion
Sarah’s disk ke hen you click, the insertio
point disappears and the icon

is deselected.

You can back up the work you store on a hard disk by copying
individual files in the usual way (dragging their icons to the icon
of another disk).

You can also use a commercial backup program to copy some or
all files from a hard disk to another hard disk, to a tape drive, or
to a series of floppy disks.

Whatever method you use, be sure to back up important files
and programs on your hard disk regularly.

P Seealso: o “Backing Up a Disk” in this chapter
* “Backing Up the Session’s Work™ in Chaprer 3
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Startup disk
sequence

The scanning order
for a startup disk

The Macintosh follows a set procedure, called the scanning order,
to locate a startup disk. The computer always looks first in the
floppy disk drives, then it looks at external and internal hard disks.

You can specify which device will be the first hard disk in the
computer’s scanning order by using the Startup Device section
of the Control Panel.

The Macintosh scans disk drives for a startup disk in the
following order:

» internal floppy disk drive

s second internal floppy drive

» cxternal floppy drive

m startup device set in the Control Panel

s internal SCSI hard disk (the computer waits 15 seconds for
the internal drive to warm up)

s external SCSI hard disk (if more than one, in descending
order of device numbers)

s internal hard disk (the computer returns to this drive and
waits another 15 seconds)

= floppy disk drive (if no startup disk has been recognized, the
computer displays a blinking question mark over a floppy
disk icon and waits for a startup disk to be inserted in a

floppy drive)
> See also: = “Specifying Items to Be Opened at Startup” in

Chaprter 2
* “Setting the SCSI Device Number” in Chapter 9
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Designg{[jng a hard disk  If you use more than one hard disk with your Macintosh, you
as the startup device should specify which one is the startup disk. You use the Startup
Device section of the Control Panel for this task. (See Figure 6-2.)

ECl

Control Panel —=————
=

Monitors

=) =
Jose’s #1

Figure 6-2  The Startup Device section of the Control Pancl

When you designate a starcup device, it precedes all other
devices except floppy disks in the scanning order.

To set a startup device,
Euut e Finder.. first choose the Control
Panel desk accessory from the
Alarm Clock Apple menu.

Calculator
Chooser
Control Panel
DiskInfo

The General Control Panel
appears.

Startup disk sequence
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Scroll if necessary, then
2 select the Startup Device
icon in the left area of the
Control Panel.

The Startup Device section
appears.

Click the icon of the disk
you want to be the
startup device.

Click the close box to
close the Control Panel.

It's a good idea to close the
Control Panel, although you
can leave its window open.



Clean Up Window
fanply frash
Prave sk

Set Startup...

Restart
Shut Down

~ Choose Restart from the
) Special menu.

The computer restarts, using
the disk you specified as the
startup device.

P> Seealso:  * “The Scanning Order for a Startup Disk” in this

chapter

PI’OteCtiﬂg You can protect all the information on a disk by locking the disk
information itself, or you can lock individual documents and applications in

the Info window.

on a disk

The informarion in a locked document or disk can’t be changed
or thrown away; it can usually be opened or copied, however.

Locking a floppy disk  You adjust a tab on the disk’s plastic case to lock it.

Unlocked Locked

Protecting information on a disk

To lock a floppy disk,
first locate the tab at the
top-left corner on the back of

the disk.



Slide the tab upward
with the tip of a ballpoint
pen (or a similar tool).

The disk is locked when the
tab is in the upper position
and an opening is visible in the
disk’s case below the tab.

Sliding the tab down (covering the opening in the case) unlocks

a floppy disk.
[.()Cl\'i[lg documents  You use the Get Info command to lock a document.

To lock a file, first
select its icon.

Choose Get Info from
the File menu.

New Folder 3N

Open *0 The Info window opens.
Print

Close EW

Get Info &I

Duplicate D
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3 Click the Locked box in

the upper-right corner.

Kind: Copy of WritelNow document
Size: 1,024 bytes used, 1K on disk

Yhere: archives, internal drive

Ee—y— Click the close box to

Locked [ | close the Info window.

by
=E

EE From Any
The document is now locked.

You can also lock a program using the Info window (to prevent
the program’s being erased, for example), but locking a program
may affect its operation.

« Locking folders: You can’t use Get Info to lock folders;
however, you can protect the contents of folders on an
AppleShare file server by using the Access Privileges desk
accessory in the Apple menu.

» Seealso: o “Creating Private Files on a File Server” in Chaprer 7
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Adding the
Macintosh to
a network

Chapter 7

Using the Macintosh on a
Computer Network

All Macintosh models have built-in circuitry for connecting
to a LocalTalk™ network. LocalTalk is one of the network types
available in the AppleTalk® network system—a means to
connect computers, printers, and other devices so that their
users can share information and resources. Some Macintosh
models can use expansion cards that provide connections for

other types of AppleTalk networks in addition to Local Talk.

This chapter provides an introduction to using the Macintosh as
part of a network and instructions for using the parts of the
system software that are designed for network operations.

You can casily connect the Macintosh to a network that uses the
computer’s built-in Local Talk circuitry. If your Macintosh mode
has slots for expansion cards, you can install a card to provide a
connection to a different type of network, such as Ethernet.
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Connecting to an existing
LocalTalk network

You can add your Macintosh to an existing Local Talk network,
or you can connect one or more Local Talk devices to the
Macintosh and create your own small network.

The instructions that follow provide a summary of procedures
for connecting to an existing network. Consult the
documentation provided with the LocalTalk connector and
cable for a more detailed treatment of this task.

To make the Local Talk connection, you use a buile-in connector
on the Macintosh—the printer port—and a LocalTalk cable (or

a compatible cable).

Important: If you are adding the Macintosh to an existing
network, notify the other computer users on that network, and
arrange to make your connection at a time that won't disrupt the
network’s operation. .

(I::r(nillul\ll]nl;l hox "'—H‘T"___—ﬂw‘ E TO c:'.)nnect s

existing LocalTalk
network, first assemble the
components you need:
LocalTalk connector box and
cable, extender and extra
cable if necessary, and the
Macintosh.

2-meter cable =1 s

Unplug the Local Talk
‘ _-New Mac ( | cable from the LocalTalk
connector box of the device

~——| that will be next to your
Macintosh on the network.

Disconnect
cable here.
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Printer icon

L p
Printer port ——— .

ew Mac |
/,\L\\A]K

wy = Reconnected

= — cable here

‘“ ‘ [ New Mac

1] FF——New cable
N il attached here ‘

Adding the Macintosh to a network

Plug the cable end of

the LocalTalk connector
box into the Printer port on
the back panel of the
Macintosh.

You can recognize the Printer
port by the icon above it on
the case.

Plug the cable you

unplugged earlier into one
of the sockets in the the
LocalTalk connector box now
attached to your computer.

If the cable isn’t long enough,
you can attach a cable extender
and additional cable to it.

Plug one end of your

LocalTalk cable into the
second socket in the
LocalTalk connector box
attached to your Macintosh.

If the cables aren’t long
enough, you can attach a cable
extender and additional cable
to one or both of them.
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[ LoNewMac [ ] 6 Plug the other end of
your LocalTalk cable into
- _ the empty socket of the
I LocalTalk connector box
Atach new —_| o attached to the computer next
i cable here, to yours on the network (the
one from which you originally

detached a cable).

Now your Macintosh is part of
the network.

When you've completed the network cable connections, it's a
good idea to make sure that all cables and devices you worked
with have been reconnected to a Local Talk connector box. Two
cables should be attached to the connector box for all devices on
the network except for those at either end of the network.
Devices at the end should have only one cable in their connector
boxes. (See Figure 7-1.)

Tt B=

>

Figure 7-1 A LocalTalk network with one too many cables

As noted, some Macintosh models can also connect to other
types of AppleTalk networks. Instructions for these connections
are provided with their specialized hardware and software.

186 Chapter 7: Using the Macintosh on a Computer Network



Preparing the  The system software supplied with the Macintosh conrains
Macintosh system software  elements for some network operations. Depending on what
for networking  devices your Macintosh network uses, you may need to install
some or all of these parts of the system software on your
startup disk:

m  LaserWriter printer drivers

LaserPrep and LaserWriter

m ImageWriter printer driver—AppleTalk ImageWriter

n  ImageWriter LQ printer driver—LQ) AppleTalk ImageWriter

» AppleShare driver (for using an AppleShare file server or
print server)

m  Access Privileges desk accessory (for checking your access to
files on an AppleShare file server)

m any special software supplied with networking cards or other
network devices, such as Ethernet software if you insrall an
EtherTalk® card.

You also need to be sure that AppleTalk is turned on if you
want your Macintosh to use the services of an AppleTalk
network system.

y-
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To prepare the Macintosh

system software for network
use, first place all the drivers for
your network’s AppleTalk
devices in the System Folder of
your startup disk.

You can copy these drivers by
Sy=tem Folder dragging them into the System
Folder of your startup disk, or
you can use the Installer to add
them to your system. They
include the printer drivers.

If necessary, install the

AppleShare resource by
following any special
AppleShare instructions
supplied with your
Macintosh model or by
dragging it to the System
Folder of your startup disk.

AppleShare

If no special instructions for
AppleShare installation are
provided with your Macintosh
and you plan to use an
AppleShare file server, be sure
to place the AppleShare
resource in your System Folder
by dragging its icon or by
using the Installer program’s
Custom option.

188 Chapter 7: Using the Macintosh on a Computer Network



Active button
selected indicates
that AppleTalk is on.

EtherTalk

O Font

@® Desk Accessory ropep
fAlarm Clock SRRyl Access Privileges 6
Chooser
Control Panel
Find File

8683 byles
selected
System i Rccess Privileges
on Jody’s hard disk | on Jody’s hard disk
3080K free | 3080K free
((cwose ] [ ouit ) Close

L

Laserriter LQ App!eT-al‘

¢ User Name

L

=

AppleTalk

® Active
O Inactive

> See also:

Copy or install any

other necessary software
for network devices on your
startup disk.

Consult the documentation
for that software for specific
instructions.

If you are using an

AppleShare file server, use
the Font/DA Mover to install
the Access Privileges desk
accessory.

Skip this step if you are not
using an AppleShare file server.

Confirm that AppleTalk

is turned on in the Chooser.
If it’s not, click the Active button
to turn it on.

* “Creating a Customized System” in Chapter 2

* “Installing a Desk Accessory”™ in Chapter 8

Adding the Macintosh to a network
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Ch;mging from If you have installed a card and software for a network other
one network to  than LocalTalk, you have a Network section in the Control
another network Panel. You use this section to designate which type of network
you want to use and to change from one network to another.

About the Finder...

Alarm Clock
Calculator
Chooser

Control Panel
Diskinfo

To change from one

type of network to
another, first choose Control
Panel from the Apple menu.

The Control Panel opens, with
the General section displayed.

Scroll if necessary to

locate the Network icon,
then click it to display the
Network section.

The Network Control Panel
appears, with the icon of the
network currently in use
selected. The pointer becomes
a crosshair when you place it
in the arca where the network
icons are located.
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Crosshair pointer

Icon representing
the built-in
AppleTalk circuitry

3 ]

Startup bnn.v{!_ [

Access to current network services
will have to be re-established. Are
you sure you want to change the
fAppleTalk connection?

o)

[ Cancel ]

Click the icon for the

network you want to select.

When you select the icon, it
becomes highlighted. You may
then see a message alerting
you that you will lose your
connection with the devices
on your currently connected
network.

Click the OK button to
confirm the change of
networks.

If you aren’t sure that you
want to change networks, click
Cancel and consulc the
network administrator or the
documentation for the
nerwork products you're using.

After you close the Control Panel, your choice remains in effect
until you choose a different network.

Adding the Macintosh to a network
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Using a printer on
the network

Like the Macintosh, most models of the LaserWriter printer have
built-in AppleTalk circuitry and connectors. The ImageWriter
and ImageWriter LQ printers can also be used on a network if
they contain an AppleTalk adaprer. If your Macintosh is part of
a network that has more than one printer, you can use any of
those printers.

If your network is linked together with other AppleTalk
networks, you may have access to printers on other networks.
When multiple networks are interconnected, the resulting
internet may be divided into AppleTalk zowes for easier
management. You can select any zone listed in the Chooser to
use printers and servers available in that zone.

You specify the zone and the printer you want to use with the
Chooser. (See Figure 7-2.)

[J==————= Chooser

This part of the Chooser
does not appear if the

network is not part of an
interconnected group.

Select a LaserWriter:
Fontsga!ore
Graphics
Quickndirty
Steadystream
Toledo

!
[

AppleShare [X

Background Printing: @ 0On O 0ff
AppleTalk Zones:

CC4 Upper
—| CC4-5th/North
CC4-5th/South
CC4-6th/North
CC4-6th/South

User Mame:
Jody Larson

@ Active
) Inactive

AppleTalk

Figure 7-2  The Chooser showing zones and LaserWriter printers
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Choosing a network printer  You use the Chooser to designate both network printers and any
connected directly to your Macintosh.

1 To specify a network
printer, first select the
Chooser from the Apple menu.

About the Finder...

Alarm Clock

Calculator The Chooser opens.

Chooser
Control Panel

Chooser &
Select a file server:

If necessary, locate the

&

. 2 icon for the type of
A sovetnwre. Losmriie | | | 7 rinter you want to use, then
bt
Icons for the type | ] ' . . .
uf deehse 5| click the icon to select it.
want to use o] |
AppleTalk Zones i e — You may have to scroll to
| User Name: -
Coa-Sth/North B | e locate the icon. When you
CC4-5th/South — | - . r
coa-sthorth ol | @active select a different type of
cca-6th/south  [o] | AP O Inactive

device, the list in the box on
the upper right changes to the
names of available devices.
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[[o========== chooser B If necessary, locate the
' L Writ . .
= | rFontsgaiore E name of the zone in which
= . | Graphics s - =
sosiesare DR | | R -|| you want to use a printer, then
i click that zone to select it.

AppleTelk Zones You may have to scroll to
locate the zone you want.

@ Ritie When you select a different

CC4 Upper
CC4-5th/North

CC4-5th/South

]
]
CC4-5th/Northy i ApplaTalk

ECABLhv SONLh Oinactive zone, the printer names
change in the upper-right part
of the window.

= Chooser ==

Click the name of the

; Select s Laserriter:

== 9 e 5 printer you want to use.
et ot ]
| Londog, || You may have to scroll to
o e 2| locate the name.

AppleTalk Zones:

CC4 Upper
CC4-5th/North
CC4-5th/South

| Background Printing: @ On O 0ff

CC4-6th/North ® Active
CC4-6th/South ApplaTalk S itive

Your choice takes effect immediately and remains in effect until
you choose a different printer. (It’s a good idea to close the
Chooser window.)

Pn’n[ing your work  Once you have designared the printer you want to use (with the
on a network printer Chooser), you simply print your documents in the usual way—
by using the Print command in an application program or by
selecting one or more documents on the desktop and choosing
Print from the File menu.

P Secalso:  * “Printing Your Work” in Chaprer 4
g I
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Using a print server A print server is a combination of hardware and software that
manages printing jobs sent to it by a number of computers on a
network. A print server is often called a spooler, a term that is
generally used as part of its name on the network.

[f your Macintosh is part of a network that contains a print
server, you can send printing jobs to it and make the most
efficient use of your computer for other work. You may wish to
turn off background printing if you use a print server.

To use a print server,
first open the Chooser
desk accessory in the Apple

About the Finder...

Alarm Clock mendu.
Calculator

Control Panel

Follow the regular steps

for choosing a printer, but
select one that has Spooler in
its name.

Select a Laserwriter:
ACOT Express Spooler
Duck Dodgers

Shane’'s Shine

Mad Hatter Spooler \
Mushroom

You may have to scroll to
locate the name.

When you print a document, the printing status box appears for
a few moments, then closes. You can now use your Macintosh
for other work while printing,

» Seealso: “Using Background Printing” in Chaprer 4

=
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Using an AppleShare
file server

Gaining access to an
AppleShare file server

If your Macintosh is part of a network that has an AppleShare
file server, you can expand your access to programs and data

significantly without adding any components to your own

computer. You can also create private files on the server and

designate who will have access to them.

In addition, a file server allows you to exchange information

with anyone else on your network or in a zone that you can

reach from your computer.

You connect to a file server with the Chooser.

The instructions that follow summarize the connection process;
consult the AppleShare file server documentation for a complete

explanation of all options.

About the Finder...

Alarm Clock
Calculator
Chooser

Control Panel

= Chooser =55

&

iﬁphShaﬂ Lazer'¥riter {

&

AppleTalk Zones.
CC4 Upper
CC4-5th/North
CC4-5th/South
CC4a-6th/North
CC4-6th/South

| Background Printing: @ On O 011

| User Name
lll/odu Larson

® Active
O Inactive

AppleTalk
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To gain access to an
AppleShare file server,
first select the Chooser from

the Apple menu.

The Chooser opens.

Click the AppleShare

icon to select it.

When you select a type of
device, the names of the
devices available appear in the
upper-right list box.
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Chooser s

| Select a fil2 server:

Database downloads
Electronic tools
Graphics server
Hore graphics

1k

Boilerplate files

CC4-Sth/North
CC4-5th/South

User Name

CCa-6th/North | ®) Aclive
CCa-6th/Soutt | ApleTalk 5 hactive
Chooser
5 | Select a file server:
@ % = E Art group
= | | Budgets 91 & 9]
DFTIEDNER Laser vriter | [marketing plans
| |Data archives
|
—
1 |

AppleTelk Zones

CC4 Upper

CCa-5th/North
CC4-5th/South
EC4-6th/North
CC4-6th/South

K ® Active

AppieTal

Q Inactive

Chooser Ei

Select a file server:

AppleTalk Zones:

1l 5
# ; g Budgets 91 & Q2 | ]
WSUELE LaserWriter Harketing plans ‘
Data archives %
v,
]

CC4 Upper
CC4-Sth/Naorth
CC4-5th/Sauth
CC4-61h/North
CC4-6th/South

® Active
O Inactive

AppleTalk

Using an Appleshare file server

If necessary, click the
name of the zone in which
you want to use a file server.

You may have to scroll to
locate the zone you want.
When you select a different
zone, the server names change
in the list box at the upper-
right side of the window.

Click the name of the

file server you want to use.

You may have to scroll to
locate the name.

Click OK when the
S name of the file server you
want to use is selected.

A dialog box appears when
you click OK, in which you
provide information for
connecting to the server.
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Guest does not

require name or

password (hut may
have limited access
o information).

Registered user's
name and password
must match those in

a master file on the
SCTVET OF ACCess

will be denied.

Connect to the file server "Budgets 91 & 92"
as:

) Guast
@ Registered User

_Aame: l.mdg Larson

Password: {Scrambled)

@1 Passumnﬂ

[ cancel |

o )

Connect to the file server “Budgets 91 & 927
as:

O Guest

@® Registered User

Name: Ijudg Larson |

Password: (Scrambled)

Cancel

[Snt Passumrd] [[ 0K k }I

To connect to the server

as a Registered User, type
or correct your name if
necessary. (Your name must
match the form with which
you are registered.) Then, type
your password. If you’re not a
registered user, click the Guest
button, if it’s not dimmed.

Your name will be inserted
automatically if you've
supplied a user name in the
Chooser. When you type your
password, you won't sce the
characters on the screen (for
security), so type carefully.

If the Guest option is dimmed
and you're not a registered
user, you won't be able to
connect to the server.

7 Click OK.

When you click OK, another
dialog box appears, in which

you select the portions of the
file server you want to use.
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Portions of the file

server (called

volumes) available
1o this user .

selected volume —

A private (dimmed) —
volume (to which
this user doesn't

have access)

% Budgets 91 & 92

gogllfonder 5

Operations FY91 Ok
—[ Operations FY92 ]

Checked volumes ([£) will be opened at
system startup time.

O Save My Name Only

@ Save My Name and Password

[_okx ]

Select the server volumes you want to use:

]
2T

Staffing

Trazh

Using an Appleshare file server

8 Select the name or
names of the volumes you
want to use, then click OK.

You may have to scroll to
locate the volume or volumes
you want. When you click
OK, the dialog box closes and
the selected volume or
volumes appear as AppleShare
icons on your desktop in the
area where disk icons appear.

Use a file server
9 volume as you would a
disk, opening it and using the
documents and folders in its
window or creating new
documents on it.

1 O When you're
finished using a file

server volume, drag its icon to
the Trash to disconnect your
Macintosh from it.
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Storing and retrieving
information on an
AppleShare file server

Creating private files
on a file server

You use programs, documents, and folders on a file server in much
the same way you use them on a disk in a drive that is part of your
Macintosh system.

Because an AppleShare file server provides a means of limiting access
to programs and files, you may not be able to use some server
volumes and some folders on the volumes that are available to you.

You'll recognize the volumes, folders, and documents to which
you do not have access because their icons (or their names in a
list) are dimmed in the server window.

With the exception of dimmed items, you can copy items from
the file server to your disks, create and edit documents on the
server, use programs on the server, and copy or save items from
your Macintosh to the server.

Consult the AppleShare file server documentation or see the
network administrator for your work group for more detailed
information about file server use.

When you are connected to a file server as a registered user, you
can create and assign access privileges to folders. That is, you
designate who can use a folder and what the users can do with
its contents.

In brief, the access privileges you can assign include

= three categories of users—owner (you), group (any group
registered on the server by the administrator), and everyone
(all registered users and guests who have access to the server)

m three types of privileges for each of these user categories—the
privilege to see any folders inside the folder you created; the
privilege to read or copy any documents or programs in the folder
(but not to change any); and the privilege to make changes to any
of the folder’s contents, including deleting items from it

Consult the AppleShare file server documentation or the
network administrator for your work group for more detailed
information about AppleShare’s access privileges.
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Connecting to
another computer
via modem

You can obtain a great deal of electronic information by using a
modem—a device that converts computer signals for
transmission over telephone lines—to communicate with other
computers.

You can connect to numerous commercial information services
and free bulletin boards by modem, and you can also connect
directly with another individual computer user if that person’s
system is equipped with a compatible modem and controlling
software.

You need a communications program to direct the modem’s
operations and a telephone line that is relatively free of static or
other interference. The documentation for a modem and for
communications programs can provide specific instructions for
connecting with other computers via modem.

Once you've made a connection with another computer, you can
use the communications program to send and receive files and
to perform many activities on the other compurer.

P Seealso: o “Connecting a Modem” in Chapter 9
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Chapter 8

Personalizing Your
Macintosh Work Space

he Macintosh is designed to let you adjust some aspects of its
operation and its screen’s appearance. These customizable items
include

= mouse operation

s keyboard operation

= sound and volume

s time and date

= the look of the desktop

s colors or shades of gray

a fonts and desk accessories

Most of these adjustments are made in the Control Panel. Some
use desk accessories or other parts of the system software
supplied with the Macintosh. A few adjustments, such as screen
brightness and monitor position, are made with the hardware.
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AdJUSUng MOUSE you can modify two aspects of mouse operation—pointer
Opera[ion movement and double-clicking speed—in the Mouse section of
the Control Panel. (See Figure 8-1).

E[[[==———= Control Panel E
Mouse Tracking :
8 @
ﬂ B &
General (ITabM) (Mousze) . Options for
O ®@ OO0 0O correlating mouse
Yery Slow  Slow Fast and pointer
Keyboard + movement
¥ ¥
o
_Double-Click Speed | Options for speed of
double-clicking the
mouse button

)

Sound

Figure 8-1 The Mouse Control Panel

Setting the correlation The correlation between mouse and pointer movement, called
between mouse and  mouse tracking, can be adjusted so that the pointer moves the
pOill[(‘l‘ movement same distance on the screen as the mouse moves, or so that the
pointer moves up to two times as far on the screen as the mouse
moves, depending on how fast you move the mouse.

Mouse tracking is preset to slow when you install the system
software. The options for tracking are

= Slow—the mouse and the pointer move the same distance

m  Fast—the pointer moves twice as far as the mouse
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s Buttons between Slow and Fast—graduations between one-

for-one and two-for-one pointer and mouse movement

s Very Slow/Tablet—the pointer moves at a constant speed
when the mouse is moved, a useful setting for drawing with
the mouse or using a graphics tablet

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

EC]

General

Keyboard

Adjusting mouse operation

G2

To set mouse tracking,
first choose Control Panel
from the Apple menu.

The Control Panel opens, with
the General section displayed.

Scroll if necessary to

locate the Mouse icon,
then click it to display the
Mouse section.

The Mouse Control Panel
appears. The pointer becomes
a crosshair when you place it
in the Mouse Tracking area.
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Crosshair pointer

Setting the

Mouse Tracking

5 Click the button for the
& 4O £

tracking option you want.

(Tablet) (Mouse) The new tracking option is in
Q ®0 0D effect; you can test it by
Yery Slow Slow Fast

moving the mouse.

After you close the Control Panel, your choice remains in effect
until you choose a different tracking option.

You can adjust the double-clicking speed of the mouse button

dOLlth—CziC]{inQ speed by changing the interval between clicks.

To set the double-
1 clicking speed, first
choose Control Panel from

Alarm Clock the Apple menu.

Calculator . : )
thaooer The Control Panel opens, with

Control Panel the General section displayed.
DiskiInfo

About the Finder...
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The space between
arrows corresponcls
to the interval
between clicks.

Mouse button highlights

[

Crosshair pointer

twice at the interval selected
when yvou click a button.

Scroll if necessary to

locate the Mouse icon,
then click it to display the
Mouse section.

The Mouse Control Panel
appears. The pointer becomes
a crosshair when you place it
in the double-click area.

clicking speed you want.

3 Click the double-

When you click, the mouse
button on the screen is
highlighted twice at the
interval you selected.

Your choice remains in effect until you choose a different

double-clicking speed.

Adjusting mouse operation
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Ad]'USting key})()ﬂfd You can adjust the rate of character repetition when a key is held
Opel"ltion down as well as the delay before the character begins repeating.
‘ These adjustments can be made with any Macintosh model and

keyboard.

You make these adjustments in the Keyboard Control Panel.

(See Figure 8-2.)

=——— Control Panel 08—

Key Repeat Rate 'Dﬂau Until Repeai'

O00@®@O C @000

lSIow Fast] Off Long Short

Options for
character-repetition
speed

Figure 8-2  The Kevboard Control Panel
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repetition; the Off
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repetition



Setting the keys' repeat rate

Crosshair pointer

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
DiskInfo

=

&>

General

Keyboard

Key Repeat Rate

O@®OOm

Slow Fast

Adjusting kevboard operation

On all Macintosh keyboards, holding down most keys causes
the character to appear repeatedly on the screen until you
release the key. You can adjust the rate of repetition from very
slow to quite fast.

To set the repeat speed
for a key held down, first
choose Control Panel from

the Apple menu.

The Control Panel opens, with
the General section displayed.

Scroll if necessary to

locate the Keyboard icon,
then click it to display the
Keyboard section.

The Keyboard Control Panel
appears. The pointer becomes
a crosshair when you place it
in the Key Repeat Rate area.

Click the button for the
repeat rate you want.

Your choice remains in effect until you choose a different key
repeat rate.

209



210

Setting the delay  You can adjust the keyboard’s operation to your “touch” by
hefore keys repeat setting the delay before a character begins repeating when a key
is held down.

About the Finder...

Alarm Clock
Calculator
Chooser

Control Panel
DiskInfo

[

General

s

Crosshair pointer

The Off button |

[Delay Until Repeat

| O Bo®0

Off  Long Short

turns off repeating

characters.

To set the delay until
1 characters repeat when a
key is held down, first choose
Control Panel from the Apple

meniu.

The Control Panel opens, with
the General section displayed.

Scroll if necessary to

locate the Keyboard icon,
then click it to display the
Keyboard section.

The Keyboard Control Panel
appears. The pointer becomes
a crosshair when you place it
in the Delay Until Repeat area.

3 Click the button for the

repeat delay you want.
Clicking the Off button
overrides the character-repeat
feature.

Your choice remains in effect until you choose a different delay
option.
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AdeS[ing S()Und You use the Sound Control Panel to set the speaker volume and

Zlﬂd \"OIUIHQ to choose the sound the Macintosh makes when it signals you.

(See Figure 8-3.)

E[l=— Control Panel

Settings for |
adjusting speaker
volume; when set

at (), the speaker
is turned off (the
menu bar blinks
once as an alert).

General

Alert Sound Setting

Boing

Options for the

Monkey
Simple Beep

|

alert sound

<A

Keyboard
&
Mouse

<))

Speaker
VYolume

L If your Macintosh
has sound input
capability, you'll see
an additional control
here: tor information

see Special Features
of Your Macintosh.

Figure 8-3  The Sound Control Panel

built-in speaker.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
DiskInfo

Adjusting sound and volume

To adjust the speaker
volume, first choose

on using this control,

Setting the speaker volume  You can choose one of eight volume settings for the Macintosh’s

Control Panel from the Apple

ment.

The General Control Panel
appears.
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Scroll if necessary to

locate the Sound icon,
then click it to display the
Sound section.

The Sound Control Panel
appears. The pointer becomes

a crosshair when you place it
in the Speaker Volume area.

Using the crosshair
pointer, drag the bar to

Crosshair pointer the number you want for the

level of speaker volume.

Bar indicating
volume level

When you release the mouse
button, the alert sound plays
at the volume level you
selected.

Your choice remains in effect until you choose a different level
for speaker volume.

@ Speaker volume in two sections: You can also set the speaker
volume in the General Control Panel. «

»  Secalso: o “Setting the Alert Sound” (next section)
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Setting the alert sound

Crosshair pointer

Many programs are designed to play a sound when an alert
message is displayed or when you try to give a command that
the Macintosh cannot recognize. You can choose one of several
options for the alert sound.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

=[]

2

Mouse

W)

Alert Sound Setting

Boing
Clink-Klank

Monkey

Adjusting sound and volume

To set the alert sound,
first choose Control Panel
from the Apple menu.

The General Control Panel
appears.

Scroll if necessary to

locate the Sound icon,
then click it to display the
Sound section.

The Sound Control Panel
appears. The pointer becomes a
crosshair when you place it in
the Alert Sound Setting area.

click the name of the
sound you want.

3 Scroll if necessary, then

When you release the mouse
burton, the selected sound

plays.

| S
iy
e
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Setting time
and date

Your choice remains in effect until you choose a different alert
sound.

& Flash instead of sound: When the speaker volume is set to
zero, the menu bar flashes in place of an alert sound.

» Secalso:  * “Setting the Speaker Volume” (previous section)

The Macintosh has an internal clock that runs continuously. A
bactery inside the computer maintains the time and date when
the machine is turned off.

You set the time and date in the General Control Panel. (See
Figure 8-4.)

[[&==———= Control Panel
Rate of Insertion
@ Point Blinking
General il
. Desktop Pattern O ®@® O
Slow Fast
e ® Time-setting area
ink me
eiboird Menu Blinking &
—_— 5:14:53 PM
12hr. 24hr. i .
@ Q Options for 12-hour
Mouse O OO ®|oate I@ or 24-hour clock
RS 6/21/90 Date-setting arca
D)
Al O On
ound  [5] RAM Cache @
i (® off

Figure 8-4 The General Control Panel showing time and date areas

» See also: = “Installing a Desk Accessory” in this chaprer
* “Changing the Clock Battery” in Chapter 10
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Changing the time  You can specify a standard 12-hour clock (showing A.M. and .M.
with the time) or a 24-hour clock when you set the time.

Crosshair pointer

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

(@ 12hr. 1) 2dhr.

Time @

oH8:19 AM

Setting time and date

To set the time, first
choose Control Panel
from the Apple menu.

The General Control Panel
appears. The pointer changes
to a crosshair when you place
it in the time area.

If you want to change

the type of clock selected
(12-hour or 24-hour), click
the appropriate button.

The time changes in the Time

arca to reflect the type of clock

selected.

Click the part of the
time you want to change
(hours, minutes, or seconds).

The part of the time you click
becomes highlighted, and
small up and down arrows
appear at the right.

I~
p—

S
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Selected section
of the time

Click repeatedly on the
Time ® up or down arrow until

ofE 31 Ar{@ the time you want is

displayed.

The selected part of the time
changes in the direction of the
arrow each time you click.
You can also type a new
number for the time when it is
selected.

To save the new time,
Time @ click the clock icon.

OFE31 AM @ The clock icon becomes
highlighted briefly, then the

new time is displayed.

After you close the Control Panel, the time you set remains in
effect until you change it.

»,

% Another way to set the time: You can also set the time, as well
as an alert time, in the Alarm Clock, a desk accessory that is
part of the system software supplied with the Macintosh.  +

Chapter 8: Personalizing Your Macintosh Work Space

»



4

Changing the date  You change the date in much the same way as you change the time.

To set the date, first
1 choose Control Panel
from the Apple menu.

About the Finder...

Alarm Clock % =
e R The General Control Panel

Chooser appears. The pointer changes
Control Panel to a crosshair when you place
Diskinfo it in the Date area.

e Click the part of the
Date |E- date you want to change
®/21/90 (month, day, or year).

The part of the date selected
becomes highlighted, and

Crosshair pointer

small up and down arrows
appear at the right.

3 Click the up or down

arrow repeatedly until the

[ate @

B21/00 @ date you want is displayed.

The selected part of the date
changes in the direction of the

Crosshair pointer!
arrow each time you click.
You can also type a new

number for the date when it is
selected.

Setting time and date 217



Crosshair pointer

Setting an alert time with
the Alarm Clock

Date ] E

B21/90 3

To save the new date, s
click the calendar icon.
The calendar icon becomes -

highlighted briefly, then the
new date takes effect.

After you close the Control Panel, the date you set remains in

effect until you change it.

« Another way to set the date: You can also set the date in the

Alarm Clock, a desk accessory that is part of the system

software supplied with the Macintosh.

You can set the Macintosh Alarm Clock desk accessory to alert

you at a predetermined time.

The Alarm Clock is part of the system software and is usually

installed when you install the system software. If necessary, you
can install it with the Font/DA Mover.

About the Finder...

Access Privileges
Alarm Clock
Calculator

To set an alert time,
first choose Alarm Clock
from the Apple menu.

The Alarm Clock appears at
the top right of the screen, just
below the menu bar. It
displays the current time on
the system clock.
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[0 3:52:18 PM 3

Lever to expand (:1"
compress the Alarm Clock

[0 3:52:40 PM ¢
6/21/90
The highlighted -
area indicates
the item displayed
in the middle

row—the date,
in this example.

00 3:53:34PM ¢
@ 8:21:00 AM

Set/unset button
for the alarm

Crosshair pointer

Setting time and date

Click the upward-

pointing lever to the right
of the time.

The lever points downward,
and the Alarm Clock expands

to its full size.

If necessary, click the
alarm clock icon in the
lower-right area to select it.

The alarm clock area is
highlighted when you select it.
(Skip this step if the alarm
clock is already highlighted.)
The time showing in the
middle row is the last time to
which the alarm was set.

Click the button to the

left of the time in the
middle row to turn the
alarm on.

The pointer becomes a
crosshair when you place it in
the middle row. When you
click, the button moves up and
the alarm clock icon changes
to show a ringing alarm,
indicating that the alarm is
turned on. (Clicking again
moves the button down and
turns the alarm off)
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Button in the upper
position indicates
that the alarm is on.

220)

0 3:53:34PM ¢
—*l  8:24:00 AM

Icon showing
ringing alarm

[ 3:53:34PM ¢

{ B:ml]l] AM Fj

EI 3:53:34 PM th

B:m:l]f.l aM 2]

Click the part of the

time you want to change.

The part of the time selected
becomes highlighted, and
small up and down arrows
appear to the right of the time.

Click the up or down
arrow repeatedly until the
time you want is displayed.

The selected part of the time
changes each time you click.

Click the lever at the
right side of the top row
to compress the Alarm Clock.

The alarm will not go off
unless you click the lever to
return to the compact clock,
select another area of the
clock, or click the close box.
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Click the close box to
close the Alarm Clock.

[N 3:53:34PM 3

When the system clock reaches the time set for the alarm, the alert
sound plays once (the menu bar flashes once if the speaker volume
is set to zero) and an alarm clock icon blinks alternately with the
Apple icon ar the left side of the menu bar. (See Figure 8-5.)

©j File Edit Diew Special

1 64 items 21,342K in disk

Figure 8-5 The alarm clock icon in the menu bar

After the alarm has gone off, you must open the Alarm Clock
and turn the alarm off to stop the alarm clock icon blinking in
the menu bar.

* Setting the time and date: You can also set the system clock’s
time and date in the Alarm Clock, by first selecting the time

or date icon and then changing the numbers. %

> See also:  » “Installing a Desk Accessory” in this chapter
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Changing the look
of the desktop

Options for sctting

the number of

blinks of a selected
menu item

You can modify several aspects of the desktop’s and screen’s
appearance with the Control Panel as well as with controls on
the Macintosh or its monirtor.

Three of these items—the desktop pattern, blinking of a chosen
menu item, and blinking of the insertion point—are adjusted in
the General Control Panel. (See Figure 8-6.)

E0 Control Panel ==
! Rate of Insertion
Point Blinking
General .-: | .
Desktop Pattern 3] @ Q
Slow Fast
Time
Keyboard G?-
5:14:53 PM
—
(@ 120, ) 24br.
Mouse
vate  [Zq]
6/21/90
<))
s D On Speaker
oun RAM Cache @ Volume

@) 0ff

Areas for displaving
and editing available
desktop patterns

L__ Options for setting

the blinking rate of
the insertion point

Figure 8-6  The General Control Panel showing desktop adjustments
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Changing the pattern

Crosshair pointer

Pattern-editing area
(magnified view
of pattern)

Miniature desktop

Crosshair pointer

C You can choose from a variety of patterns provided for the
displayed on the desktop  Macintosh desktop, or you can create your own design by
editing one of the patterns supplied.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
DiskInfo

/
Dezkiop Fattern

)
LA,

==—— Control Panel

Desktop Pattern

Changing the look of the deskiop

1 To adjust the desktop
pattern, first choose
Control Panel from the Apple

menu.

The General Control Panel
appears. The pointer changes
to a crosshair when you place
it in the Desktop Pattern area.

To see the patterns

available, click either small
arrowhead at the top of the
miniature desktop on the right
side of the Desktop Pattern
area.

The pattern changes each time
you click. Clicking the
opposite arrowhead reverses
the order of patterns displayed.

When you see a pattern

you like, click the
miniature desktop to see the
new pattern on your full
screen.

The new pattern replaces the
current pattern for the
desktop. If you decide not to
keep that pattern, begin the
selection process again.



To edit a pattern, place

the crosshair pointer in
the pattern-editing area, then
click where you want to make
a change.

Crosshair pointer

Desktop Pattern

Tiny squares (called pixels) turn
from black to white or white to
black (or change color) when

clicked. The changes you make

when editing a pattern are
displayed immediately in the
miniature desktop.

When you have finished
5 editing, click in the
miniature desktop to display
the new pattern on your full
screen.

Crosshair pointer

lidited pattern

Desktop Pattern

After you close the Control Panel, the new pattern you selected
or created remains in effect until you change it.

» Secalso: “Changing the Colors or Shades of Gray in the Desktop
Pactern” in this chaper
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Adjusting the blinking Menu items are preset to blink three times when you choose
of a selected menu item  them. You can reduce or eliminate the blinking of a chosen
menu item in the General Control Panel.

I About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

Menu Blinking

Crosshair pointer

© 00®

off 1 2 3

To adjust the blinking

of a chosen menu item,
first choose Control Panel
from the Apple menu.

The General Control Panel

appears. The pointer changes
to a crosshair when you place
it in the Menu Blinking area.

Click the button for the
num_ber of times you want
the menu item to blink.

Clicking the Off button
prevents a menu item from

blinking.

After you close the Control Panel, the blinking option you
selected remains in effect until you change it.

Changing the look of the deskiop

R}
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Adjusting the blinking  You can change the blinking rate of the insertion point—used o~ »
of the insertion point  designate the place in a document or an icon name where you
will add or change the content—in the General Control Panel.

Insertion point,
blinking at the
rate selected
Crosshair pointer

220

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

Rate of Insertion
Foint Blinking

2l
® O

Slow Fast

Chapter 8: Personalizing Your Macintosh Work Space

To adjust the blinking

rate of the insertion point,
first choose Control Panel
from the Apple menu.

The General Control Panel
appears. The insertion point is
blinking at the rate currently
selected. The pointer changes
to a crosshair when you place
it in the Rate of Insertion
Point Blinking area.

Click the button for the
rate of blinking you want.

When you click, the insertion
point changes to the rate of
blinking you selected.



Indicating the
relative positions of
multiple monitors

The pointer moves
trom one monitor to
the other across the

“horder” where the

[wo monitor icons
touch. (The actual
monitors do not
have to touch.)

If you use two or more monitors, you must indicate their
relative positions so that the pointer can move from one monitor
to another. You specify monitor positions in the Monitors

Control Panel. (See Figure 8-7.)

Control Panel

Clicking Options opens

Characteristic

{®) Grays:
() Colors:

Drag monitors

s of selected monitor :

and menu bar to rearrange them.

a dialog box that lists
the type of video card to
which the selected

|__ monitor is connected.

The small white menu

Icons for the

Startup Device

har indicates the main
monitor, on which the
menu bar is located.

The dark line around

monitors connected
to the Macintosh,
showing their
numbers and their
relative positions

<

an icon indicates
that it is selected.

| Clicking the Identify

| [ 1dentify J

|Ct=1:>rs' in this box correspond
to the number of colors
selected for the monitor.

button displays each
monitor’s number
on its screen.

Figure 8-7 'The Monitors Control Panel showing two monitors

The number of each monitor is determined by the location of
the video card or built-in video socket to which it is connected.
The monitor numbers remain the same unless you change the

location of their video connections.

Changing the look of the desktop



About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo
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To specify monitor
positions, first choose
Control Panel from the Apple

menu.

The General Control Panel

appears.

Scroll if necessary to

locate the Monitors icon,
then click it to display the
Monitors section.

The Monitors Control Panel
appears.



Icon outline

|

Drag monitors and menu bar to rearrange them.

[ 1dentifyp

Crosshair pointer

Changing the look of the deskiop

numbers of your monitors
by placing the pointer on the
Identify button at the lower-
right corner of the Control
Panel and holding down the

mouse button.

3 If necessary, check the

A large number appears in the
center of each monitor’s screen
while the mouse button is held
down; that number corresponds
to the number of the icon in
the Control Panel.

Skip this step if you don’t
need to verify the monitors’
numbers.

Drag the icon of the

monitor whose position
you want to adjust to a
location on the screen that
corresponds to that monitor’s
actual position.

Because you're adjusting the
monitor’s position relative to
the other monitor or monitors
near it, you can’t move the
icon away from the other icon
or icons. If you drag the icon
to an isolated location on the
screen, it will snap back to
border on the closest other
icon when you release the
mouse button.



Release the mouse

button when the outline
of the icon you're
repositioning is where you
want it.

The icon appears at or near

. where you dragged its outline,
Border between monitors; the sl ide hordesi |
pointer moves from one monitor (o Wil one:siae bordenng the

the other only along this border on closest other icon.
the actual monitors,

If necessary, repeat steps 3
through 5 to adjust the relative
positions of other monitors.

Choose Restart from the
Special menu to

Special

Clean Up Window . .
Leaply Trash implement the new monitor
Lrase Hisk positions.

Set Startup...

You don’t have to close the
Restart _ Control Panel before choosing
Shut Down A the Restart command.

The monitor positions you specified remain in effect until you
change them.

After you have specified the monitor positions, the pointer
moves from one screen to another across the borders where the
monitors icons touch in the Control Panel.

230 Chapter 8: Personalizing Your Macintosh Work Space



Demgn:ltmg 4 You can designate a main monitor, where the Finder’s menu bar

main monitor - will always be displayed.

+ Monitors of different sizes: 1t's a good idea to make your larger
monitor the main monicor. If the smaller one is the main
monitor, some programs will restrict the window size to the

size of the smaller monitor.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

=[]

Changing the look of the desktop

*,
e

To designate a main
monitor, first choose
Control Panel from the Apple

meni.

The General Control Panel
appears.

Scroll if necessary to

locate the Monitors icon,
then click it to display the
Monitors section.

The Monitors Control Panel
appears.



[
(26

Outline of
the menu bar

Identlfgﬂ

Drag monitors and menu bar to rearrange them.

If necessary, check the
3 numbers of your monitors
by placing the pointer on the
Identify button at the lower-
right corner of the Control
Panel and holding down the

mouse button.

A large number appears in the
center of each monitor’s screen
while the mouse burtton is held
down; that number corresponds
to the number of the icon in
the Control Panel.

Skip this step if you don’t need
to verify the monitors’
numbers.

Drag the white menu

bar from the top of one
monitor icon to the icon of
the monitor you want to be
your main one.

An outline of the menu bar
moves with the crosshair
pointer as you drag.
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Changes won’t take effect until restart.

Special
Clean Up Window
benplyg Trash
Prase Hisk

Set Startup...

Restart
Shut Down

Release the mouse

button when the menu
bar’s outline is where you
want it.

The menu bar appears across
the top of the icon for the new
main monitor.

Choose Restart from

the Special menu to
implement the new main
monitor.

You don't have to close the
Control Panel before choosing
the Restart command.

The monitor you specified will be the main one until you
change it in the Monitors Control Panel.

Changing the look of the desktop



Adjusting screen  You can adjust the screen brightness of most Macintosh models
])['ighmcss with a control on the computer or on the monitor. (If your
Macintosh model does not have a brightness control, it has a
special section of the Control Panel that lets you adjust screen
brightness. For instructions on using the Brightness Control
Panel, see Special Features of Your Macintosh.)

Brightness
control

1 Locate the brightness

control or controls on

Contrast control .
your Macintosh model or

monitor. If your Macintosh
has a separate monitor, check
the monitor’s manual for
specific instructions.

Certain compact models
(Macintosh Plus, Macintosh
SE models) have one control
on the front of the computer.
Modular Macintosh models
usually have two controls—
brightness and contrast—on
one side of the monitor. Some
of these controls are marked
with an icon of a sun.

Turn the control dial or
dials until the screen’s
appearance is satisfactory.
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D@Signa[iﬂg colors 1 your Macintosh model and its monitor can display color or
or shades of orqy  multiple shades of gray, you can designate the number of colors
‘ 514y or shades of gray to be displayed and then specify how the
available colors or shades of gray will be used in highlighting, in
the desktop pattern, and in icons.

Specifying the number of ~ You use the Monitors Control Panel to specify the number of
colors or shades of gray  colors or shades of gray displayed on your Macintosh. (See
Figure 8-8.)

Options for the
number of colors or

[[[=———= Control Panel shades of gray
ﬁ Characteristios of selected monitor: displayed on _1]](3
) B Black & ‘hite PR L selected monitor
Buttons for r® Grays: K |
specifying color or General O colors: [[Iptil:ms... H— Butonfor
shades of gray for (1‘:‘]?133’1“8 a hﬁll of
senlante o video cards and
the selected monitor E Drag monitors and menu bar to rearrange them. R A
connections in use

Monitors,

Startup Device

lcons representing
monitors connected
to the Macintosh

& - ] [tdentify |l pugonto identify

the selected monitor

Figure 8-8 The Monitors Control Panel

Designating colors or shades of gray

o
o
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The number of colors or shades of gray your Macintosh model
can display depends on the type of video capability it has. Some
Macintosh models require a video card to connect a monitor.
Other models don’t require a video card (because they have a
built-in video connector), but they can use a video card if one is

installed.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel

Diskinfo

=[]

Monitors

To specify the number
]. of colors or shades of gray
to be displayed on a monitor,
first choose Control Panel
from the Apple menu.

The General Control Panel
appears.

Scroll if necessary to

locate the Monitors icon,
then click it to display the
Monitors section.

The Monitors Control Panel
appears. The pointer becomes
a crosshair when you place it
in the monitor-position or
monitor-characteristics area.
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Selected monitor

Drag monitors and menu bar io rearrange them.

Characteristios of selected monitor:

(ONSIER Black & swhite Py
4

O TR
256

C} Grays:
(®) Colors:

If you have more than
one monitor, click the
icon of the monitor for which

you want to specify the
number of colors or shades of

gray.

The monirtor is selected.

Click the Grays or the

Colors button to specify
the characteristics of the
selected monitor.

Click the number of

colors or shades of gray
you want displayed on the
selected monitor.

The number of colors or shades of gray you specified remains in

effect until you change it.

Designating colors or shades of gray



Changing the  You can change the color of the highlight on your screen, using
highlight color  the Color Control Panel and the color wheel dialog box. (See
Figures 8-9 and 8-10.)

Current highlight

EC

Control Panel EI}

color

Highlight color
suare (shows new
selection in top half,
current color in
bottom half)

Numbers

correspond to color
on the color wheel:
they can be adjusted
10 select the
highlight color.

General

Keyboard

Manitors

{hange Lafor |—

|__ Button to display
the color wheel

dialog box

Figure 8-9

The Color Control Panel

Select a highlight color.

L

| Dot indicates
selected color

238

~ Brightness
control
Hue [20995 |f} __ Color wheel
saturation [36051 |(3] showing options
Brightness (50229 |{) for highlight
color (when four
Red |35933 |3 colors or grays
Green (50229 |[3) are selected,
Blue | 22598 @ (cancel ] [ ok ) letters appear in
= the wheel,
indicating color
values)
Figure 8-10 A simulation of the color wheel dialog box
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Crosshair pointer

To change the highlight color, the number of colors or shades
of gray selected in the Monitors Control Panel must be four

or more.

About the Finder...

Alarm Clock
Calculator

Chooser
Control Panel
Diskinfo

=[]

Keyboard

N

ChangeEColur

Designating the color or shades of gray

1 To change the highlight
color, first choose Control
Panel from the Apple menu.

The General Control Panel
appears.

Scroll if necessary to

locate the Color icon,
then click it to display the
Color section.

The Color Control Panel
appears, showing an example
of the current highlight color.
The pointer becomes a
crosshair when you place it in
the color changing area.

Click the Change Color
button to display the
color wheel dialog box.

The color wheel dialog box
opens, showing the current
highlight color and brightness.
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Circular pointer

If necessary, change the

brightness of the color
wheel by dragging the scroll
box up or down.

Scrolling up makes the color
wheel brighter; scrolling down
makes it darker.

Place the pointer

on the color wheel and
click to select a new color or
shade of gray.

The pointer is circular when it
is on the color wheel.

The new color or shade of gray
is displayed in the top half of
the square at the upper left of
the dialog box. The current
highlight color or shade
remains in the bottom half of
the square for comparison.

Chapter 8 Personalizing Your Macintosh Work Space
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To experiment with
other highlight colors or
shades, drag the pointer

Select a highlight color.
Newly selected
color

around the color wheel or
click at another point on the
wheel.

Current highlight
color

Hue (20996 @
saturation (36051 |(]
Brightness [50229 |(F

A new color or shade is
displayed in the upper half of
the square as you drag or each
time you click.

When you are satisfied

with the highlight color
or shade, click OK to confirm
your choice.

The dialog box closes, revealing
the Color Control Panel with
the new highlight color
displayed in the Example box.

After you close the Control Panel, the highlight color or shade
of gray you specified remains in effect until you change it.

> Seealso: o “Specifving the Number of Colors or Shades of Gray”
in this chapter
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Changing the colors or
shades of gray in the
desktop pattern

You can change the colors or shades of gray displayed in the »
deskrop pattern in the General Control Panel. You change colors
in the pattern by editing one of the standard patterns provided,

using the colors or shades of gray displayed in the Control Panel
to replace the original colors or shades in that pattern.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel
Diskinfo

=— Control Panel

Crosshair pointer

Pattern-editing area
(magnified view
of pattern)

Miniature desktop

=aT T

Desktop Pattern

Simulation of

color har for
selecting color or
shades of gray

selected color Cheavy
line across top)

1 To change the colors or
shades of gray in the
desktop pattern, first choose
Control Panel from the Apple

menu.

The General Control Panel
appears. The pointer becomes
a crosshair when you place it
in the Desktop Pattern area at
the top center of the panel.
To see the patterns

2 available, repeatedly click
either small arrowhead at the
top of the miniature desktop

on the right side of the
Desktop Pattern area.

The pattern changes each time
you click. Clicking the
opposite arrowhead reverses
the order of patterns displayed.
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Crosshair pointer

Pattern edited with
one color

Crosshair pointer

Desktop Pattern

Crosshair pointer

Desktop Pattern

Designating colors or shades of gray

When you see a pattern
3 you want to edit, click the
color or shade of gray with
which you want to replace
some or all of the original
colors.

The selected color or shade is
indicated by a heavy line at its
top edge.

Click in the parttern-
editing area where you
want to make a change.

The dark or light squares
(called pixels) change to the
color you've selected when you
click them. The changes you
make when editing a pattern
are displayed immediately in
the miniature deskrop.

another color or shade of
gray, select that color or
shade, and then click the
pixels you want to change to
that color or shade.

S If you want to edit with

Clicking a pixel once changes
it to the selected color or
shade; clicking it a second
time restores its original color.



When you have finished P

editing, click in the
miniature desktop to display
the new pattern on your full
screen.

Crosshair pointer —

After you close the Control Panel, the number of colors or shades
of gray you specified remains in effect until you change it.

» Seealso: o “Changing the Pattern Displayed on the Desktop™ in
this chaprer

Designating the  You can easily change an icon’s color or shade of gray in the
color of icons  Color menu. This menu is available only if your Macintosh is
capable of displaying color or shades of gray and if you have
specified at least 16 colors or shades of gray in the Monitors
Control Panel.

1 To change an icon’s
color or shade of gray,
first click the icon to select it.

The icon becomes highlighted.
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Choose the color or
shade of gray you want
from the Color menu.

The icon’s color or shade
changes to the one selected.

The icon retains the new color or shade of gray until you
change it.

@ Viewing icons by color: Macintosh models that can display
color or shades of gray include an option for organizing files
by icon color in the View menu. %

P Secalso: * “Specifying the Number of Colors or Shades of Gray”
in this chapter
¢ “Displaying Documents by Name, Size, Date, Kind, or
Color of Icon” in Chaprer 5
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Mov il'lg f()I][S and  The Macintosh system software includes several desk accessories r
volr Arrocemeiae  and a selection of type fonts. Independent manufacturers and
desk accessories user groups or computer bulletin boards provide many
additional fonts and desk accessories.

When you install the system software, a core set of fonts and
desk accessories is installed. You can add more desk accessories
or fonts—or remove any of the ones already installed—with the
Font/DA Mover, another part of the system software supplied .
with your Macintosh.

Figure 8-11 shows the Font/DA Mover’s primary dialog box.

Desk accessories already
installed in the System file
of the startup disk

Markers showing }
direction of copying

(O Font
® Desk Accefsory Moker
= 1
Chooser 3 (<< Copy << ) [Alarm Clock
Control Panel Calculator Desk
Size of the thaoser [ ‘{C(.:tf‘i\'»(Jl'iL“i
. ) e N Control Panel S o
tem selected N Find File available 10
for installation \1 1944 bytes [Key Caps install
6 selected Note Pad

Button 1o display s!li_‘em Desk Rt:essorles | Desk accessory
brief instructions anilrees (_Hep ] aniirees for
e _/3445K free 3443K free ?elgﬁef_ tor

( installation
Space available on —! Close ) (it ] ([ Close ]

the startup disk

. Message area

Figure 8-11

The Font/DA Mover showing desk accessories

Chapter 8: Personalizing Your Macintosh Work Space



]nstalling afont  The Font/DA Mover and a file of fonts are supplied on the
system software disks with the Macintosh. (See Figure 8-12.)

dh (4]

Fort /Dy Mover Fants

— All fonts and font

files have this icon,
regardless of
their names.

Figure 8-12  The Font/ DA Mover and fonts file

Locate the disk or disks containing these files (or the font file you
want to use) if you do not have them on your startup disk already.

Font/Dé& Mover

Moving fonts and desk accessories

1 To install a font,
first open the Font/DA
Mover by double-clicking its

icon.

The Font/DA Mover opens,
with the Font option selected
in its window. The box on the
left shows a list of the fonts
currently installed in the
System file of the startup disk.

[f you want to install a font
onto a different disk, click the
Close button, then use the
Open button that replaces it
to open the System file on the

other disk.
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Fonts installed in
the System file
(numbers indicate
type size for
screen display)

Font
g Desk Accessory Haver:
Geneva 10 topiy [
Geneva 12
Geneva 14
Geneva 18
Geneva 20
Geneva 24
Helvetica 9 13|
System 1
on Main Disk i
16260K free |
(T cowese ) i ouit )! ( open.. k)

[Ea Font/0A Mover Folder |

= Main Disk

Open k.

Sl

Click the Open button
below the empty list box
on the right side of the

window.

A directory dialog box appears,
with which you locate and
open a fonts file.

If necessary, use the
Drive, Eject, and Open
buttons to locate the fonts file
you want, select the file’s
name, then click Open.

The dialog box closes, and the
fonts in the file are listed in
the box at the right side of the
Font/DA Mover window.
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Size of the

selected font

Sample of the
selected font

@ Font
O Desk Accessory Mover
Geneva 10 8 Lopy Courier 12
Geneva 12 Courier 14
6 14 Courier 18
Geneva 18 Courier 2
Geneva 20 Geneva 10
Geneva 24 Geneva 12
Helvetica 9 Geneva 14
System : Fonts =]
on Main Disk on Main Disk
16149K free 16149K free
(Ccose ] ([ _aut_ )i [ clese ]
Fonts available
in the fonts file
just opened
@ Font
( Desk Accessory Houer
Geneva 10 << Copy “!t.] Courier 12
Geneva 12 Courier 14
Geneva 14 Courier 18
Geneva 18 Courier 24
Geneva 20 9574 bytes Geneva 10
Geneva 24 selected Geneva 12
Helvetica 9 o Geneva 14
System : Fonts
on Main Disk | on Main Disk
16149K free 16149K free
(Ccese ) (_aut )| Close

___courier24: The qUiCk brown fox j

Moving fonts and desk accessories

Scroll if necessary, then

select the font you want
to install by clicking its name
in the list on the right.

Small markers appear on the
Copy button, showing the
direction that the selected item
will move. A sample of the font
appears in the message area at
the bottom of the window, and
the amount of disk space
occupied by the font is
displayed between the two list
boxes. If you select more than
one font from the list (by
Shift-clicking), the combined
size of your selection is
displayed, but no sample
appears in the message area.
Click the Copy button
5 to add the selected font or

fonts to your System file’s
fonts.

The name or names of the
new fonts appear in the list on
the left in alphabetical order
when copying is completed.
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@® Font Click the Quit button .
O Desk Accessory Mover h b {_.
Newly installed font Tourier 24 55| (< Copy << ) [Courier 12 at the bottom center o
Geneva 10 & Courier 14 1
Geneva 12 = Courier 18 the‘ wlndf)w w}}en you have
Geneva 14 ; Courier 24 finished installing fonts.
Geneva 18 9574 bytes Geneva 10
1] 20 selected Geneva 12
Geneva 24 Geneva 14
System 1 Fonts F
on Main Disk — | on Main Disk
16139K free | 16139K free
(Cciose )] {( _oquity J| ([ ciose )
courier24: The quick brown fox j

If you're using
MultiFinder, choose
Restart from the Special menu.

Clean Up Window
teaply Trash
brase sk

Set Startup...

Restart
Shut Down

+ Copying fonts from one file to another: You can also copy
fonts from one System or fonts file to another System or

.,

fonts file.

By restarting, you ensure that
the new fonts will be available.
You can skip this step if you're
not using MultiFinder.

P Seealso: * “Managing Multiple Programs Using MultiFinder”

in Chapter 3
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Removing a font  You may need to remove one or more fonts to make more room
on a startup disk. You use the Font/DA Mover to remove fonts.

If you’re using MultiFinder, you can’t remove fonts from the
System of the startup disk. Start up with a different system disk,
then use the Font/DA Mover to open the System of the disk
from which you want to remove fonts and proceed according to
the steps that follow.

% Saving a font when you remove it: 1f you want to remove a
font and be certain that you still have a copy of it, you can
use the Font/DA Mover to copy thar item to a separate fonts
file, and then remove it from the System.

To remove a font, first
open the Font/DA Mover
by double-clicking its icon.

The Font/DA Mover’s window
opens, with the Font option
selected. The box on the left
shows a list of the fonts
currently installed in the
System file of the startup disk.

Font/D & Mover

Moving fonts and desk accessories 251



Scroll if necessary, then

8;::: HCEGSSOI’U Mover .
= : - click the name of the font
imes L BpY [ i .
Uenice 1% you want to remove in the list
2apf Dingbats 10
Zapf Dingbats 12 on the left.
Zapf Dingbats 14
Zapf Dingbats 18 a
& | A sample of the font is
Syst : . -
onMath Disk. | C ) displayed in the message area
160724K free | s
o) Cow 3l O at the bottom of the window,

and the space the item
occupies on the disk is
displayed between the two list
boxes. If you select more than
one font from the list (by
Shift-clicking), the combined
size of your selection is
displayed, but no sample
appears in the message area.

® Font e Click the Remove
() Desk Accessory
) - button to remove the
Selected font —! ] 1 di s f
(xRemove ) selected 1tem or 1items from
your System’s fonts.
4180 bytes
Disk space occupied —! — Agimer x An alert dlalog box appears,
. AP - ystem : i
by the selected font ‘:2;;2;'? :Hsk askmg you to confirm or
ree i
(Ccose ] [ owit ) ( open.. ) cancel the action.
sample of the —L_penice 14: The quick brown fox jumps over the [azy
selected font

L
)
I~
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| UK*

@ fire you sure you want to

remove the selected items?

The font name

no longer appears
in the list.

The available disk !
space is increased.

Installing a desk accessory

@ Font
O Desk Accessory iover
Times 10 I Lopy i
Times 12 o
Zapf Dingbats 10 |
Zapf Dingbats 12 D
Zapf Dingbats 14 |7
Zapf Dingbats 18 | | ||
Zapf Dingbats 24 > e
System
on Main Disk
16D78K free
(_clese ] | ((xouit ] [ open.. ]
P See also:

this Chﬂpt(;‘l‘

Click the OK button to

proceed with removal of
the selected font.

If you change your mind, you
can use the Cancel button to
stop the action.

Click the Quit button

at the bottom center of
the window when you have
finished removing fonts.

* “Creating a File of Desk Accessories or Fonts” in

The Font/DA Mover and a file of desk accessories are supplied on

the system software disks with the Macintosh. (See Figure 8-13.)

Font /D d Mover

o2

Desk dccessories

All desk accessories

’ and desk accessory

files have this icon,
regardless of
their names.

Figure 8-13  The Font/DA Mover and desk accessories file

Moving fonts and desk accessories
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Locate the disk or disks containing these files (or the desk o
accessory file you want to use) if you do not have them on your
startup disk already.

To install a desk
]. accessory, first open the r
Font/DA Mover by double-
Font/Ud Mover clicking its icon.

The Font/DA Mover opens,
with the Font option selected
in its window. The box on the
left shows a list of the fonts
currently installed in the
System of the startup disk.

The Font/DA Mover ® Font . Click the Desk
always opens with (R Desk Accessory A butt ¢t th
Font selected. Symbol 9 o Lopy | RECHNY SN & <
Symbal 12 1
S et top of the window.
h)!!l.\ alrcady symbol 24 )
installecin | | limes o [ The list on the left changes to
the System = = :
) Times 12 o 9 | the desk accessories currently
3 System . .
The name of ——[ on Trees installed in the System file on
the open file, the 3764K free h didk
disk, and free (__close ] ot ]| [ open.. ) S sk
space on the disk y
If you want to install a desk
accessory on a different disk,

click the Close button, then
use the Open button that

replaces it to open the System
file on the other disk.
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) Font

Desk accessories | [
currently installed
in the System

{® Desk Accessory E1ogor
Chooser [ _toen ) K]
Control Panel
= =
System |
on Trees |
3764K free |
(Cewse ] ([ _out ]! [ open.y ]
<} Font/DA Mover Fnlderl
0 Desk Accessories = Trees

Moving fonts and desk accessories

Click the Open button
below the empty list box
on the right side of the

window.

A directory dialog box appears
with which you locate and
open a file of desk accessories.

If necessary, use the

Drive, Eject, and Open
buttons to locate the desk
accessories file you want,
select the file’s name, and

then click Open.
The dialog box closes and the

desk accessories in the file are
listed in the box at the right

side of the Font/DA Mover

window.



250

Arrows indicate
direction of
copying—{rom the
desk accessory file
to the System

Size of the desk
accessory selected

O Font

@ Desk Accessory LI
Chooser K4 Lopy filarm Clock
Control Panel Calculator
Chaoser
Control Panel
Find Fily
Key Caps
= Note Pad
System Desk Accessorif's
on Trees on Trees
34435K free 3443K free
(Ccese ] [ (__aut ) [ _ciose
Desk accessories in
the file just opened
O Font
@ Desk Accessory inUEr
™
Chooser €4 [ <« Copy <<j] |Alarm Clock
Control Panel Calculator

Cunlrul Panel
Find File

11944 bytes |Key Caps
5] /selected  |Note Pad
System i . Desk Accessories
on Trees j on Trees
3443k free ¢ 3443K free
(Ccese ] | ([ out )i (__clese )

Select the desk accessory
5 you want to install by
clicking its name in the list on
the right.

Small markers appear on the
Copy button, showing the
direction that the selected item
will move. The size of the item
is displayed between the two
list boxes. If you select more
than one desk accessory from
the list (by Shift-clicking), the
combined size of your
selection will be displayed.

6 Click the Copy button

to add the selected item or
items to your System’s desk
accessories.

The item or items are copied
into the System. The name or
names of the new desk
accessories appear in the list on
the left in alphabetical order.
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The name of the
desk accessory
installed in the

Svsem appears in
the list when
copying is
completed.

O font Click the Quit button
{®@ Desk Accessory Sisher h b {_—
Chooser K [« Copy << } [Alarm Clock at the bottom center o
Control Panel Calculator 1
Eenirol| Caietiol the window when you have
Control Panel finished installing desk
| | 11944 bytes accessories.
= selected
system i Desk Accessories
on Trees i on Trees
3443K free 3443K free
(Ccese ] [ ouit n ) [ clse ]

If you're using
Clean Up Window MultiFinder, choose
Fipty Trash Restart from the Special

frase sk menu.
Set Startup...

By restarting, you ensure that

the new desk accessories will
be available in the Apple
menu. Skip this step if you're
not using MultiFinder.

Restart
Shut Down

“ Starting the Font/DA Mover with the Desk Accessory option
selected: If you hold down the Option key when you start the
Font/DA Mover, the Desk Accessory option is automatically
selected.  #

> See also:  * “Managing Multiple Programs Using MultiFinder”
in Chapter 3

[0}
7
|
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Removing a desk accessory

You may need to remove one or more desk accessories to make
more room on a startup disk. You use the Font/DA Mover to
remove desk accessories.

* Saving a desk accessory when you remove it: If you want to
remove a desk accessory and be certain that you still have a
copy of it, you can use the Font/DA Mover to copy that
item to a separate desk accessories file and then remove it
from the System.

To remove a desk
accessory, first open the
Font/DA Mover by double-
Font/UA Maver clicking its icon.

The Font/DA Mover opens,
with the Font option selected
in its window. The box on the
left shows a list of the fonts
currently installed in the
System of the startup disk.

The Font/DAMover L 5¢ 0 o Click the Desk
always opens with (g Desk Accessory Sitar Accesso button at the
Font selected. Symbol 9 &l Loy K] £ th l'y d
Symbol 12 top or the window.
Fonts installed :um:lﬂl ;B (CRembue_) P
" S ymbol 24 .
in the System Times 9 The list on the left changes to
mes .
Times 12 5l [ the desk accessories currently
System I ! . .
skbetariank | | installed in the System file on
3407K free | h disk
(oese ] | [_quit ]| (_open.. ) the startup disk.

258

Chapter 8: Personalizing Your Macintosh Work Space



Desk accessories !
in the System of
the startup disk

Size of the selected —
desk accessory

O Font
® Desk Accessory MRpEr
filarm Clock [ Lop =
Chooser
Control Panel
Find File
Key Capy
Note Pa ||
& o]
System
on J's hard disk
3407K free
[ ciose ] ( quit ) [ _open
Font
8Besk Rccessory  TTOUer
Alarm Clock 5] topy | K
Chooser
Control Panel gﬂemnn
Find File
2728 byles
hiele Pad ~ selec{l’ed -
System !
on J's hard disk t
3407K free |
(Coose ] [ _auit ] [__open.

Moving fonts and desk accessories

Select the desk accessory
you want to remove by
clicking its name in the list on

the left.

The size of the item is
displayed between the two list
boxes. If you select more than
one desk accessory from the
list (by Shift-clicking), the
combined size of your
selection will be displayed.

Click the Remove

button to remove the
selected item or items from
your System’s desk accessories.

An alert dialog box appears,
asking you to confirm or
cancel the action.
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Click the OK button to
0 fire you sure you want to "
remove the selected items? pl'CICCCd Wlth removal Of
the selected desk accessory.

ox; m‘ Ifyou changc your mind, you
can use the Cancel button to
stop the action.

OFont Click the Quit button
@ Desk Accessory oLl 1 at the b t t f-
Alarm Clock ] ] h ind oF Em e e; ®
Chooser the window when you have
Control Panel i i Y
Fi i finished removing desk
| | | | accessories.
& 1o
System |
on J's hard disk |
3409K free | |

_Lcmse ) [ Ouit k ] Ll{pen.i. ]

Creating a file of desk
accessories or fonts

260

When you move desk accessories and fonts into and out of the
System on a startup disk, you can easily create the special types
of files used to store these items. Figure 8-14 shows the icons for
a desk accessories file and a fonts file.

A

Desk Accessories Fonts

Figure 8-14 The icons for a desk accessories file and a fonts file

You use the Font/IDA Mover to create these files.
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Font/La Mover

@ Font

Q Desk Accessory MOUEL
AGaramond R... 10 K| Lopiy K|
AGaramond R... 12 E
AGaramond R... 14|
B AGaramond... 10|
B RGaramond... 12
B AGaramond... 14|
Chicago 12 [ =
System i

on Lissy’s hard disk | [ lelp___)

3367K free H

((cose ) | auit ] [(__open.. )

Moving fonts and desk accessories

To create a fonts file,
first open the Font/DA
Mover by double-clicking its

icon.

The Font/DA Mover opens,
with the Font option selected
in its window. The box on the
left shows a list of the fonts
currently installed in the
System file of the startup disk.

If you want to create a
desk accessories file, click
the Desk Accessory button.

Skip this step if you want to
create a fonts file.
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O Font
@® Desk Accessory pIoKer
Alarm Clock KA Topy Q_‘
Chooser
Control Panel
Find File
Note Pad
5 5
System i
on Lissy's hard disk |
3367K free [
C clese: ] [ nuit ] [ open... k)

[£2 Fonl/DA Mover Folder |

[ Desk Accessories

—Lissy’'s h...

[nsertion point !

New k
|2 Font/DA Mover Folder |
3 Dask fceessories i
0 Enten fonls
& Fonbt/Iif Maves
0 Fonts
New Desk Accessary File Lissy's ...
New file name 3
= ——jEntra DA
L
(createy] [ Cancel ] [ Drive )

Click the Open button
below the empty list box
on the right side of the

window.

A directory dialog box
appears, in which you specify
the file to open.

Click the New burtton

to create a new file.

Another directory dialog box

appears, in which you name the

new file. An insertion point is

blinking in the name box.
Type a name for the

5 new file, then click Create

to create the new file.

The dialog box closes, again
revealing the Font/DA Mover
window. The new file is open
on the right side of the window.
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on Lissy’s hard disk on Lissy's hard disk

3367K free

O Font

@ Desk Accessory hioues
Alarm Clock » Copy > k!
Chooser
Control Panel
Find File

2605 bytes
selected
System 1 Entra DAs

33567K free

- ,[, -

Close

) iC

[ close

Copy the item or items
you want to move into the
new file.

[f you don’t copy at least one
font or desk accessory into the
new file, that file will not be
saved when you finish using

the Font/DA Mover.

When you have finished copying the item or items you want to
store in the new file, remove any of them you no longer want in
the System, then quit the Font/DA Mover.

Moving fonts and desk accessories
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Connecting
SCSI devices

Chapter 9

Expanding Your
Macintosh System

Tlc Macintosh is the heart of a powerful and versatile
computer system. This system can include such external devices
as disk and tape drives, printers, multiple monirors, a scanner, a
modem, a graphics tablet, and audio devices. All of these devices
can be connected to the computer when it is originally set up or
added later to expand its power.

The Macintosh can be expanded internally by installing
additional memory and—in some models

coprocessor cards,
specialized video and graphics cards, memory cache cards, and
communications cards.

This chapter provides an overview of hardware connections and
component installation for all Macintosh models. When you are
connecting a specific device to your Macintosh, be sure to follow
the detailed instructions that came with your Macintosh model
and with the device itself.

All Macintosh models have a socket, or port, for connecting devices
that use the Small Computer System Interface (SCSI). The SCSI port
permits high-speed communication between the computer and the
device. (SCS7is commonly pronounced “skuh-zee.”)
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Among the SCSI devices that are commonly used with the
Macintosh are internal and external hard disk drives, tape
backup drives, CD-ROM drives, scanners, and printers.

Because SCSI devices can be connected to one another, or daisy-
chained, rather than having to be connected directly to the
computer, the Macintosh can support up to seven of these
devices, including one internally.

Setting the SCSI - Each SCSI device has an 1D number from 0 to 7 that you can

device number  change if necessary. Apple assigns cach type of SCSI device it
manufactures a number at the factory; in most instances, you
should not need to change the number unless two of the devices
in your system have the same number.

The Macintosh uses the ID number to assign each device a priority
on a chain of SCSI devices. The higher the number, the higher the
device’s priority; the computer itself is number 7 and an Apple
internal hard disk is number 0 (so nothing else can have those
numbers). The devices you use most often should have the highest
priority numbers.

A Warning: Be sure to change the ID number of one device if you
have two SCSI devices with the same ID number. You could lose
information on one or both devices if you try to use two SCSI
devices with the same ID number. A

1 With the SCSI device
turned off and unattached
to anything, locate the ID
number and the ID number
switch on the back panel of
the device.

11 number indicator

1D number switch

The preset number is showing.

260 Chapter 9: Expanding Your Macintosh System



Daisy chaining
SCSI devices

Insert the point of a

pushpin or an opened
paper clip into the ID
number switch and push
gently until the number you
want is showing.

The number increases to 7,
then starts over at 0. Some
devices have blank spaces
between the numbers 7 and 0.

SCSI devices can be linked together by cables to form a chain.
The arrangement of devices in a SCSI chain does not determine
their priority in communicating with the Macintosh; the
devices’ ID numbers determine priority.

To assure accurate transmission of information to and from the
compurter and the SCSI devices connected to it, you must place
special connectors, SCSI cable terminators, at cach end of a
SCSI chain. (See Figure 9-1).

Figure 9-1 5CSI cable terminator

Every Macintosh that has an internal Apple hard disk has a
built-in SCSI terminator. For most models, the computer’s
internal terminator serves as the terminator for one end of the
SCSI chain. If you have a Macintosh Portable, consult the
Macintosh Portable Handbook for instructions about using
terminators. You may need to use an additional terminator if
you connect an external SCSI device to the Macintosh Portable.
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You use terminators with SCST cables, which connect the first
device to the computer and other devices in a chain to each other.

Table 9-1 shows how to arrange the SCSI cables and terminators
with several different configurations of equipment.

Table 9-1  Guidelines [or using terminators when connecting SCSI devices
1o the Macintosh

|

If D—-:; ..... then —
|
|

If & .. ... then no action needed

If D—E—E then E‘ —e—1+H—-{©°
i E

i 0 3 B3 then ———=3

If =3 B3 then no action needed

= B =

no action needed
[x. = o

no action needed

[ E——

Macintosh with
an internal hard disk

— ..... then

F——"—"1——— then

R A R R

: j——E—E then

Macintosh without
an internal hard disk

[
[]
If E—E—E then
]
[]

E=1 Peripheral without BE= Peripheral with
an internal terminator an internal terminator
@1 Add terminator between 2 Add terminatorto connector
device and cable into device not used for ciable

0 Remove lerminator
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Connecting
non-SCSI devices

Connecting a printer

When you connect a SCSI cable to the Macintosh, you place the
cable in the SCSI port on the computer's back panel. You can
recognize the SCSI port by its icon, shown in Figure 9-2.

Figure 9-2 The SCSlicon

Important: Always turn on your SCSI device before turning on
your computer.

The Macintosh has several ports to which you can connect other
types of peripheral devices. Each port is marked by a distinctive
icon on the back panel of the computer and on the Apple cable
that connects the appropriate device to it.

You connect most printers to the Macintosh through the printer
port. This port is a serial port, meaning that it transmits the bits
that make up the computer’s information in single file, or serially.

Some printers, such as the LaserWriter [INT and LaserWriter [INTX,
are designed for use on the AppleTalk network system. O'thers,
such as the ImageWriter II and ImageWriter LQ), can operate
either as stand-alone printers for one Macintosh or as Local Talk
devices. (LocalTalk is the name for work-group networks that
are part of the AppleTalk network system.)

All these printers connect to the computer’s printer port. Exceptions
are the Personal LaserWriter SC and the LaserWriter 1Isc, which
connect to the SCSI port.

If necessary, a printer can be connected to the modem porrt,
which is also a serial port. You indicate the port to which a
printer is connected in the Chooser.

Connecting non-SCSI devices 209



Assemble the
components you need:
————————— printer, appropriate cable,
LocalTalk connector box if

needed, and setup instructions.

Printer

of
2-meter cable £ | [

LocalTalk
connector box

Attach the larger

connector on the printer
cable to the printer, or attach
one end of the LocalTalk
cable to the printer. (Consult
the printer’s setup
instructions for details.)

Biitter oo [’—‘ J 3 Attach the small, round
s connector on the printer
cable to the printer port on
the back panel of your
Macintosh, or attach the
LocalTalk connector to the

printer port and plug the
LocalTalk cable into the box.

Printer port

You can easily recognize the
printer port by its icon.

P See also: “Choosing a Printer” in Chapter 4
* “Choosing a Network Printer” in Chapter 7
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Connecting a modem The modem port on the Macintosh back panel is a serial port
that is almost identical to the printer port. You use it to connect
an external modem, a device that converts the computer’s signals
for transmission over telephone lines.

This port is preferable for modem connection because the
computer gives it priority over the printer port when checking
for activity, which helps to assure that the modem’s
communications link will remain intact.

If necessary, you can connect a printer to the modem port or a
modem to the printer port, however.

Assemble the

components you need:
modem, appropriate cable,
and setup instructions.

Attach the appropriate

connector on the modem
cable to the modem. (Consult
the modem’s setup
instructions for details.)
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Connecting an external
floppy disk drive

oF Attach the small, round
Modem icon ———\&
‘ connector on the modem
cable to the modem port on
Modem port the back panel of your

Macintosh.

You can easily recognize the
modem port by its icon of a
telephone handset.

Some Macintosh models have a disk drive port, to which you can
attach a floppy disk drive.

You can also connect a non-SCSI hard disk such as the Apple HD 20
(no longer manufactured or supported with system software).

Make sure that your
Macintosh has a disk
drive port, then assemble the

components you need:
external drive, appropriate

cable, and setup instructions.

Attach the free end of

Disk drive port icon —— 5 dhie didk diger cikile to-the

Disk drive port — ((O) \\©

disk drive port on the back
panel of your Macintosh.

You can recognize the disk
drive port by its icon of a disk.
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Connecting Apple
Desktop Bus devices

On most Macintosh models, you connect the mouse and the
keyboard to Apple Desktop Bus™ (ADB) ports. These ports
allow you to use a variety of input devices with your system,
such as a graphics tablet, a specialized keyboard, a trackball, a

light pen, or a barcode reader.

You can daisy-chain ADB devices and thereby connect several to
each ADB port on the computer’s back panel. Most Macintosh
keyboards also contain an extra ADB port, and some monitors

have an ADB port.

The number of input devices you can connect to the computer
is limited by the combined power they require and by their
performance. The practical limit of devices is probably six—
three for cach ADB port on the Macintosh. Performance of the
devices is likely to be unacceptably slow with more devices than
three per port.

Important: Do not exceed the Apple Desktop Bus power
requirements when using ADB input devices. The combined
power used by all devices must not exceed 500 mA
(milliamperes). Be sure to check the power required for each
device you use and make certain that the total needed is less
than 500 mA. Consult the Special Features booklet or the
Handbook for your model for more information.
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o

Apple Desktop Bus device connected to a Macintosh

i
ADB icon Pt (o)
L
ADB port .

Confirm that the device

meets ADB power
requirements, then assemble
the components you need:
keyboard, mouse, or other
device; ADB cable; and setup
instructions.

Attach one end of the

ADB cable to the device,
if necessary. (Consult the
devices setup materials for
any special instructions.)

Attach the other end of
3 the cable to the ADB port
on the back panel of your
Macintosh.

You can recognize the ADB
port by its icon.
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Apple Desktop Bus device daisy-chained to another ADB device

Confirm that the device
@% meets ADB power
requirements, then assemble
the components you need:
mouse, graphics tablet, or
other device; ADB cable; and
setup instructions.

&,

Mogse cebile’s If necessary, attach one
permanently attached
/ end of the cable to the
ADB port on the device you
are adding. (Consult the
device’s setup materials for
any special instructions.)

p— ‘\—EQ Attach the other end of
' ) 3 the cable to the ADB port
on the device at the end of the

@ daisy chain.
You can recognize the ADB

port by its icon. The icon may
not be located directly above
the socket as shown here.

ADB port

< Macintosh Plus mouse and keyboard: The Macintosh Plus
does not have ADB ports; its mouse connects to a mouse port
on the back panel of the computer and its keyboard plugs
into the front of the computer.

i
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Connecting audio devices

Adding an
additional monitor

You can attach an audio device, such as an amplifier or
headphones, to the audio jack on the back of the Macintosh.
The audio jack accepts a standard stereo miniplug, like that used
to attach headphones to a portable sterco player.

Connect the audio device to
the audio jack on the back

panel of the Macintosh, using
Audio jack ——— Q a stereo miniplug,.

You can recognize the audio

Speaker icon ——

jack by its icon of a speaker.

You can use two different monitors simultaneously with most
Macintosh models.

On some modular Macintosh models, such as the Macintosh I1cx,
you connect the additional monitor to a video card installed in the
computer. On other models, such as the Macintosh Tlci, you can
connect the additional monitor to a video card or to the
computer’s built-in video port.
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Connecting a monitor
to a built-in video port

£

Some Macintosh models provide a built-in video port to which
P
you can attach the first or second monitor for your system.

Important: If you're connecting a monitor to the built-in video
port of your Macintosh, make certain that the compurer is
turned off before connecting the moniror. If it is turned on
while the monitor is connected, no system RAM will be reserved
for the built-in video.

Adding an additional monitor

Asserable the

components you need:
monitor, appropriate cable,
power cord, and setup
instructions.

Attach one end of the

monitor cable to the
monitor. (Consult the
monitor’s setup materials for
special instructions.)



Video icon

Video port

Chapter 9: Expanding Your Macintosh System

Attach the free end of

the monitor cable to the
video port on the back panel
of your Macintosh.

You can recognize the video
port by its icon.

Attach the power cord

to its socket on the
monitor, then plug the other
end into a grounded outlet.

You can plug one monitor into
the back panel of the
Macintosh; a second monitor
must be plugged directly into
an outlet.



Connecting 4 monitor ~ You can connect a monitor to a video card installed in the

to a video card  Macintosh. The card must be installed in the computer before
you connect the monitor.

Adding an additional monitor

Assemble the
1 components you need:
monitor, appropriate cable,
power cord, and setup
instructions.

Attach one end of the

monitor cable to the
monitor. (Consult the
monitor’s setup materials for
special instructions.)
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Attach the free end of

the monitor cable to the
port on the video card at the
rear of your Macintosh.

Most video cards do not have
an icon to identify the video
port. Consult your dealer or
Apple representative if you are
unsure about the purpose of the
port on a card in the computer.

Attach the power cord

to its socket on the
monitor, then plug the other
end into a grounded outlet.

You can plug one monitor into
the back panel of the
Macintosh; a second monitor
must be plugged directly into
an outlet.

“ Additional monitor for compact models: On models that have
a built-in monitor and can also use an external monitor, such
as the Macintosh SE, the external monitor is connected to an
adapter that must be installed by an authorized Apple
representative.
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Positioning monitors

When you're using two monitors, you may need to position
them to avoid interference on the screen of one monitor caused
by signals from the other.

A Warning: When setting up your monitors, be sure not to cover

Installing
expansion cards

the ventilation openings on the monitors or on the Macintosh.
Check the setup guide for your Macintosh model and the
monitor’s documentation for special instructions. A

» Secalso: * “Indicating the Relative Positions of Multiple
Monitors” in Chapter 8

Macintosh I family computers contain slots into which you can
install expansion cards. The interface through which these cards
exchange signals with the computer’s microprocessor is the
NuBus™ interface; consequently, the cards are known
collectively as NuBus cards, and the expansion slots are called
NuBus slots.

Most video cards used with monitors are NuBus cards; other
NuBus expansion cards include memory cards, specialized
graphics and video cards, coprocessor cards, and network
interface cards.
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The number of NuBus expansion

slots varies among the

Macintosh II models, though most have either three or six slots.

Figure 9-3 shows the expansion slots in some Macintosh [I-family

computers.

NuBus expansion slots

Back panel openings are
uncovered when cards are
installed.

Figure 9-3 The three NuBus slots in a Macintosh 1ci

Important: If you are installing fewer cards than the number of
expansion slots in your Macintosh, position the cards for
maximum airflow and cooling: leave an empty slot between
cards, and use the slot closest to the fan last. =
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The instructions that follow summarize installation of a NuBus
expansion card. See the guide Setting Up Your Macintosh tor
your Macintosh model for more detailed instructions. The
illustrations in this summary show the Macintosh IIcx.

Installing expansion cards

Take the lid off your

Macintosh and remove
the plastic cover plate from
the end of the slot into which
you will install a NuBus card.

Gently slide the NuBus

card, with the gold-tipped
connector pointing
downward, into the slot.

Hold the card carefully at the
outside top edges. Press the
card down to be sure that it’s
seated in the slot.

As you position the card, take
care to fit the connector on the
end of the card into the slot on
the computer’s back panel.
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Replace the lid on the

compute I.

Attach the appropriate
cable or cables to the
connector on the NuBus card.

Consult the documentation
for the card and the device to
be connected to it for detailed
instructions.
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Using multiple
expansion cards

Power requirements
and limitations

If you use two or more NuBus expansion cards in your
Macintosh, you must observe the Following precautions to
assure safe operation of the compurter.

The combined power consumption of all NuBus cards in your
Macintosh must not exceed the limits established for that model.

Expansion cards can draw three types of power from a NuBus
slot:

m  +5 volt current
m  +12 volt current
s —12 volt current

Each card may draw from these currents in varying amounts.
Consult the Special Features booklet for your Macintosh

model and the specifications for each card that you use to
determine the combined power consumption for cach type of
current. Then make certain that the torals do not exceed the
recommended limits. (You can calculate the rotal limits by
multiplying the recommended limit per card by the number of
slots in your model.)

Recommended
Type of current limit per card
+5 volt 2.0 amps
+12 volt 0.175 amps
—12 volt 0.100 amps

Warning: Exceeding the power limits could damage one or
more NuBus cards or the computer. A
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Assuring adequate
ventilation

Installing cards in
a special slot

When operating, NuBus cards generate heat. If you use several
cards in your Macintosh, make certain that you position them to
allow maximum air circulation around the cards.

For example, if your Macintosh has six NuBus slots and you are
using three cards, place the cards in the second, fourth, and sixth
slots (counting from the end opposite the disk drive) to assure
the maximum amount of air circulation.

Some Macintosh models can use a type of expansion card that
does not use the NuBus interface. This card fits into a special slot,
called the memory cache slot in some models and the processor-
direct slot in other models.

Important: If you plan to use a card in a special slot, make
certain that the card you install is designed for your Macintosh
model. Installing a card designed for this slot in a different
model could damage the card and the computer.

Instructions for installing a card in the memory cache slot or the
processor-direct slot vary among the models that use these cards.
Consult Setting Up Your Macintosh and the Special Features
booklet or the Handbook for your Macintosh model for details.
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Expanding memory
on the main
circuit board

The RAM in most Macintosh models is provided in packages
called Single In-line Memory Modules, or SIMMs. Each SIMM
consists of a group of RAM chips on a circuit board that has
electrical contacts along one edge. This board is plugged into a
SIMM sockert on the computer’s main circuit board.

The RAM in your Macintosh can be expanded by adding to the
SIMM modules already installed or exchanging the modules for
ones that contain chips with greater storage capacity. (The
system RAM can also be expanded by installing a NuBus
memory card.)

If you plan to expand the computer’s memory, make certain
that the chips or SIMMs used are the correct ones for your
Macintosh model. Consult the Special Features booklet or the
Handbook for your Macintosh model for information about

the RAM chips and SIMMs.

A Warning: RAM expansion on the main circuit board should

only be done by an authorized Apple representative or another
qualified technician. Modification or expansion by anyone
except qualified personnel voids the equipment’s warranty and
could cause damage. A
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Chapter 10

Macintosh Maintenance
and Troubleshooting

Yur Macintosh computer is sturdy and requires liccle
maintenance. But like any piece of electrical equipment, it
should be handled carefully and positioned in accordance with
its design and specifications.

This chapter provides some general precautions for setting up
and working with the computer, as well as guidelines for
maintaining a safe operating environment for the Macintosh,
instructions for cleaning system components, and a note about
Apple service and support.

289



Sﬂfety and  Follow the suggestions in this section to ensure that your Macintosh
gener: | care s@ysin good operating condition.

All system components  When setting up and using the computer and its components, be
sure to

= Handle all equipment with care and always place components
on a sturdy, flat surface.

» Follow the setup instructions provided with your Macintosh and
its components precisely.

= Always hold a cable by the connector at one end when attaching
it to or removing it from a component; don't force a connector
into a socket or plug on the Macintosh or a component. If you
can't get the piceces to join easily, consult your Apple dealer or a
technician for help.

n Turn off the computer and all components before adding or
removing any part of the system. If you add or remove a
component or its cable while the computer is on, you may
damage the Macintosh, the component, or both.

»  Keep food and liquids away from the immediate area of your
Macintosh if possible, and be extremely careful not to spill any
liquid on the computer, keyboard, mouse, or other components.

s Ifyou do spill food or liquid into the computer, be sure to turn
it off and unplug it before attempting to deal with the situation.

A Warning: Plug the power cords for the computer and its
components only into three-prong, grounded outlets. The
Macintosh’s grounding-type plug is a safety feature; do not defeat
the purpose of this plug. Disconnect the power plug if it becomes
frayed or otherwise damaged. A
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A Warning: Your power supply is a high-voltage component and

Monitor

should not be opened for any reason. There are no serviceable parts
inside. If you think that your power supply needs servicing, please
contact your authorized Apple service provider. A

Whether your Macintosh has a built-in screen or a separate
monitor, be sure to

= Turn down the brightness control on the screen if you
leave the computer turned on for extended periods; if the
brightness is not turned down, the image on the screen could
“burn in” and permanently damage the screen. (If your
Macintosh model does not have a brightness control, it has a
special section of the Control Panel that lets you adjust screen
brightness. For instructions on using the Brightness Control
Panel, see Special Features of Your Macintosh.)

You can use a “screen-saver” program to remove or vary the
image on the monitor’s screen when the computer is turned on
but idle for a specified period of time. These programs are
available from independent suppliers or user groups.

s [fyour Macintosh has a separate monitor, position the monitor
so that none of its ventilation openings are covered or
obstructed.

s Follow positioning instructions for a monitor precisely— don't
put it on any surface not strong enough to support it. Some large
monitors, such as the Apple Two-Page Monochrome Monitor,
cannot safely be placed on top of the main unit of a modular
Macintosh.
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Keyboard

Floppy disk drives

Floppy disks

Take special care not to spill any liquid on the keyboard or to get
greasy or sticky substances on it. If you should spill a liquid on the
keyboard and it stops working, follow these procedures:

» [f the liquid is thin and clear, try unplugging the keyboard,
turning it upside down to let the liquid drain out, and drying it
for 24 hours at room temperature. If the keyboard still doesn’t
work, take it to your authorized Apple dealer for repair.

m If the liquid is sweet or sticky, unplug the keyboard and take it
to your authorized Apple dealer for repair.

Whenever you transport the Macintosh or an external floppy disk
drive, be sure to

»  Place the plastic disk-shaped piece (placed in the drive at the
factory) in the internal floppy disk drive and in any external drives
when you move them. If your Macintosh model has a
SuperDrive, you don't need to use a plastic disk—SuperDrives can
be moved without the protector.

Figure 10-1 summarizes the correct and incorrect ways to handle

floppy disks.

125°F (32°C)

|

SOCF (10°C)

Figure 10-1  Dos and don'ts of handling floppy disks



Opel.ﬂtiﬂg The Macintosh is designed to operate reliably in a suitable
environment environment. To maintain this environment:

»  Keep the Macintosh and components out of direct sunlight and
free from exposure to rain or other moisture.

m  Operate the Macintosh only at temperatures between 50 degrees
and either 95 or 104 degrees Fahrenheit (10 degrees and either
35 degrees or 40 degrees Centigrade), depending on the model,
and at a humidity ranging from 5 percent to 95 percent. (See
the Special Features booklet or the Handbook for your model
for derails.)

= Be certain that all components are positioned so that none of
their ventilation areas are blocked or partially blocked. Do not
put papers, disks, or other items over the air circulation areas of
the system, even temporarily. Preventing proper air circulation
could result in overheating of a component and possible damage
or unreliable operation.

s If your Macintosh and components are positioned so that
you see interference on the monitor’s screen or see or hear
interference on a nearby television or radio, move the affected
components farther apart.
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Cleaning system
components

Computer and
peripheral-device cases

Monitor

Mouse

You can clean the exterior of most Macintosh system components,
the monitor’s screen, and the mouse’s mechanical parts.

To clean the case of your Macintosh or a peripheral device:

= Use a damp, soft, lint-free cloth to clean the computer’s
exterior. Avoid getting moisture in any openings.

= Don't use acrosol sprays, solvents, or abrasives when cleaning
the computer or other components.

Follow this guideline when cleaning the monitor’s screen:

= Put household glass cleaner on a soft cloth and wipe the
screen. Don't spray the cleaner directly on the screen, because
the liquid may drip into the monitor’s or computer’s interior.

The mouse contains a small ball that rolls as you move the
device. You can keep this ball free of dirt and grease by using the
mouse on a clean, hard surface and cleaning it occasionally.
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Cleaning system components

To clean the mouse,
first turn off the
Macintosh.

You should always turn off
electrical equipment before
disassembling any part.

2 Turn the mouse over
and open the plastic ring

on the bottom that holds the
ball.

Macintosh models use two
different types of rings on the
mouse; one is opened by
turning the ring counter-
clockwise, the other is opened
by pulling the ring straight
down until it snaps.

Remove the ring and the
ball beneath it.

You may be able to lift off the
ring while holding the mouse
upside down; if not, turn the

mouse over while holding one
hand underneath it to catch

the ring and ball.
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Clean the three small

rollers inside the mouse
with a cotton swab moistened
with alcohol.

Rotate the rollers to clean all
their surfaces.

Wipe the mouse ball
with a clean, soft,

dry cloth.

Don’t use any liquid to clean
the ball.

, Gently blow into the
“ mouse case to remove any
? ? \ dust that has collected there,
{

then replace the ball and ring.
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Testing and
repairing a disk

Using Disk First Aid to test
or repair a floppy disk
or 4 hard disk

Both floppy disks and hard disks can become damaged from
repeated use and handling. The Macintosh system software
provides some tools for testing disks and repairing some types of

damage or wear.

[f you see a message reporting that a disk is damaged or

unreadable, these tools may help to diagnose and correct the

problem.

You can test and repair either type of disk with the Disk First
Aid™ application, supplied with system software.

nE 5
el

Dizk First Aid

archives

(Internal Floppy Drive)

[ Drive |

[ cancel |

Testing and repairing a disk

To test or repair a disk,
start Disk First Aid by
double-clicking its icon.

The application opens and
presents a dialog box for you
to select a disk.

Select the disk you

want to test and repair,
using the Drive and Eject
buttons as necessary. Then

click Open.

The disk you selected is the
volume listed, and a message
reports that Disk First Aid

is ready.
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% File Edit SILIGLE If you want automatic

3 repair, choose Repair
Automatically from the
Options menu.

Hasume
LU BUE NG 1 Click Start to begin
Uolume: Archives . ~ .
S testing the disk.
A message at the top of the
: screen reports testing and
repair progress and results.
« WAICW Edit  Options Z When testing and repair
= Bpen Untume ., [T D are completed, choose
§ Close ; .
o Quit from the File menu.

Alternatively, to test another

@ disk, choose Close from the
(asume File menu, then select and

open the disk and follow steps

3 and 4 above.
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Using HD SC 5(:‘[[11) You can test a SCSI hard disk with the HD SC Setup
to test a SCSI hard disk  application, supplied with the system software.

The disk’s SCSI
device number

The disk’s name

5

Apple HL 5C Setup

Apple HD SC Setup

Initialize | SCSI Device: O

Update i
Partitian | | [ ]

Test &
Quit

[

The volume name is Hard Disk

B

Testing the disk will take several minutes and
A cannot be interrupted. It will not affect any data
on the disk. Do you want to continue?

l Cancel ) 0K k

Testing and repairing a disk

1 Start HD SC Setup by

double-clicking its icon.

Select the disk you
want to test, using the
Drive button if necessary.

Then click Test.
The disk’s SCSI device

number is displayed above the
Drive button; the disk name is

displayed in the message box
at the bottom of the screen.

An alert box appears
before testing begins,
asking you to confirm or

cancel the test. Click OK to

continue.

Testing begins; the spinning
beach ball icon indicates that
testing is under way.

209



300

Changing the
clock battery

Macintosh Plus

fApple HD SC Setup

@] SCSI Device: 0
Update | .
Partition
Test .

Quit k

:

Testing was successful.

When a dialog box
appears telling you that
testing is complete, click

Quit.

All Macintosh models have a system clock that runs
continuously. When the computer is turned off, a batcery

maintains the time.

You can change the clock battery in the Macintosh Plus and

carlier models.

Batteny
compartment

To change the clock

battery, first locate the
battery compartment on the
back right side of the
computer and open it by
pressing the latch.

Remove the cover of the
battery compartment.
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Other Macintosh models

Remove the battery

from the compartment
and replace it with another
battery of the same type, in
the same position.

The battery you need is a 4.5-
volt unit—the Eveready 523
or its equivalent.

Replace the cover on the
battery compartment.

The clock battery on all other Macintosh models is located
inside the computer’s case. If your system clock begins to keep
inaccurate time or stops when the computer is turned off, have
your authorized Apple dealer or representative replace the
battery.
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Troubleshooting

Avoiding data loss
or damage

At some time you may experience a problem with your Macintosh.
The descriptions of problems and possible solutions that follow
should help you in troubleshooting difficulties with your
Macintosh’s operation.

Be sure to check Special Features of Your Macintosh for additional
troubleshooting information. If you have a Macintosh Portable, you
should consult the Macintosh Portable Handbook.

In recent years, many computer users have experienced problems
with vzruses—malicious programs that damage files or erase disks. A
virus could be introduced into your Macintosh system from a disk
you or someone else puts in its drive, from a network device such as
a file server, or from an electronic bulletin board service.

Check regularly for viruses

You can use any of several virus-detection and elimination programs
to check your Macintosh disks for viruses. Such programs are
available from user groups, computer bulletin boards, and dealers.

Even if you don't notice problems with your computer’s operation
or the information on your disks, you should check for viruses
frequently if you exchange disks or information with other users.
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A good virus strategy includes these elements:

s Check your primary disk or disks regularly with a virus-
detection program and correct any problems it finds.

s Whenever you get a disk from anyone—even commercial
software—check it for viruses before using it or copying
anything from it to your system.

» [f your Macintosh is on a network or you use a modem to
connect with information services or bulletin boards, check
for viruses as often as it’s practical—ideally after cach time
you copy any information from an outside source.

s If you are part of a work group that includes a number of
Macintosh users, set up a “virus-detection station” that
everyone can use to check disks (and to copy the latest
version of virus-detection software if your group has a site
license for it).

s If you give information to other Macintosh users on disk or
send information electronically, make certain that there are
no viruses on your system before distributing the
information.
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Computer operation  Here are some potential problems, likely causes, and suggested
solutions.

The computer is turned on but the screen is dark

Cause: The Macintosh is not getting power, or the screen isn’t
getting light.

Try these actions:

m Check that the power cord is plugged in and firmly
connected to the computer and that the electrical socket has
power.

m  Check the screen’s brightness control and turn ic up if
necessary.

= If you use a screen-saving program, press a key or move the
mouse to activate the screen’s image.

When you start up, the screen is bright but the desktop doesn't
appear

Cause: The system software is not on the disk or the disk drive
is not operating properly.

When you turn on the Macintosh and insert a disk (if your
system doesn’t have an internal hard disk), you should see one of
the icons shown in Figure 10-2. (If you turn on the Macintosh
and don’t insert a disk, you’ll see the disk icon with the blinking
question mark.)
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The Macintosh
is waiting for
a startup disk.

“Happy Macintosh”
indicates that the
system software is
being loaded.

The disk that has
just been ejected is
not a startup disk.

E
X|le

*
3

“Sad Macintosh”
indicates a problem
with the svstem
software or

the computer.

1

Figure 10-2  [cons the Macintosh might display at starup

Try these actions:

s If you see the “happy Macintosh™ icon, you don't need to do

anything. The system software is being loaded.

If you see a disk icon with a blinking question mark on it,
your system is waiting for you to insert a startup disk. If your
Macintosh has an internal hard disk, this icon means that the
computer doesn’t recognize that disk.

If this happens, use a startup disk to start up and check to
see if the hard disk icon appears on the desktop. (If not, see
your dealer.)

If you see the disk icon with an X on it, you need to insert a
startup disk—one that contains an installed System Folder.

If you see the “sad Macintosh” icon, there’s a problem with
the system software on the disk or possibly with the
computer.

Eject the disk (by turning off the computer, then holding
down the mouse button while you turn the computer on

again). T'ry starting up with a different startup disk. If the
“sad Macintosh™ icon appears again, see your dealer.
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The mouse moves but the pointer doesn't move

Cause: The mouse is not connected properly or its signals are
not reaching the computer.

Try these actions:
s Check the connection of the mouse cable.

m  Sce whether the mouse needs cleaning, and if so, clean it.
(See the instructions in this chaprter.)

= Restart the Macintosh with a different startup disk. If the
pointer still doesn’t move, consult your dealer.

Typing on the kevboard produces nothing on the screen

Cause: The keyboard is not connected properly or its signals are
not reaching the computer.

Try these actions:
m  Check the connection of the keyboard cable at both ends.

m If the connections are secure and typing still yields no results,
shut down and turn off the Macintosh, then unplug the
keyboard cable. Place the computer end of the cable in the
other Apple Desktop Bus port on the computer and the
keyboard end in the other ADB port on the keyboard. (You
may have to unplug the mouse to do this.) If typing still
shows nothing on the screen, the problem is most likely in
the keyboard itself.

= Restart the Macintosh with a different starcup disk. If typing
still doesn’t produce text on the screen, consult your dealer.
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You can't save anything onto a floppy disk

Cause: The disk can’t accept information, it is damaged or

locked, or the disk drive is not working properly.

Try these actions:

If you see a message reporting that the disk is not initialized,
and you know that it has been initialized, eject the disk and
carefully insert it again. If the same message appears, the disk
is probably damaged. (You may be able to recover the
information on it with a disk-recovery program.)

If you see a message that the disk is full, eject that disk and
insert another that has adequate space for your document, or
erase some unneeded data from the disk. If you see this
message while working in a program, you can eject the disk
by choosing the Save As command from the File menu and
using the buttons in the directory dialog box.

Check the disk for obvious damage to the plastic case or the
sliding metal shutter.

Make sure the locking tab on the back of the disk at the top
left is in the down (unlocked) position. See Chapter 6 for
more information.

Insert a different disk and try saving again. If you can’t save
on the second disk, the problem may be with the disk drive.

Before concluding that the disk drive is the problem, save
your files onto a disk in a different drive, if you have one, and
then restart the Macintosh. Try saving something on a disk
you know is not damaged placed in the suspect drive. See
your dealer if saving fails again.
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You can't eject a floppy disk

Cause: The signal to ¢ject the disk is not reaching the computer
or the disk or drive is damaged.

Try these actions, in the order presented here:

s Hold down the Command and Shift keys and press the

number 1 key in the top row of the keyboard to eject a disk
in the internal drive; press Command-Shift and the number
2 to eject a disk in an external floppy drive or the second
internal drive.

If the preceding action doesn’t work, turn off the Macintosh,
then hold down the mouse button when you turn it on
again.

If neither of the preceding actions works, locate the small
hole to the right of the disk drive’s opening, and carefully
insert the end of an straightened paper clip into it. Press
gently until the disk is ¢jected, but do not force it. (See

Figure 10-3.) This method of ejecting a disk should be used
only when the other suggested methods do not work. If this
method doesn’t work, take the computer or disk drive to your
dealer to have the disk removed.

Figure 10-3  Ejecting a disk with a straightened paper clip—a last resort
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You can't start up from a hard disk or see its icon

Cause: The computer did not recognize the disk’s signals or the
disk drive is not working properly.

Try these actions:

s If the hard disk drive is an external one, make sure it is
turned on and its cable is connected firmly, then restart the
Macintosh.

m If the disk drive is an internal one, turn off the Macintosh,
wait at least 10 seconds, then turn it on again.

» If the hard disk is your startup disk, start up with a different
disk and reinstall the system software on the hard disk.

w If the hard disk is not your startup disk and you have more
than one hard disk in your Macintosh system, check the SCSI
ID number of each external hard disk and all other SCSI
devices connected to your computer. If two devices have the
same ID number, one of the devices will not be recognized by
the computer. Change the duplicate number to a number not
currently used. See Chapter 9 for more information.

> Seealso: “Testing and Repairing a Disk” in chis chaprer.

A dialog box with a bomb appears
Cause: Your system has a software problem.
Try these actions:

» Click the Restart button on the screen (if one is displayed as
part of the message). The computer may start up normally.

s If no Restart button is displayed (or clicking it doesn’t work),
use the power switch to turn off the Macintosh, wait at least
10 seconds, then turn it on again. The system may start up
normally.
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» [f the Macintosh doesn't restart with the same startup disk,

try to start up with a different startup disk.

If the Macintosh starts up with a different disk, check the
startup disk and program you were using when the bomb
message appeared. You may have been using elements of the
system software that were incompatible with each other or
with the program you were using. For example, if you used
the newest version of the System and Finder with an old
version of the Font/DA Mover, you could get the bomb
message. Reinstalling the system software may correct the
problem with the first startup disk.

Sometimes incompatible desk accessories can cause the
system to display a bomb message. Try removing any recently
installed desk accessories to see if the computer works all
right.

Occasionally it’s necessary to pull the plug, if the power
switch doesn’t succeed in cutting power to the computer.

— Important: Always be sure to upgrade all parts of your system
software when you install a new version of the Macintosh system
software, and always verify that the programs you use are
compatible with the version of system software you have
installed.  —
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The pointer suddenly “freezes™ on the screen
Cause: Your system has a software problem.
Try these actions:

s Turn off the Macintosh with the power switch on the back,
wait at least 10 seconds, then turn it on again. The system
may start up normally.

w If the Macintosh doesn’c restart with the same system disk,
try to start up with a different startup disk.

» If the Macintosh starts up with a different disk, check the
startup disk and program you were using when the system
froze. You may have been using elements of the system
software that were incompatible with each other or with the
program you were using. Reinstalling the system software
may correct the problem with the first disk.

n  Occasionally the system may freeze when you are using
MultiFinder. With the same combination of programs
open, check the allocation of system memory in the About
the Finder window. See “Managing System Memory” in
Chapter 3 for more information.

Important: Always be sure to upgrade all parts of your system
software when you install a new version of the Macintosh system
software, and always verify that the programs you use are
compatible with the version of system software you have
installed. —
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Printer operation

If you have a printer connected to your Macintosh, you might
encounter one of the following situations.

You give the command to print a document and the printer
doesn’t respond

Cause: The command isn't reaching the printer or the printer
isn't working properly.

Try these actions:

= Check that the printer is turned on and warmed up (if it’s a
LaserWriter, it should have printed the sample page).

m  Check the cable connections to the printer.

» If your printer is an ImageW'riter, make sure that the Select
light is on. (Press the Select button to turn the light on.)

m  Check that the printer is selected in the Chooser. See
“Choosing a Printer” in Chapter 4.

m If the Chooser does not show an icon for the type of printer
you want to use, place the driver or drivers for that printer in
the System Folder of your startup disk and restart the
Macintosh. See Chapter 4 for more information.
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General tips

You print a document on a network printer and it causes the
printer to restart or to display an error message

Cause: The printer has received conflicting signals.
Try these actions:

»  Make sure that you are using the same version of the printer
driver as all other people on your network. (If not, place that
driver in your System Folder and restart the Macintosh.)

s If you see an error message stating that the printer could
not print your document, turn off the printer for at least
10 seconds, then turn it on again and wait for the printer
to warm up before trying to print again.

[f your Macintosh or a component is not working properly but
its problem is not described in this chapter, you can try some
general measures that may solve the problem.

Start over

Often you can eliminate a problem simply by clearing the
computer’'s memory and starting over.

m [f possible, save any open documents in which you've made
new changes before restarting the Macintosh. (If your system
is frozen or you have a bomb message on the screen, saving
won't be possible.)

s Choose Restart from the Special menu, if possible, or turn off
the Macintosh, wait at least 10 seconds, then turn it on
again.

» [f your problem is with a peripheral device, such as a printer
or external hard disk, turn it off for 10 seconds or more, then
turn it on again and restart the Macintosh.
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Make certain that al
same version

parts of the system software are from the

These tips help keep your system software in good working order:

m  When you install a new version of system software, be sure to
copy it on all starcup disks that you use, to avoid inadvertently
working with two different system versions later.

n If the System Folder becomes damaged on one of your
startup disks, either reinstall the software on that disk or copy
the System Folder from a good disk onto the disk with the
damaged folder.

s When you install a new version of system software, verify that
the new versions of drivers for the printer and other types of
devices you use are in the System Folder of your startup disks.

Make certain that vour programs are in good working order

Here are tips for keeping your application programs working
effectively:

= [f you have problems with an application program, make
another working copy of that program from the original
program disk.

s Ifa new copy of the application program doesn’t correct the
problems with it, check with the program’s manufacturer to
make sure that the version of the program you have is
compatible with the version of the Macintosh system
software you are using. (You can often upgrade to a newer
version of the program for a modest fee.)
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= If you use a hard disk, be sure to keep only one System Folder
and only one version of each application program on your

disk.

= If you use any special programs that customize your System
file (these programs are usually called INITs, Control Panel
devices, or CDEV5), always check with the sources or
developers of those programs before you install them to make
sure that they are compatible with the version of Macintosh
system software you're using.

Create free space on the startup disk

Occasionally you may see an error message reporting that the
Macintosh doesn't have enough memory to start up.

Try these actions:

» Start up with another disk, then open the startup disk that
didn’'t work and remove some items from it.

m If your Macintosh starts up from a hard disk, you can use a
program that reduces the fragmentation of data on the disk.
This procedure makes disk operation faster and creates larger
arcas of free space for startup. (You can obtain a utility
program to reduce fragmentation from your Apple dealer.)

v
i}
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Take your time

When you see an error message on the screen, you don’t have to
take an action immediately. The message will stay on the screen
until you click the button that’s part of it or turn off the
Macintosh.

To help you diagnose and correct the problem, try to gather as
much information about the situation as you can before
starting over:

= Make a note of exactly what you were doing when the
problem occurred. Write down the message on the screen and
its ID number. (This information will help a service person
diagnose the problem should you need to take the computer
to your authorized Apple dealer for repair.)

»  Check the screen for any clues that are visible—a menu title
selected, the program and document icons that are open, and
anything else that seems relevant to the current situation.

» If you were writing new text, and were not able to save it
before the problem occurred, you can write down the parts of
the text still visible on the screen so that some of your work
will be easy to replace.

»  Ask other experienced Macintosh users about the problem
you're having; they may have a solution for it.
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Rebuild your desktop once a year

A process known as “rebuilding the desktop™ helps your
Macintosh keep track of data on your startup disks.

s To rebuild the desktop of a startup disk, hold down the
Option and Command keys while starting up your computer.

s Follow the rebuilding procedure for cach of your startup
disks once a year.

Back up your work and your programs frequently

To ensure that the information and the programs you use with
your Macintosh will always be available, back up your work
regularly and back up each program when you begin using it.

s Ifyou use a hard disk for most of your work, be sure to make
copies of all key programs and files on floppy disks.

» To protect essential information, such as business archives
and financial records, consider making duplicate backup
copies on floppy disks and storing them in a location
different from your regular Macintosh work place.
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Service 'clnd SUPPOIT To help you get the best performance from your Macintosh, Apple
Computer, Inc. has established a worldwide network of full-support
authorized Apple dealers. If you need answers to technical questions
or information about product updates, your authorized Apple dealer
can help you. Apple’s Technical Support organization backs each
dealer and international technical support group via AppleLink®, a
state-of-the-art on-line electronic information service, to ensure
promprt, reliable assistance.

Your dealer has the latest information on new hardware and
software products as well as product updates. If you wish to
upgrade your system, your dealer can help you select compatible
components.

If your Macintosh or a peripheral device requires service, your local
authorized Apple dealer is trained and ready to support you. Apple
provides factory-quality parts and the latest available diagnostic
equipment to the more than three thousand authorized Apple
service centers throughout the world. Apple guarantees parts and
warranty labor. (Regulations in each country determine the length
of warranty. Some restrictions may apply, depending on the country
of original purchase.)

If for some reason you cannot return to the authorized dealer from
whom you purchased your system, go to the nearest service
location. For the location nearest you, in the United States

call (800) 538-9696; in Canada, call (800) 268-7796 or

(800) 268-7637. For locations in other countries, either call the
Apple headquarters in your country or write to

Apple Computer, Inc. or Apple Canada, Inc.
Customer Relations 7495 Birchmount Road
20525 Mariani Avenue Markham, Ontario
Cupertino, CA 95014 L3R 5G2

USA Canada
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Apple also offers service options designed to meet your needs.
One of these is the Apple Care® Service Agreement (available in
the United States, Canada, and Australia only), which extends
full warranty coverage up to three years. Your Apple Care
contract will be honored at any participating authorized Apple
dealer within the country of purchase—an added benefit if you
relocate. Local service means time saved in getting your Apple
system back to work.

You can purchase Apple Care at any time, but it’s a good idea to
purchase it with your system, or at least before your warranty
has expired, to avoid an owner-paid inspection.

There are also self-service plans designed to allow large
installations to repair their own equipment. Whether you use
your computer at home, in the office, or at school, Apple has a
low-cost service plan for you. For details, please see your

authorized Apple dealer.

Service and support 519






Keyboard layouts

Appendix A

Keyboards and
Character Sets

Along with the mouse, you use the keyboard to communicate
with your Macintosh. You can choose from several keyboards for
use with most Macintosh models; the layout and selection of keys
varies somewhat among the different keyboards.

No matter which keyboard you use with your Macintosh, you
can use certain keys, such as Option, Command, and Shift, to
type optional characters. The Key Caps desk accessory shows the
location of optional characters for each font installed in the
System file.

The illustrations that follow show the layouts of the
Macintosh Plus keyboard (used only with that model) and the
keyboards that can be used for other Macintosh models.

P Seealso: o “Using Special Keys and Indicators on the Keyboard” in
Chapter 1
* Appendix B, “MacroMaker Command Files”
* Appendix D, “Special Aids for Using the Mouse,
Keyboard, and Screen”
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Macintosh Classic/
Macintosh LC
keyboard

Power On key: On some Macintosh models,
you press this key to switch on

vour computer. On the Macintosh

Classic. this key has no function.

Tab key: Moves the insertion point horizontally
to the next stopping place (such as a tab sop or
data field in o dialog box or program).

Caps lock key: A locking Shift kev for

letters only (numbers and symbols
aren’t affected).

Shift key: Produces uppercase letters

(or the upper character on the key).

Control key: Like the Command key, works
in combination with other keys to provide
shorteuts or modify other actions,
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22 Figure A-1

Option key:
Produces an
optional set of
special characters
when pressed in
combination with
other keys.

Command key: Works with
other kevs as a shorteut 1o
choosing a menu command or
(in some programs) canceling
AN operation in progress,

such as printing.

The Macintosh Classic Macintosh LC kevhoard



Return key: Numeric keys:
paragraph and moves the insertion produce numbers and

Delete key: Deletes any text point 1o the beginning of the next— mathematical symbols;

currently selected. or whatever line. In a dialog box, pressing some programs designate
character is to the left of the Return is the same as clicking these keys as special
insertion point. the outlined button. function keys.
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Esc key: Iscstands 1 Arrow keys: Move Clear key: Deletes the Enter key: In a dialog
for Escape: the function the insertion point, current selection. just as the— box, pressing Enter is
of this key depends on as an alternative Delete key does. In some the same as clicking
the program you're using. to using the mouse. programs, Clear may have the outlined button (or
other functions. pressing Return); some

programs require that
vou use Enter (not
Return) to put data into
specific fields.
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Apple Keyboard

Esc key: Esc stands for Escape; the function
of this key depends on the program you're using.

Tab key: Moves the insertion point horizontally
to the next stopping plice (such as a tab stop or
data field in a program).

Control key: Like the Command key, works
in combination with other keys to provide
shortcuts or modity other actions.

Shift key: Produces uppercase letters
(or the upper character on the key),

Power On key:

With most modular

Macintosh models, you press

this key to

lurn on your system

when it’s been turned off.

[
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Caps Lock key: A locking Shift
key for letiers only (numbers

and
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o

symbols aren’t affected).

/
/]

Option key: Produces
an optional set of special
characters, in combination
with other keys.

Figure A-2 The Apple Keyvboard
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Command key: Combines wit
another key as a shorteut to
choosing a menu command or
(in some programs) canceling
an operalion in progress,

such as printing.



Delete key: Deletes any text Return key: Moves the

Numeric keys: These kevs

currently selected, or whatever insertion point (o the beginning produce numbers and

character is to the left of the
insertion point. pressing Return is the same as
clicking the outlined button

of the next line. In a dialog box, mathematical symbols.
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Arrow keys: Move

the insertion point,

as an alternative Delete key does. In some

10 using the mouse., programs, Clear may have
other functions

Clear key: Deletes the

current selection, just as the

Enter key: Ina dialog
box, pressing Enter is
the same as clicking
the outlined button (or
pressing Return); some
programs require that
vou use Enter (not
Return) to put data into
specitic fields.

e

gy



Apple Extended
keyboard

Function keys: Designed o work inalternative operating systems such as
A UNor MS-DOS, With the help of the MacroMaker utility program,

vou can use these kevs in the Macintosh Operating System to

produce recorded characters and commands,

Esc key: Esc stands tor Escape: the function
of this kev depends on the program you're using,

Tab key: Moves the insertion point horizontally

10 the next stopping place (such as a b stop or
data field ina program).

Caps Lock key: A locking Shift key for letters
only tnumbers and symbols aren’t affected).

Shift key: Produces uppercase letters
(or the upper character on the key).

Control key: Like the Command kev, works
in combination with other kevs 1o provide
shortcuts or madity other actions,
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(in some programs) canceling
AN Opertion in progress,
such as printing.

Figure A-3  The Apple Extended keyboard



Delete key: Deletes any text
currently selected. or whatever
character is to the left of the
insertion point.

Special keys: These keys are
designed to work in alternative
operating systems. In most
cases, the function of these keys
depends on the operating system

Numeric keys: These keys
produce numbers and
mathematical symbols;
their arrangement matches
that on the Caleulator

Power On key: With

most modular Macintosh
models, vou press this key
1o turn on your system when
it’s heen turned off.

and program you're using. desk accessory.
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Return key: Moves the insertion
point to the beginning of the next

line. In a dialog box. pressing

Return is the same as clicking the

outlined button,

Arrow keys:

Move the insertion
point. as an alternative
to using the mouse

Clear key:
Deletes the
current selection,
just as the Delete
kev does. In some
programs, Clear
may have other
functions,

into

Enter key: In a dialog hox.
pressing Enter is the same as
clicking the outlined button
(or pressing Return): some
programs require that you use
Enter (not Return) to put data

specific fields.



Optional
characters

Viewing optional characters

328

with Key Caps

You can produce a variety of optional characters by pressing the
Option key or Option-Shift keys in combination with certain
character and number keys.

The Key Caps desk accessory shows you the standard and optional
character sets produced when modifier keys are pressed, such as the
Shift and Option keys. Key Caps is supplied with the Macintosh
system software and installed as part of the standard desk
accessories on all Macintosh models with an internal hard disk.

You start Key Caps like any desk accessory—Dby choosing its
name from the Apple menu.

Figure A-4 shows the Key Caps window with each of two sets of
optional characters available in the Chicago font when the

Option key is pressed and when Option-Shift is pressed on the
Macintosh Plus keyboard.
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Test box: characters
appear here when
you try keys out by
pressing them on the
keyhoard or clicking
them in the window,

The highlighted key
in the Key Caps
window represents
the key held down
on the keyboard—
in this case, the
Option key.

Option key

Shift kevs

[E=—————————— Key Caps
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Special characters
available in the
Chicago font
when the Option
key is pressed

Special characters
available when
Option-Shift

is pressed

Figure A-4  Special characters displayed by the Key Caps desk accessory

The Control key available on some keyboards also produces

optional characters for some keys.

Optional characters
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Typing accented characters

You can display the character sets for other fonts installed in your
System file by choosing the name of the font from the Key Caps
menu when the Key Caps window is open. (See Figure A-5.)

Athens
Avant Garde
B Avant Garde Demi
B Garamond Bold
B Helvetica Bold
Bl Avant Garde DemiOblique
Bl Garamond Boldltalic
Bl Helvetica BoldOblique
Cairo

vChicago

Figure A-5 The Key Caps menu (available when Key Caps is in usc)

Using the Option key with certain other keys lets you enter
international language characters. Table A-1 shows the accent
marks and the key combinations that produce them.

Table A-1  Option-key combinations for accent marks

Accent mark Key combination

Grave accent () Option- . then type the character to be
accented

Acute accent () Option-g, then type the character

Circumflex (A) Option-i, then type the character

Tilde (~) Option-n. then type the character

Umlaut () Option-u, then type the character

The letter ¢ with a cedilla (¢) Option-¢
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| Appendix B

MacroMaker
Command Files

'™ oy . -

Ihe MacroMaker ™ utility program provided with the

Macintosh system software lets you record keystrokes and

commands in special files called seripes or macros, and assign the

scripts to a key or a combination of keys on the keyboard. When
p ¥ : )

you press the key or combination of keys that has a MacroMaker

script, the script is “played.”



-

Installing
MacroMaker

Program icon

MacroMaker is supplied in the MacroMaker Folder on the
System Additions disk. (If you are updating your system
software with an upgrade kit, you'll find MacroMaker on
Utilities Disk 2.) Figure B-1 shows the icons of the three files
in the MacroMaker Folder.

Help file File of scripts: the

/— scripts provided
assign the Undo,

- Cut, Copy, and Paste
commands to
function keys F1
through F4 on an
extended keyhourd.

Macrotlaker  MacroMaker Help Macros
Figure B-1  Icons for the MacroMaker program, plus help and script files

To install MacroMaker, follow these steps:

1. Drag the icons for the program, its help file, and (if you
have an extended keyboard) the script file “Macros” to the
System Folder of your startup disk.

2. Restart the Macintosh.

Once the program is installed, a MacroMaker menu appears to
the right of the other menus in the menu bar. The MacroMaker
menu’s title resembles a cassette tape. (See Figure B-2.)

( % File Edit Uiew Special [@g— ‘HooMher

I menu icon

Figure B-2  The tape icon that identifies the MacroMaker menu

You remove MacroMaker by dragging its icons out of the
System Folder of your startup disk and restarting the computer.
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Creating macros
with MacroMaker

Info box with
description of
loaded macro

Keystroke line
(with Option-S for
this macro)

Clicking here
initiates script
recording.

You create a macro in the MacroMaker window. (See Figure B-3.)

Name line
(selected here)

Pop-up menu

- Macllrite Macros of macro lists
Name: BILGLUTEE .

Info : Full name and title for business letters

) : F
Address List of macros,

displayed
according to the
view indicated
helow

When a macro

i isselected inthe
. list, clicking this
button erases il.

Clicking Clicking When a macro in - 1Views available
here plavs — here stores the list is selected,  (sliding indicator
the current  the current clicking this changes the list
MACTO. NEACTO. hutton loads it. above)

Figure B-3  The MacroMaker window

Follow these steps to create a macro.
1. Open a new document in the program you’re using.

If you're working on the desktop (which means you're
using the Finder), you can skip this step.

2. Open the MacroMaker window by choosing Open
MacroMaker from the MacroMaker menu.

3. Type a name for the macro on the Name line.
The name can be up to 16 characters long.

4. 1f you want to add a description of the macro, click to
select the Info box and type the information.

e
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5. Click the Keystroke line to select it and type the keystroke
or key combination that you want to trigger the macro.

You can include modifier keys, such as Command, Option,
and Shift, in your keystroke; MacroMaker displays a symbol
to represent each of these keys. (See Figure B-4.)

&  Caps Lock

3 Command

&% Control
Numeric keypad
=5 Option

4+ Shift

Figure B-4  Symbols for moditicr keys used in keystrokes for macros

6. Click the Record button.

MacroMaker returns you to the current program. The
cassette icon blinks in the menu bar to remind you that all
keystrokes, mouse clicks, and menu commands you use will
be recorded until you stop recording.

7. Enter the script you wish to record by typing, clicking, and
choosing menu commands.

If you make a mistake while typing, use the Delete
(Backspace) key to remove the incorrect characters.

8. To stop recording, choose Stop Recording from the
MacroMaker menu.

Recording stops, and the MacroMaker window opens.
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9.

10.

L1;

If you want to check your script, click the Play button.

MacroMaker returns you to the program in which you
recorded the script, repeats the script, then reopens the
MacroMaker window.

If you want to change the script, you can record it again
without changing the name or keystroke.

Click the Store button to save the macro and move it into
the macro list on the right side of the MacroMaker window.

If the list already contains a macro with the same name or
keystroke, you'll see a dialog box asking if you want to replace
the existing macro with the new one or to cancel the store
command. If you cancel, you can rename the macro or
change the keystroke and then store it.

If you don’t store a macro and you close the MacroMaker
window, you'll see a message asking if you want to store the
macro before closing. If you don’t store it, the macro will be
lost.

Creating a global macro: You can create a global macro, which
is available regardless of the program you're using, by
selecting Global Macros from the pop-up menu above the
macro list box on the right side of the MacroMaker window,
then following the regular steps to make a macro. Because
menu commands vary among programs, it’s a good idea to
avoid using them in a global macro unless you're certain that
they are provided on the same menu, at the same position, in

2,

all programs.

» Secalso: o “Using Special Keys and Indicators on the Keyboard™ in

Creating macros with MacroMaker 33

Chaprer 1

* Appendix A, “Keyboards and Character Sets”

* Appendix D, “Special Aids for Using the Mouse,
Keyboard, and Sereen”
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Appendix C

Exchanging Disks and Files
With MS-DOS Computers

Some Macintosh models have the Apple SuperDrive as the
internal floppy disk drive. The SuperDrive can read and
initialize 3.5-inch disks for both Macintosh computers and for
computers that use the MS-DOS operating system.

You use the utility program Apple File Exchange to initialize
disks in the MS-DOS format and to convert files from
MS-DOS computers for use in a Macintosh computer.

336



Using Apple File

Exchange for

MS-DOS disks
and files

Initializing an MS-DOS disk
in a SuperDrive

Apple File Exchange is supplied on the System Additions disk
provided with Macintosh system software. (If you are updating
your system software with an upgrade kit, you’ll find Apple File
Exchange on Utilities Disk 2.) The program and one or more
special translator files, which conver files, are stored in the

Apple File Exchange Folder.

Figure C-1 shows the Apple File Exchange icon.

N

Apple File Exchange

Figure C-1 The Apple File Exchange icon

To initialize a 3.5-inch disk in MS-DOS format, follow these
steps:

1. Start Apple File Exchange by double-clicking its icon.

The program’s window opens, showing a directory dialog
box that lists the contents of the active window on the left
side and has an empty list box on the right side.
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2. Place a blank high-density disk in the SuperDrive.

A dialog box appears, reporting that the program can’t read the
disk and asking if you want to initialize it. This dialog box
shows the names of formats available in Apple File Exchange,

including Macintosh and MS-DOS. (See Figure C-2.)

(You can initialize a disk that is not blank by inserting it,
clicking the drive button until its name appears above the
right list box in the Apple File Exchange window, and
choosing Erase Disk from the File menu.)

High-density disk dialog box Normal-density disk dialog box
) Apple File Exchange cannot ] Apple File Exchange cannot
= read this disk. Do you wish to m read this disk. Do you wish to
initialize it? initialize it?
Jisk capacity —
.I isk ¢y 1€y ——® 1440K [Macintash | © 400K
is the same for MS-D0S ©) 800K MS-D0S
MS-DOS high-
density disks. (initiatize ) [ Eject )] itiatize ) (_Eject )

MS-DOS capacity

Figure C-2  Dialog boxes for initializing high-density and normal-density disks

3. Click MS-DOS, then click the Initialize button.

The disk is initalized in MS-DOS format. When
initialization is completed, a dialog box appears, asking you
to name the disk.

Type a name for the disk, then click OK.

The name must be valid for MS-DOS—up to 11 characters,
with no period.

The dialog box closes, and the name of the disk you
initialized appears in the Apple File Exchange window, above
an empty directory. This disk’s icon doesn’t appear on your
Macintosh screen (because it is in MS-DOS format).
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Converting files to and from
MS-DOS format

5. Choose Quit from the File menu when you are finished
using Apple File Exchange.

“ Initializing a normal-density disk in MS-DOS format: You
can also use Apple File Exchange to initialize a regular
(normal-density) 3.5-inch disk for MS-DOS files. Follow the
preceding steps, but place an 800K disk in a SuperDrive and
click 720K in the dialog box that asks whether you want to
initialize. (See Figure C-2.) #

O
oo

5.25-inch disks: Some Macintosh models can use an external
5.25-inch floppy disk drive that can read data files from
MS-DOS disks. An internal adapter or expansion card is
required to connect a 5.25-inch disk drive to the Macintosh.
Apple File Exchange can translate files from these disks and
store files on them.

Apple File Exchange converts Macintosh files into MS-DOS
format and MS-DOS files into Macintosh format. The program
provides two built-in methods of translation—text translation
for use with text files, and binary translation, which copies a file
in binary form.

In addition, Apple File Exchange can use separate translator files
designed to convert files into formats for specific programs. One
translator file provided with Apple File Exchange is the DCA-
RFT/MacWrite file, which converts documents between
MacWrite format for the Macintosh and Document Content
Architecture/Revisable Form Text format (used by many word
processing programs) for MS-DOS.
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Figure C-3 shows the Apple File Exchange window with a
Macintosh hard disk on the left and an MS-DOS disk on the right.

Menus of

translator files & File Edit Mac to MS-00S MS-D0S to Mac ]
e Apple File Enchange | S
File selected for £ _ Directory title
translation
Directory list { N BUgoEL- 9 =
) || O3 Disk Images BUDGET.91
|0 Lapels BUDGET.OUW Buttons to translate
EE i
5 or remove a file
27K - v
bytes Size of file selected
selected BI“
Disk name E =] [Z) MSDDS. jjh
; ; : — 0 Space available
Space available _A094K bytes available 1324K bytes available P the disk
on the disk ( Open ) ! [ Drive ] (Copen )i Drive ] onthe dis
g | (New Falder] [ Tject ] (New Foider) | [ Eject )
Y ‘l"i

Buttons to open and create folders, switch
disk drives, and cject floppy disks

Figure C-3  The Apple File Exchange window and menu bar

Follow these steps to translate a file:
1. Start Apple File Exchange by double-clicking its icon.

The program’s window opens, showing a directory dialog box
that lists the contents of the active window on the left side
and has an empty list box on the right side.

2. Use the Open, Drive, and Eject buttons, if necessary, to
display the files you want to translate and the destination
disk or folder where you want to store the translated files.
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Active translator

This item presents

a dialog box for
adding translators 1o
a translator menu

3. Click the name or names of the files or folders you want to
translate to select them. To select multiple files or folders,
hold down the Command key and click each name. You may
have to scroll to locate the names of some files or folders.

4. Open the translation menu for the kind of file translation
you want by pointing to its title and holding down the
mouse button.

If you are translating MS-DOS files into Macintosh files,
open the MS-DOS to Mac menu. This menu shows the
DCA-RFT/MacWrite translator provided in the Apple File
Exchange Folder, the built-in “Text translation™ and “Default
translation” (binary translation), and any other translators
you've added. (See Figure C-4.)

MS-D0S to Mac
vDCA-RFT to Maclrite

Text translation... -
-+ Default translation ~E|—— Three dots in
| tker trepaistions. menu inclicate
— that a dialog box
appears when the
item is chosen.

Figure C-4  The MS-DOS to Mac translator menu in Apple File Exchange

5. Make sure that all translators for the types of files you've
selected are active; if not, select them.

An active translator has a check mark beside it or, for the
default translator, a diamond (indicating that it’s always
active). (Selecting an active translator makes it inactive.)
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6.

Compare the size of the files or folders selected for
translation with the space available on the destination disk.

The total space for the items selected appears between the
two directory lists; the space available on the destination disk
appears below the name of the destination disk.

. If the size of the selected items is greater than the space

available on the destination disk, then either deselect some
of the items selected, select and remove some files on the
destination disk (using the Remove button), or change disks
in the destination drive (using the Eject button).

When sufficient space is available for the selected items,
click the Translate button.

If Apple File Exchange finds two or more active
translators—other than Text or Default—capable of
translating any selected file, it presents a dialog box asking
you to select the translator you want from a list of active
translators.

If the names of destination files or folders conflict with
existing files or folders, or with each other, Apple File
Exchange presents a dialog box in which you can rename the
destinarion file.

If a translator requires you to select options before a file is
translated, it presents a dialog box in which you select the
options. (Translator names followed by three dots in a
translator menu present an options dialog box.)
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9.

If necessary, select the appropriate translator from the list,
and then either click the Continue button in the dialog box,
rename the destination file and click Translate, or select the
options you want and then click OK.

The selected files or folders are translated. A dialog box
reports the status of copying, showing a horizontal bar that
fills progressively with a gray pattern as the translation is
completed.

[f Macintosh files are being translated into MS-DOS files,
the names of translated files are shortened to conform to the
naming conventions of MS-DOS (maximum 11 characters,
with a period between the eighth and ninth).

10. When all translations are finished, choose Quit from the

File menu.

Converting MS-DOS files on a file server: Some file servers
can store information created by Macintosh computers and
MS-DOS computers. For example, the AppleShare PC
program allows MS-DOS computers to store and translate

.,

files on an AppleShare file server.
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Other file-conversion Apple File Exchange provides several other options to assist you

()p[i()ﬂﬁ with file conversions. Figure C-5 shows the program’s File menu,

where you choose these options.

The program keeps a
log of all files ranslated:
it shows the date, time,
and type of conversion.
The log can be saved,

—Show User Log
Close

Save User Log As...
Clear User Log

cleared, or printed
when it's open.

Restore settings from...
Save settings as...

In

You can rename

Page Setup...
Print User Log...

destination files even if
names don’t conflict, —__
The program dims the

names of files that can't
be converted by the

__Rename Destination Files...

active translators when

this item is checked.

|vShow Only Eligible Files 3E
Erase Disk...
Quit a0

The active translators and the
options for each translator can
be saved in a special file with
the “Save settings as”
command. You can then use
them any time by choosing the
“Restore settings from”
command and opening the file.

The Erase Disk
command lets you
reinitialize a disk in any
of the formats available.

Figure C-5 The File menu options in Apple File Exchange
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More information about Apple File Exchange options

The program itself contains explanations of the translators it
uses. Choose About the Apple File Exchange from the Apple
menu to see the list of translators, select an item in the list, then
click the About button for information about that item. (Click
the Done button to return to the program’s window.)

Converting Apple [T files with Apple File Exchange

You can also translate files to and from the format for the
ProDOS® operating system for Apple II computers. Apple File
Exchange converts ProDOS files to and from Macintosh format
and MS-DOS format. You can obrtain translators for ProDOS

and other operating systems from your authorized Apple dealer.
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Appendix D

Special Aids for Using
the Mouse, Keyboard,
and Screen

T’l(.‘ Macintosh system software includes utility programs
designed to assist users who have difficulty using the keyboard
or the mouse or reading the monitor’s screen. These programs
are Easy Access, which provides alternative ways to use the
mouse and keyboard, and CloseView™, which magnifies the
images displayed on the screen.
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Keyboard and
mouse assistance
with Easy Access

Easier keyboard use
with Sticky Keys

Easy Access is a file in your System Folder that provides two

features—"Sticky Keys” and “Mouse Keys.” These features assist

people who have difficulty typing with both hands or with
manipulating the mouse. They’re also useful to anyone who
wants to use the keyboard with one hand or to make very fine
movements of the pointer with better control.

The Sticky Keys feature of Easy Access lets you type
combination keystrokes, consisting of a modifier key and

another key, without actually pressing the keys simultaneously.

The modifier keys covered by Sticky Keys are
» Shift key
s Command key

= Option key

Control key (not on the Macintosh Plus keyboard)

Keyboard and mouse assistance with Easy Access

3

1/



To use Sticky Keys, follow these steps:
1. Press the Shift key five times without moving the mouse.

(If you bump or move the mouse during this sequence, begin
again.)

When you turn Sticky Keys on, its icon appears at the far-
right end of the menu bar. (See Figure D-1.)

2. Press the key combination you want to use.

When you press a modifier key, the Sticky Keys icon changes
to indicate that the modifier key is set or locked. (See

Figure D-1.) Pressing a modifier key once sets it; pressing the
key twice locks it.

3. To turn off Sticky Keys, press the Shift key five times again.

You can also turn off Sticky Keys by pressing any two
modifier keys at the same time.

Sticky Keys A maodifier key
ison. has been pressed.

L ol i
E b E > E ) N mudil_lurkey'is
— 1 locked (pressing the

key twice locks it for
repeated use).

Figure D-1  Icons for the Sticky Keys feature of Fasy Access

Fasier mouse use  The Mouse Keys feature of Easy Access lets you manipulate the

with Mouse Keys  pointer using the numeric keypad on your keyboard instead of
the mouse. You can click, drag, and perform all the usual mouse
activities, and you can gain precise control of mouse movements
when needed.
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To use Mouse Keys, follow these steps:

1. To turn on Mouse Keys, press Command-Shift-Clear. (You
can use Sticky Keys for this combination if you wish.)

2. Use the numeric keypad to move the pointer and to click,
drag, and make other mouse movements.

Figure D-2 shows the pointer movement produced by
pressing keys on the numeric keypad. The 5 key serves as the
mouse button: press once to click; press twice to double-
click. The 0 key locks the mouse button down for dragging.
The decimal point key (to the right of 0) unlocks the mouse
button.

3. To turn off Mouse Keys, press Command-Shift-Clear
again.

<= . \
4 {15 e fl=_
AN
, SE— —_

l ' | |

Figure D-2  Pointer movements and mouse control with Mouse Keys turned on

P Seealso:  * “Using Special Keys and Indicators on the Keyboard” in
Chapter 1
» Appendix A, “Keyboards and Character Sets”
» Appendix B, *MacroMaker Command Files”
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Easier screen

CloseView is a utility program supplied

viewing with  with Macintosh system software that

CloseView

makes the screen easier to view or read
for people who have difficulty with

standard-sized screen images.

You install CloseView by dragging its
icon to the System Folder of your

startup disk. (See Figure D-3.)

G

Figure D-3  The CloseView icon

You turn CloseView on and select its
features in the Control Panel. With
the General Control Panel open,
locate and click the CloseView icon to
display the CloseView Control Panel.
(See Figure D-4.) Then select the

options you want to use.
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Control Panel FF7m7—

Clase

Inverts _|
screen image

Turns _|
keystrokes
on or off

i2) 1985,1959,
#pple Computer, Inc.

developed by
Berkeley Systems, Inc

ot ':-::' On
&f A/ = | SEEE0
1ICW,: ®on
—[@ Elack on White [EAGtizatio
() hite on Black {1 on B
- =53 H
() Off
| Keyboard (@) 0n = g
Shorteuts () Off 4 % E‘] i
" * q:b % \.l.'
...... Sl e

Figure D-4  CloseView Control Panel

Turns
CloseView
on or oft

Turns
magnification
on or off (or
use keystroke)

Arrows change
magnification
power (or use
keystroke).

When CloseView is on, you'll see its frame (a
heavy box covering a portion of the screen).

The frame moves when you move the pointer

on the screen.

Fasier screen viewing with CloseView



When the frame is displayed, you can
turn magnification on with the
keystroke Option-Command-X. (The

same keystroke turns magnification oft.)

To increase or decrease the power of
magnification, use the keystroke
Option-Command-Up Arrow
(increase) or Option-Command—
Down Arrow (decrease).
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Appendix E

Where to Get

More Information
About Your Macintosh

As you increase your knowledge of computers and develop
new uses for your Macintosh, you may want to learn more about
programming, hardware design, or other technical topics. Or
you may simply want to know what other Macintosh users in
your area are doing with their computers.

The information presented in this appendix provides a starting
point for you to expand your Macintosh knowledge and
contacts, no matter what your interests.



Macintosh
user groups

Technical
information

Whatever your level of computer experience, you can get lots of
support by joining a Macintosh user group. Macintosh user
groups are composed of people who work with Macintosh
computers and who enjoy sharing what they know with others.
Activities may include new product demonstrations,
information question-and-answer sessions, and regular classes on
using popular programs or learning to write your own programs.
Many user groups have special beginners” meetings.

Ask your authorized Apple dealer for the name of the Macintosh
user group nearest you, or call 1-800-538-9696 for more
information. For user groups outside the United States, or if
you're interested in starting your own user group, contact

Berkeley Macintosh User Group or Boston Computer Society

1442-A Walnut Streer, #62 One Center Plaza
Berkeley, CA 94709 Boston, MA 02108
(415) 849-9114 (617) 367-8080

A variety of technical documentation is available for the
Macintosh. Apple Computer releases technical information
through three primary outlets: the Apple Technical Library and
the Apple Communications Library, both published by
Addison-Wesley Publishing Company, and APDA™.
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Apple Technical Library

Apple Communications
Library

APDA

The Apple Technical Library includes comprehensive technical
documentation for all Macintosh computer models and the
multiple-volume guide to the Macintosh operating system for all
models, Inside Macintosh.

Other books in the Apple Technical Library cover design of
expansion cards and programming of device drivers for the
Macintosh, programming for the Macintosh, and designing the
user interface for Macintosh programs.

You'll find the Apple Technical Library in most well-stocked
bookstores.

The Apple Communications Library offers complete technical
information about Macintosh communications products and the
Macintosh in a network environment. The library includes an
introductory volume, Understanding Computer Networks, and
the comprehensive guide to the AppleTalk network system,

Inside AppleTalk.

The books in the Apple Communications Library are available
at bookstores.

APDA provides a wide range of technical products and
documentation, from Apple and other suppliers, for
programmers and developers who work on Apple equipment.
For information about APDA, contact

APDA

Apple Computer, Inc.
Mailstop 33-G

20525 Mariani Avenue
Cupertino, CA 95014

1-800-282-APDA (1-800-282-2732)
FAX: (408) 562-3971

Telex: 171-576

AppleLink: APDA
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Assistance for hardware and

336

software developers

If you plan to develop hardware or software products for sale
through retail channels, you can get valuable support from
Apple Developer Programs. Write to

Apple Developer Programs
Apple Computer, Inc.
Mailstop 75-2C

20525 Mariani Avenue
Cupertino, CA 95014-6299
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Appendix F

Glossary

A

active application The application program currently
being used. With MultiFinder, a number of
application Pl'()gl"ﬂin.‘; can l)(‘ open, b'l.l[ ()lll}' one
of them is the active application. The active
application is represented by a small icon at the
top-right corner of the menu bar. You can switch
from one application to another by clicking the
icon.

2 Active-application icon

active window The frontmost window on the
desktop, where the next action will rake place.
An active window's title bar is highlighted
(with a series of lines).

EC==nee's disk =0z litle bar

Sitems 38,337K in disk

&

Cartoons

ADB See Apple Desktop Bus.

Alarm Clock A desk accessory thart displays the
current time and date, and can be set to function
as an alarm.

alert box A box that appears on the screen to give a
warning or to report an error message during use
of an application program. Its appearance is
usually accompanied by a beep.

This process will erase all
information on this disk,

Ap])lc Desktop Bus  (Abbreviated ADB.) Built-in

circuitry of Apple computers. Apple

= Desktop Bus ports are on the computer’s

' back panel and marked with a
“branching” icon. You use them ro
artach the keyboard, mouse, and other
devices, such as graphics tablets, hand
controls, and specialized keyboards. Sce
also bus.

L
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Apple menu The menu farthest to the left in the
menu bar, indicated by an Apple symbol, from
which you choose application programs and desk
accessories.

About the Finder...

Alarm Clock

AppleTalk network The AppleTalk connectors,
cables, cable extenders, and software that link
computers and peripheral devices—such as
printers or file servers—together in a network.
AppleTalk capability is built into every
Macintosh and most LaserWriter models.

application program A program written for some
specific purpose, such as word processing,
database management, graphics, or tele-
communication. Most application programs are
represented by icons that show a hand working
with a document.

MacWrite  FullPaint  MacDraw Il

audio jack A connector on the back panel of the
Macintosh marked with a “sound” icon.
lﬂ \i\’]. You use the audio jack to attach
% headphones or other audio devices.

B

back panel The rear surface of the computer, which
includes the power switch, the power connector,
and ports for peripheral devices.

358

hack up (v) To make a copy of a disk or of a file on a
disk. Backing up your files and disks ensures that
you won't lose information if the original is lost
or damaged.

hit A contraction of binary digit. The smallest unic of
information that a computer can hold. The value
of a bit (1 or 0) represents a simple two-way
choice, such as on or off, true or false, black or
white, and so on.

bitmap A set of bits that represents the graphic image
of an original document in memory. Used by the
Macintosh to construct graphic images and
typefaces.

bitmapped character A character that exists in a
computer file or in memory as
a bitmap, is drawn as a pixel
pattern on the graphics screen,
and is sent to the printer as
graphics data. See also pixel.

bitmapped font A font made up of bitmapped
characters. For example, fonts stored in a
Macintosh System file are bitmapped fonts.

buffer A “holding area” in memory where
information can be stored by one program or
device and then read ac a different rate by
another. For example, some printers have built-in
memory to store text coming from the computer
faster than it can be printed. This memory is

called a print buffer.

bus Circuits inside the computer that ransmit
information from one part of a computer system
to another; for example, the Apple Desktop Bus.
In a network, a bus is a line of cable with
connectors linking devices together.
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button A pushbutton-like image in dialog boxes
which you click to designate, confirm, or cancel
an action. Compare mouse button.

(options ] [ Help |

byte A unit of information consisting of a fixed
number of bits. One byte usually consists of a
series of eight bits, and represents one character
(such as a letter, numeral, or punctuation mark).

See also kilobyte, megabyte.
cache  See memory cache, RAM cache.

Calculator A desk accessory that works like a four-
function pocket calculator. Calcularion results
can be cut and pasted into your documents using
the Cutand Paste commands from the Edit
mentt.

Cancel button A button that appears in some dialog
boxes. Clicking it cancels the command just
chosen.

central processing unit (Abbreviated CPU) The
“brain” of the computer; the microprocessor that
performs the actual computations. See also
Processor, COprocessor.

character Any symbol that has a widely understood
meaning and thus can convey information, such
as the letters, numerals, and punctuation marks
indicated on the computer’s keyboard.

check box A small box associated with an option in a
dialog box or window. When you click the check
box, you may change the option or affect related
options.

Printer Effects:

[CJ Font Substitution?

[ Text Smoothing?

[] Graphics Smoothing?
[ Faster Bitmap Printing?

chip See integrated circuit.

choose To pick a command by dragging through a
menu. You normally choose a command after
vou've sclected something for the command to
act on.

Chooser A desk accessory that lets you designate
devices, such as printers, that your Macintosh
will use.

About the Finder...

Alarm Clock
Calculator

Chooser
Control Panel

Clear A command in the Edit menu that removes
selected material without placing it on the
Clipboard. You can use the Undo command
immediately after using Clear if you change your
mind. Compare Cut.

click To position the pointer on something, and then

to press and quickly release the mouse button.

Clicking is normally used to select an icon, a

word or object in a document, a choice ina

window, or to confirm a choice in a dialog box.
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Cliphoard  An area in the computer’s memory that
functions as a holding place for what you last cut
or copied. Information on the Clipboard can be
pasted into documents.

Cut or copied 10 Cliphoard

Text or graphic

Pasted from
Cliphoard

The small white box on the left side of an
active window's title bar. Clicking it
closes the window.

color wheel - A feature that appears in a dialog box
when you click the Change Color button in the
Control Panel desk accessory. The color wheel
lets you adjust hue, saturation, and brightness of
the highlight color. It is also used to adjust shades
of gray.

command  An instruction that causes the computer

Ed

Undo 32

to PC['FO['I“ some action.

Macintosh commands are
the commands listed in a
menu. These are chosen by
using the mouse and
pointer. Others can be
typed from a keyboard.

300

The most common form of

conf iglll‘:llit m (DA gcneral—purpose computer term
that can refer to the way you have your computer
set up. (2) The combined hardware
components—computer, monitor(s), keyboard,
and peripheral devices—that make up a
computer system. (3) The software settings that
allow various hardware components of a
computer system to communicate with each
other,

Control Panel - A desk accessory that lets you change
various Macintosh features, such as speaker
volume and keyboard repeat speed and delay.

About the Finder...

Alarm Clock
Calculator
Chooser

Control Panel
Diskinfo

COProcessor - An auxiliary processor designed to
relieve the demand on the main processor by
performing a few specific tasks. Generally,
coprocessors handle tasks that could be performed
by the main processor but much more slowly.

Copy A command in the Edit menu that copies
selected material and places it on the Clipboard,
without removing the material from the original
document. See also Clipboard.

COpy-protect To make a disk uncopyable. Software
publishers sometimes copy-protect their disks to
prevent them from being illegally duplicated. See
also lock.

CPU

Sece central processing unit.

current application  See active application.
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current startup disk  The disk that contains the
System file the computer is currently using. The
startup disk icon always appears in the upper-
right corner of the desktop.

cursor  See pointer.

A command in the Edit menu that removes
sclected material and places it on the Clipboard;
from there you can paste it elsewhere. Compare

Clear. See also Clipboard.

Cut

cut and paste  To move something from one place in
a document to another in the same document or
a different one. It's the computer equivalent of
using scissors to clip something and glue to paste
the clipping somewhere else.

D

data disk A disk that contains your work—leteers,
budgets, pictures, and so on—in the form of
documents.

default A value, action, or setting that a computer
system assumes, unless you give it a different
instruction. (Also called preser.)

deselect  To change a selected item, such as an icon,
so that it is no longer selected. On the desktop,
you deselect highlighted icons by pressing the
Shift key and clicking the icon you want to
deselect, or by selecting something else without
pressing the Shift key.

desk accessories  “Mini-application programs” that
are available from the Apple menu at all times,
regardless of the program you're using. Desk
accessories provided with the Macintosh
include the Alarm Clock, Calculator, Chooser,
Control Panel, Find File, Key Caps, and
Scrapbook. You use the Font/DA Mover to

install desk accessories.

About the Finder...

Alarm Clock
Calculator
Chooser
Control Panel

Llesl\'[()p Your working environment on the
computer—the menu bar and the background area
on the screen. You can have a number of documents
open on the desktop at the same time.

Menu bar

e T Desktop
: Marquesa

1 Hame Size Kind st

400 AppleLink 5.0 — folder | frator;

{100 Design 83 - folder

[ Design 83 Word Setting... 3K Micros :trator &

1[0 HyperCard & Stacks -- folder bo

destination  The disk or folder that receives a copied
or translated file, as in destination disk.

dialog hox A box that contains a message, often
“requesting more information from you.
Sometimes the message is accompanied by
a beep.

Replace existing
“Gloss.3” ?

=¥esr ] - oo )
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dimmed A term used to describe words or icons that

appear in gray. For example, menu commands
appear dimmed when they are unavailable. A
dimmed icon represents an opened disk or folder,
or a disk that has been ejected. Double-clicking a
dimmed disk or folder icon causes the window
for the disk or folder to become the frontmost, or
active, window.

Dimmed command

Dimmed folder

D Super Paint icon
Dimmed program
TeachText Kon

(iil’L‘C[()l"_\‘ A list of the contents of a folder or a disk.

By using commands from the View menu, you
can set a directory window to present this list
pictorially, alphabetically, chronologically, or

according to size.
€

directory dialog hox A type of dialog box you use

disk

to locate files and change disks from within an
application program. Directory dialog boxes
appear whenever you choose the Open or Save
As commands from within an application
program.

A flat, circular, magnetic surface on which
information can be recorded in the form of small
magnetized spots, in a manner similar to the way

sounds are recorded on rape. See floppy disk,
hard disk.

disk capacity The maximum amount of data a disk

302

can hold, usually measured in kilobytes (K) or
megabytes (MB). For instance, Apple 3.5-inch
disks typically have a disk capacity of 400K,
800K, or 1.4 MB. Hard disks can hold from
20 MB to 160 MB, and some even more.

disk drive  The device that holds a disk, retrieves

information from it, and saves informartion on it.
All models of Macintosh computers contain at
least one built-in disk drive.

document  Whatever you create with an application

program. Documents are
usually represented by icons
derived from the icons of the
programs that created them.

See also file.

document icon

double-click To position the pointer on an object,

drag

such as an icon, and then press and release the
mouse button twice in quick succession without
moving the mouse. Double-clicking an icon
opens the document, application program, or
disk that the icon represents.

To position the pointer on something, press and
hold the mouse burton, move the mouse, and
release the mouse button. When you release the
mouse button, you either confirm a selection or
move an object to a new location.

driver A system program that allows the

microprocessor to direct the operation of a
peripheral device, such as a printer or scanner.
(Also called a resource.) Drivers are represented by
icons; to begin using drivers with the devices
connected to your Macintosh, you usually drag
their icons to your System Folder and restart the
computer.

Driver icons

ImageWriter LQ ImageWriter
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Easy Access A feature of Macintosh system software
thar assists people who have difficulty typing on
the keyboard or manipulating the mouse.

Edit menu A menu that is available in most programs
and lists editing commands—such as Cut, Copy,
and Paste.

fingo

Cut H
Copy %C
Paste #U

eject To remove a disk from a disk drive.

error message A displayed message thar tells you of
an error or problem in the execution of a
program or in your communication with the
computer system. An error message is often
shown in an alert box and accompanied by a
sound.

expansion card A removable circuit board thac plugs
into expansion slots in some models of
Macintosh computers. Expansion cards enable
the compurer to use some types of devices or to
perform special functions.

expansion slot - A long, thin socket on the main
circuit board of some Macintosh models into
which you can install an expansion card that
expands the computer’s capabilities.

1 Expansion slot

F, G

file server A combination of a mass-storage device
(such as a hard disk) and software that allows
computer users to share common files and
application programs through a network.

file Any named, ordered collection of informarion
stored on a disk. Application programs and
documents are examples of files. You make a file
when you create text or graphics, give the
material a name, and save it on a disk.

File menu A menu tha lists commands that affect
whole documents—commands such as Save,

Print, and Quit.
New 3EN
Open... 30
Close #W
Save 3#S
Save As...
Delete...
Page Setup...
Print... #P
Ouit a0

o
[
LS
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Finder A part of Macintosh system software that's
always available, creating the deskeop
environment. You use the Finder to manage
documents and application programs, and to get
information to and from disks.

(& File Edit Uiew Special

e e

Locked D
Finder
== System Software Yersion 6.0.5

P7 663K avail:

3.8 d
Kind: System document
Size: 110,914 bytes used, 109K on disk
er dos
Where: Hard Disk, SCS10 Bhare] | 2

Find File A desk accessory that enables you to find
any folder or file on a disk.

ﬂ()p[)‘_\;' disk A disk made of flexible plastic that stores
computer data. The 3.5-inch disks
used in Macintosh disk drives are
floppy disks housed in rigid, plastic
containers for support and
protection.

folder A holder for documents, programs, and other
folders on the desktop. Folders let you organize
information in any way you want.

[ ]

System Folder  Utilities Folder

font A collection of letters, numbers, punctuation
marks, and other typographical symbols with a
consistent appearance; the size and style can be
changed readily.

This is New York font.

This is Geneva font.

304

Font/DA Mover A udility program, supplied wich
Macintosh system software, that
(4L lets you add or remove fonts and
Font/Da Mover ek accessories from a disk’s
System file.

format  See initialize.

H

hard disk A disk made of metal and permanently
scaled into a drive or cartridge. A hard disk
stores very large amounts of information
(20 MB-160 MB) and operates much faster than
a floppy disk.

L]

I-beam A type of pointer shaped like the capiral letter
‘T" and used for entering and
editing text. See also
insertion point.

statinnEgI

[-heam

icon An image that represents an object, a concept,
or a message. For example, an unopened
HyperCard stack’s icon looks like a stack of
cards; a floppy disk’s icon is a miniature of that

type of disk.
o &
Document Trash Floppy Disk  HyperCard Stack

initialize To prepare a blank disk to receive
information by organizing its surface into tracks
and sectors; same as format.
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Input  Information transferred into a computer from
some external source, such as the keyboard, the
mouse, a disk drive, or a modem. Compare
output.

insertion point - The place in a document where
something will be added; it is
placed by clicking at the spot
where you want to make the
change and is represented by a

blinking vertical bar.

stationkry

Insertion point ‘

Installer A program thar lets you install or update

your system software or add
&

Iresources.
Installer

integrated circuit (IC) - An electronic circuit entirely
contained in a single piece of semiconducting
material, usually silicon. Often reférred to as a

chip.
intertace The point of communication between a

person and a computer. Often referred to as the
computer’s human interface or user interface.

K

K See kilobyte.

Key Caps A desk accessory that shows you the
optional character set available for a given font
family.

keyboard equivalent A combination of key presses
that you can use instead of a mouse action to
perform a task. Keyboard equivalents almost
always include the Command key, and are
convenient alternatives to using the mouse to
choose menu commands. Also called a
Command-key equivalent or keyboard shortcut.

select Al 24— Keyboard equivalent

Show Clipboard

kilobyte A unit of measurement consisting of 1024

bytes. See also byte, megabyte.

L

LocalTalk cable system A system of cables, cable
extenders, and connector boxes that connect
computers and network devices as part of the
AppleTalk necwork system.

lock To prevent files or disks from being altered.
Individual files are locked with
software commands. A disk can
be physically locked by sliding the
small tab on the back of the plastic
case of a 3.5-inch disk roward the

edge of the disk.

M

main l()f;’i(;' hoard A large circuit board that holds
RAM, ROM, the microprocessor, custom-
integrated circuits, and other components that
make the computer work.
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NN memory  The part of a computer’s memory
whose contents are directly accessible to the
microprocessor; usually synonymous with
random-access memory (RAM). Programs are
loaded into main memory, where the computer
keeps information while you're working,
Sometimes simply called meniory. See also
random-access memory, read-only memory.

megabyte (MB) - A unit of measurement equal to
1024 kilobytes, or 1,048,576 bytes. See also byte,
kilobyte.

memory - A hardware component of a computer
system that can store information for later
retrieval. See main memory, random-access
memory, read-only memory.

memory cache Memory chat is dedicated to
increasing the efficiency and operating speed of
the computer. Some models of Macintosh
computers offer an internal connector for an
optional memory cache card. Compare RAM
cache.
menu - A list of actions from which you can choose.
Menus commonly appear when you point to and
press menu titles in the menu bar or in a dialog
box. You choose a command by dragging
through the menu and releasing the mouse
button when the command you want becomes

highlighted.

menu The white strip across the top of your
screen that contains the titles of the menus
available to you.

(6 Flle Edlt View Special
B :
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menu title - A word, phrase, or icon that is in the
menu bar and that designates one menu.
Positioning the pointer on a menu title and
holding down the mouse button causes the title
to be selected and its menu to appear below it.
You then drag to choose a command.

% File View Specml

Hade

Cut
Copy
Paste
MMear

modem  Shore for modulator/demodutator. A device
that links your computer to other computers and
information services over telephone lines.

modem port A connector on the computer’s back
. panel marked by a telephone icon. A

(™ port that you can use to attach a modem
\:\) to the computer, or to connect tlle
computer to the AppleTalk network
system.

MoNitor - See video monitor.

mouse A small device that controls a pointer on the

screen. When you move the mouse

on a flat surface, the pointer

moves.

mouse button  The mechanical button on top of the
mouse. In general, pressing the mouse button
initiates some action on whatever is under the
pointer on the screen, and releasing the button
confirms the action.

Mouse Kevs  An Easy Access feature that lets you use
keys on the numeric keypad to move the pointer.
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MS-DOS  An acronym for Microsoft Disk Operating
System. This is the operating system for
computers manufactured by many computer
companies.

MultiFinder A part of Macintosh system software
that allows the computer to use multiple
programs simultaneously by alternating between
programs. An icon at the top-right corner of the
menu bar shows the current application program.
Clicking the icon changes applications.

N

network A collection of interconnected, individually
controlled computers, together with the hardware
and software used to connect them. A network
lets users share data and peripheral devices such as
printers and file servers, exchange electronic mail,
and so on.

Note Pad - A desk accessory that lets you enter and edit
small amounts of text while working on another
document.

NuBus An address bus and data bus incorporated
into the Macintosh 11 line of computers. NuBus
lets you add a variety of components to the
computer system, through expansion cards
installed in NuBus expansion slots inside the
computer. See expansion slot.

numeric keypad A caleulator-style keypad, to the
right of the main keyboard, that
you can use to type numbers.
The layourt of numbers on the
keypad makes it easier and faster
to use than the the number keys
on the regular keyboard. Some
application programs designate
the keys on the numeric keypad
as special function keys.

O

open To make available. You open files in order to
work with them. Opening an icon causes a
window to come into view, revealing the
document or application program the icon
represents. You may then perform further actions
on the contents of the window.

OpPerdling system - A program that organizes the
incernal activities of the compurter and its
peripheral devices; an operating system performs
basic tasks such as moving data to and from
devices, managing information in memory, and
50 on.

output Information transferred from the computer’s
microprocessor to some external device, such as
the display screen, a disk drive, a printer, or a
modem. Compare input.

P, Q

password A secret word that gives you, but no one
else, access to your data or to messages sent to
you through electronic mail or an information
service.

Voyates 4 . L

Paste A command in the Edit menu that puts the
contents of the Clipboard—whatever was last cut
or C()picd at the insertion point. See also

Clipboard.

peripheral device A piece of hardware—such as a
video monitor, disk drive, printer, or modem—
used with a computer and under the computer’s
control. Peripheral devices are often (but not
always) physically separate from the computer
and connected to it by cables.
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pixel Shore for picture element. The visual
representation of a bit on the screen (white if the
bitis 0, black if it’s 1). Also a location in video
memory that corresponds to a point on the
screen. See also bit.

POINLEr - An arrow or other symbol on the screen that
moves as you move the mouse. You
use the pointer to choose commands,
move data, and draw in graphics
programs.

Port: A socker on the back panel of the computer
where you can plug in a cable to connect a
peripheral device, another computer, or a
network.

printer poit A connector on the computer’s back
— panel marked with a printer icon. A
) 57 serial port that you can use to attach a
E=13 printer to the computer, or to serve as
an attachment point for an AppleTalk
CONNector.

processor The computer hardware component that
performs the actual compurations directed by
software commands. In microcomputers such as
the Macintosh, the processor is a single integrated
circuit called a microprocessor. See also central
processing unit.

Program A set of instructions describing actions for
a computer to perform to accomplish a task,
conforming to the rules and conventions of a
particular programming language. Computer
programs are collectively referred to as soffware.

pull-down menu - A menu that is hidden until you
move the pointer to its title and press the mouse
burton. See also menu, menu bar, and menu

title.

308

RAM ' See random-access memory.

RAM cache A portion of the Macintosh main

memory (RAM) that you can set aside for special
use. You use the Control Panel to turn the RAM
cache on or off. Compare memory cache.

random-access memory  (Abbreviated RAM.)

Memory in which information can be referred to
in an arbitrary or random order. RAM usually
means the part of memory available for programs
and documents that the computer reads from a
disk; the contents of RAM are lost when the
computer is turned off. Compare read-only
memory.

Read Me document A document that is included on

some application program and system software
disks to provide you with late-breaking
information about the product.

read-only memory  (Abbreviated ROM.) Memory

whose contents can be read, but not changed.
Information is placed into read-only memory
only once, during manufacturing. The contents
of ROM are not erased when the compurer’s
power is turned off. Compare random-access
memory.

resource A file thar is contained in the System Folder

and that the computer uses for its operations.
System files and drivers are examples of resources.

RGB monitor A type of color monitor that receives

separate signals for each color (red, green, and

blue).

ROM  See read-only memory.

Appendix F: Glossary



save  To store information by transferring it from
main memory (RAM) to a disk. Work not saved
disappears when you wrn off the compurer or
when the power is interrupted. It’s a good idea to
save your work frequently so that you lessen the

risk of losing dara.

scanning order  The order in which the operating
system scarches the disk drives for a starcup disk.
See also startup disk.

Scrapbook A desk accessory in which you can save
frequently used pictures or passages of text. The
Scrapbook can store multiple images. You can
cut, copy, or paste images from the Scrapbook
into documents created with most application
programs. Compare Clipboard; see also cut and
paste.

screen fonts  The fonts provided with Macintosh
system software; also known as bitmapped fonts.
You use a version of the font for each size of type
you want to display on the screen. (A different
version of fonts is used for printing,)

scroll To move a document or directory in its
window so that a different part of
it is visible. To scroll through

a document or directory, you use
the scroll arrows, scroll bars, or
the scroll box.

==

@

SCSI - See Small Computer System Interface.
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SCSI cable terminator A device used in a SCSI chain
to maintain the integrity of the signals passing
along the SCSI chain. A SCSI chain should
always have two terminators, one at cach end of
the chain. With some devices, the terminator is
built-in.

SCSIchain A group of SCSI devices linked to one
another through SCSI peripheral interface cables
and linked to the SCSI port on the computer
through a SCSI system cable.

SCSIport The connector on the back panel of the
computer to which you connect SCSI
devices.

select To designate where the next action will take
place. To select something with a mouse, you
click an icon or drag across text or graphics.

selection  The information or items that will be
affected by the next command. A selected item
is usually highlighted.

serial ports The connectors for peripheral devices
that receive data in a serial format (chat is, one bit
at a time), such as the printer and modem ports
on the Macintosh.

Shift-click A technique that allows you to extend or
shorten a selection by holding down the Shift key
while you select (or deselect). You can also Shift-
click multiple items in a list or group to select
them all.

Shift-drag A technique thar allows you to select two
or more groups of objects by holding down the
Shift key while you drag diagonally to enclose
each group of objects in a rectangle.
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SIMM' An acronym for Single In-line Memory

Module, a circuit board that contains eight RAM
chips. SIMMs attach to SIMM sockets on the
computer’s main circuit board. See also random-
access memory.

size box A box on the bottom-right corner of some

active windows. Dragging the
size box resizes the window.

Small Computer System Interface (Abbreviated

SCSI) A specification of mechanical, electrical,
and functional standards for connecting
peripheral devices such as certain kinds of hard
disks, printers, and optical disks to small
computers. Macintosh computers use the SCSI
interface for hard disks and other peripheral
devices.

source The disk or folder that holds the original of

a file to be copied or translated, as in source

disk.

startup disk - A disk with all the necessary program

files—such as the Finder and System files
contained in the System Folder—to set the
computer into operation.

startup drive The disk drive from which you start

your computer system.

Sticky Kevs An Easy Access feature that lets you type

combination keystrokes without actually pressing
the keys simultaneously. Sticky Keys are especially
helpful for users with impaired motor skills.

oystem file A fle that Macintosh compurers use

to start up and to provide
systemwide information. The
System file must be in the
System Folder.

System

System Folder A folder containing the software that

Macintosh computers use to
start up. A disk that contains a
System Folder is a startup disk.

Systern Folder

SYStem sofware Sefrware components that support

T

application programs by managing system
resources—such as memory—and input and
output devices. Also known as the operating
systen.

TeachText A ility program on the System Tooks disk

that functions as a limited word-
prOthSSing pmgr:lm.

TeachText

[CIMINALOT See SCSI cable terminator.

3.5-nchdisk A flexible, plastic disk measuring 3.5

inches in diameter and having a rigid plastic
jacket. On the Macintosh, 3.5-inch disks are the
standard type of floppy disk used. These disks
store 400K, 800K, or 1.4 MB of informarion,
depending on the type of disk drive and
formatting used. See also kilobyte, megabyte.
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title bar - The horizontal bar, at the top of a window,
that shows the name of the window’s contents.
When the window is active, the title bar is
highlighted with a series of horizontal lines.

B uene ey Tile bar
206K available | ::

To Do

Trash  An icon on the desktop that you use to discard
documents, folders, and
= application programs. You can
]”] also drag disk icons into the
Trash Trash to eject disks.

U

unlock  To remove the restriction on the use of a disk
or a document so thart it can once again be
changed, deleted, or renamed. See also lock.

user group - A computer club where computer users
exchange tips and information.

user interface  See interface.
utility programs - Programs you use to perform special
operations, such as installing or updating

software, seeing a magnified version of the
screen’s contents, and so on,

V

Version: A number indicating the release edition of a
particular piece of software.

video monitor A display device that can receive video
signals by direct connection only, unlike a
television set, which can receive broadcast signals.
Sometimes simply called a monitor.

VIruS - A malicious program that damages files. Virus
programs can be spread though networks and
bulletin board services as well as on disks. Virus-
detection and elimination programs are available
through dealers and user groups.

volume - A general term referring to a storage device; a
source of or a destination for information.
Often used in reference to hard disks and file
servers. A volume can be an entire disk or only
part of a disk.

W, X, Y

Window  The area that displays information on the
desktop; you create and view a document
through a window. You can open or close a
window, move it around on the desktop, and
sometimes change its size, scroll through it, and
edit its contents.

Write  To transfer information from the computer to a
destination external to the computer (such as a
disk drive, printer, or modem), or from the
computer’s processor to a destination external to
the processor (such as main memory).

Z

200m box A small box in the top-right corner of the
title bar of some windows.
Clicking the zoom box expands
the window to its maximum size;
clicking it again returns the

: e i T
window to its original size.

FEK available
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Numeric Entries

12-hour clock
setting and location 214, 215
24-hour clock
setting and location 214, 215
3.5-inch disks (MS-DQOS). See also devices; disks
initializing 337
reading with Apple SuperDrive 336
32-Bit QuickDraw
installing 64
5.25-inch disks (MS-DOS). See also devices; disks
reading from an external floppy drive 339
720K
MS-DOS normal-density floppy disk size,
initializing 339

A

AJUX. See also alternative operating systems; Apple
File Exchange
Function keys, use with 326
setting up a hard disk to run with 170
warnings about hard disks containing 48, 168,
171

About command (Apple menu)
Apple File Exchange, investigating options 345
displaying informartion about application
programs with 150, 153
Finder, verifying memory amount with 103
accent
accute (") 330
grave (1) 330
access. See also security
privileges, on a file server 200
accessing. See also opening
file servers
on AppleShare 196
private files on 200
menus 20, 21, 23, 24
Access Privileges (desk accessory). See also file
servers; networks
AppleShare file server and 187
protecting folder contents with 181
access protection.
See passwords; security
activating. See also selecting
windows 12
active window 12
acute accent ()
entering with Option-e 330
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ADB. See Apple Desktop Bus
adding. See also connecting
desk accessories 253
devices 265-287
fonts 249
Macintosh to a network 183-193
adjusting. See changing
air circulation. See also maintenance; ventilation
importance for heat dispersion 293
alarm
setting and turning oft 218-220
Alarm Clock. See also desk accessories
desk accessory, setting alarm, date, and time
with 216, 218-220
icon, on menu bar 221
turning off the alarm 221
alert
boxes, using 28
flashing, setting the 214
sound, setting the 213
time, setting with the Alarm Clock desk
accessory 216
alignment. See also graphics; printing
of bit-mapped areas, with LaserWriter 119
allocating memory. See memory
alternative operating systems. See also A/UX; MS-
DOS; ProDOS
converting files from 336-345
Special keys, use with 327
amplifier. See also devices; sound
attaching to the audio jack 276
APDA 355
Apple
service and support information 318
technical information available from 354
Apple Care Service Agreement
characreristics of 319
Apple Communications Library

description 355

374

Apple Desktop Bus (ADB)
devices, connecting 273-276
ports
connecting devices to 273
diagnosing input problems 306
power requirements 273
Apple Developer Programs
description 356
Apple Extended Keyboard
key descriptions (figure) 326
Apple File Exchange. See also networks
use with MS-DOS files and disks 336-345
Apple HD SC Setup program
using 168-170
Apple TIGs
sharing a hard disk with (partitioning) 170
Apple Keyboard
key descriptions (figure) 324
Apple menu. See also menus
About command
as clue to where you are 94
for application programs 20, 150, 153
About the Apple File Exchange command 345
About the Finder command, verifying memory
amount with 103
Chooser desk accessory 39-41
file server connection with 196
output devices, selecting 116
printers, designating in 116-118
printers, network setup 192
printers, setting up background 130
printers, solving problems with 312
finding active programs 95
Find File desk accessory 144-146
General Control Panel location in 36
Key Caps desk accessory 328, 329
Scrapbook desk accessory, editing operations in
91
top line of, as clue to where you are 94

Index



AppleShare. See also networks
driver, installing as preparation for networking
187
file server 196-200
file server, using MS-DOS files on 343
AppleShare PC program
converting MS-DOS files with 343
AppleTalk network 183-201. See also Local Talk;
networks
activating with the Chooser (figure) 41
connecting printers to 269
selecting devices on with the Chooser 39
zones, listed in the Chooser window (figure) 41
Apple Technical Library
description 355
application programs. See also desk accessories;
software; system software
active, finding out which is 95
copying, as installation method 72
creating new documents from within 74
displaying information about 153
cjecting disks from within 160
importance of keeping only one version on hard
disks 315
installing 72
in use, effect on discarding icons 15
managing multiple 97
memory
changing allocation for 105
checking allocation for 104
open
at startup, specifying 66 (table), 98-100
finding out which are 95
opening 73, 76, 101
operations common to all 71-111
printing from 122, 194
quitting 74, 109
relationship with system software 48
returning to desktop from 96
starting 73, 76, 101
switching with MultiFinder 100

arrow keys. See also keyboard
alternative to mouse for pointer movement 323,
325; 32T
primary use, in summary of special keys (figure)
42
arrow(s)
pointer as 2
scroll, displaying window contents with 16
attaching. See connecting
audio devices. See also devices; sound
connecting to audio jack 276
automatic repair. See also troubleshooting

with Disk First Aid 297

B

background. See also MultiFinder
editing desktop pattern 223, 242
printing
controlling with PrintMonitor program 131
turning on and oft in the Chooser (figure)
41
using a print server with 195
backing up. See also security; viruses
data, by saving documents 84-93
date view useful for 150
devices for, SCSI tape drives as 266
disks 165, 175
documents, by copying individually 137
files 110
strategies for 317
Backspace (Delete) key
deleting selected text 33, 323
barcode readers 273. See also Apple Deskeop Bus
devices; devices
battery. See also maintenance
clock, changing 300
beep. See also sound
changing
type of sound 213
volume of sound 211

Index 375



Berkeley Macintosh User Group
address 354
binary wanslation
Apple File Exchange use for 339
bits 269
blinking. See also Control Panel; customizing
alarm icon in menu bar, meaning of 221
command, meaning of 22
menu item, changing speed of 225
question mark icon, meaning of 305
BMUG
See Berkeley Macintosh Users Group
bomb icon 309. See also troubleshooting
boot. See startup
Boston Computer Society
address 354
brightness control. See also monitors; screen saving
adjusting 234
diagnosing monitor problems with 304
screen saving with 291
bulletin boards. See also networks
accessing with a modem 201
C
cables. See also devices
daisy chaining SCSI devices with 267
handling precautions 290
LocalTalk network 185
calendar icon
changing date with 217
canceling. See also deleting
background printing jobs 132
editing actions 83
Caps Lock key
keyboard diagrams (figures) 322, 324, 326
cards. See also devices
expansion, installing and use 281-285
cassette tape icon (MacroMaker) 332
CDEV (Control Panel devices)
as potential cause of software incompatibility

315

370

CD-ROM drives. See also devices; disks
connecting 266
cedilla (¢). See also characters
entering with Option-c 330
changing. See also adding; deleting; installing
beep
type of sound 213
volume of sound 211
blinking
insertion point, speed 225
menu item, speed 225
Chooser settings 41
clock battery 300
Control Panel 38, 203-263
date 38, 217
desktop
appearance 221
patterns 238, 23, 242
disks
from the desktop 159
from within a program 160
documents, saving after 86
General Control Panel 37, 38
highlight color or gray shade 244
icon
color or gray shade 244
name 29-34
MacroMaker scripts 335
memory allocation for a program 105
mouse operation 204-207
networks 190
pointer movement between multiple monitors
227
programs, in MultiFinder 100
RAM cache size 106
screen brightness 234
sound 211-214
speaker volume 38
startup disk 176
time of day 38, 215
windows 11
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characters. See also customizing; editing
deselecting 31
entering
international 330
optional 328
repeating, adjusting the rate of 209
manipulating (appendix) 321
checking
Clipboard contents 78
installed system software 49
memory available 104
Chooser desk accessory 39-41. See also desk
accessories
file server connection with 196
output devices, selecting 116
printers
designating in 116-118
network setup 192
solving problems with 312
printing, setting up background 130
choosing. See also selecting
commands 7, 21
font name, for Key Caps display 330
printers 116-118
circumflex (A). See also characters
entering with Option-i 330
classes
Macintosh, where to find 354
cleaning. See also maintenance
mouse 294, 306
system components 294-296
Clear command (Edit menu). See also Cut
command
deleting
selected texr in an icon name with 33
text and images permanently 82
with Scrapbook, use of 93
Clear key 323, 325, 327
clearing. See also deleting
icons from the desktop 14
system memory 104

clicking 4. See also double-clicking; mouse; selecting
double-clicking, description of 5
in scroll bar 19
selecting objects by 8
in window to make it active 13
Clipboard. See also editing
checking contents of 78
copying text and images to 77
Cut command use of 33
deleting (cutting) text and images to 82
inserting text and images into a document from
78
clock
battery, changing 300
icon, clicking to change time 215
internal 214
system, purpose of 300
Close box
closing windows with 13
(figure) 9
Close command (File menu)
closing windows with 13
CloseView Control Panel 350, 351
closing. See also opening
windows 13
cloverleaf. See Command key
color. See also gray shade; monitors
desktop patterns, editing 224, 242
display of, designating 235
highlight, changing 244
how to use 235
icons
designating and viewing by color 244, 245
listing the contents of a folder by 150
images, enhancing with 32-Bit QuickDraw 64
numbers of 235
printing, installing drivers for 114
wheel dialog box 238, 240
Color bar (Desktop Pattern area of General
Control Panel) 242
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Color button (Monitors Control Panel) 237
Color Control Panel
components of (figure) 235
Color menu
changing icon colors with 244
Command key
menu equivalent use of 22, 322, 324, 326

primary use, in summary of special keys (figure)

42
Sticky Keys combinations 347
Command-C (Copy command, Edit menu) 78
Command-D (Duplicate command, Edit menu)
138
Command-E (Eject command, File menu) 159

Command-I (Get Info command, File menu) 152

Command-Q {Quit command, File menu) 74
Command-S (Save command, File menu) 86
Command-Shift-1

ejecting, floppy disks with 159, 308
Command-Shift-2

cjecting, external floppy disks with 159, 308
Command-Shift-Clear

turning Mouse Keys on and off with 349
Command-V (Paste command, Edit menu) 79
Command-X (Cut command, Edit menu) 82
Command-Z. (Undo command, Edit menu) 83
commands. See also keyboard shortcuts, specific

command names

choosing 7, 21

core, list of (figure) 20

creating macros for 331

dimmed, meaning of 22

dots following, meaning of 26

highlighted, meaning of 22

initiated, blinking as indicator of 22

keyboard equivalents, displayed in menu 22

special keyboard keys for 42

378

commercial information services
accessing with a modem 201
communications. See also AppleShare; networks
link, establishing 271

programs, directing modem operation with 201

compact Macintosh models
attaching additional monitors to 280
turning on 44
computers
networks, using the Macintosh on 183-201
operation, problems 304
sharing
with hard disk partition 170
by use of a network 183
configuration
hardware, recommended minimum 51
connecting. See also adding; installing
Apple Desktop Bus (ADB) devices 273-276
audio devices 276
computers with a modem 201
keyboard 273
Macintosh to a network 183-193
modems 271
monitors 276-281
mouse 275
non-SCSI devices 269
printers 269, 271
SCSI devices 266
Control key
generating optional characters with (figure)

329

primary use, in summary of special keys (figure)

42

Sticky Keys combinations 347
use similar to Command key (figure) 324, 326
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Control Panel desk accessory 203-263. See also
customizing; desk accessories
CloseView Control Panel 351
Color Control Panel, components of (figure)
235
customizing the work space with 203-263
General Control Panel 214
changing, blinking of insertion point, menu
item 225, 226
changing, desktop pattern 223-224
changing, desktop pattern in color or gray
shades 242-244
changing, networks 190
changing, RAM cache 106
changing, sections and settings 37, 38,
203-263
changing, speaker volume 212
description and use (figure) 35-38
designating a startup disk from 177
opening 36
position in startup scanning order 176
setting date and time 214
settings that may be adjusted, list of 36
Keyboard Control Panel, adjusting character
repetition with 208-210
Monitors Control Panel
specifying main monitor with 231-233
specifying number of colors or gray shades
with 235
specifying relative monitors position with
227
Mouse Control Panel 204, 206
Network Control Panel, changing networks
with 190-191
Sound Control Panel
adjusting sound volume with 211
setting alert sound with 213

Control Panel devices (CDEV)
as potential cause of software incompatibility
315
conventions
document version naming 88
converting
Apple 11 files with Apple File Exchange 345
Macintosh files into MS-DOS format 339
MS-DOS files 339, 345
coprocessor cards
installing on Macintosh 11 models 281
Copy button (Font/DA Mover) 256
Copy command (Edit menu)
application programs use of (figure) 20
copying text and images 77, 79
Scrapbook use of 93
copying. See also Clipboard; editing; Scrapbook
desk accessory
application programs, as installation method 72
desk accessories, from one file to another 258
disks, as backup method 165
documents
between disks 137, 90
on the same disk 88, 138
files
as backup procedure 110, 175
from a file server 200
fonts, from one file to another 250
images 77,79, 91
network software onto a startup disk 188
sclected graphics or text, effect on contents of
Clipboard 77
text
between application programs 91
between documents 78, 79
correcting. See also changing
problems, strategies for 313
typing crrors 85
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crash. See also maintenance; security
system, strategies for handling 309
creating. See also changing; editing
documents
and saving them 85
hierarchy of 143
multiple versions of 88
procedures for 74
files of desk accessories and fonts 260
folders 141-143
log, translated files 344
macros 331-335
startup disks 60-63
systems
customized 56-60
small 62
standard 52
crosshair pointer. See pointers
current (electric). See power
cursor. See also pointers
movement, arrow keys as mouse alternative 42
customizing
hardware by adding devices 265-287
working environment 203-263
Cur command (Edit menu). See also editing; Paste
command
application programs use of (figure) 20
compared with Clear command 82
deleting
selected text in an icon name with 33
text and images without losing them 82
Scrapbook use of 93
cut sheet feeder use. See also printers
setting for ImageWriter 121

D

daisy-chaining. See also devices
ADB devices 273, 275
description 266
SCSI devices 267

data. See also application programs; editing;
hierarchical file system (HFS); translating
avoiding loss 302
backing up, by saving documents 84-93
deleting 161, 168, 174
preventing damage to 302
sending to other computers by modems 201
date. See also time
listing the contents of a folder by 150
setting 38, 221, 217
DCA-RFT/MacWrite translator file. See also files
converting MacWrite and MS-DOS files 339
delaying key repeat interval 210
Delete key
compared with, Clear key 327
correcting typing errors with 85
deleting
characters to the left of insertion point with
325,327
selected text in an icon name with 33
text and images permanently 82
primary use, in summary of special keys (figure)
42
deleting. See also Clear command; Cut command;
erasing; removing
desk accessories 258
files 161,168, 174
fonts 251
from the Scrapbook 93
icons 14
images 82
selecred items 77
text
in an icon name 33
in a document 82
deselecting. See also selecting
active translators 341
characrers 31
icons 30, 33
selecred objects 8
text 31
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designating
icon color 244
main monitor 231-233
printers 40, 192
zones 192
designing expansion cards 355
desktop
changing 221-234
pattern 38, 223, 242
clearing icons from 14
components of (figure) 9
editing, basic procedures 29
moving around the 9
opening
documents from 76
programs from using MultiFinder 101
pattern 223, 242
printing from 123
putting away items on the 149
rebuilding, avoiding problems by 317
renaming
disks from the 164
documents from the 139
returning to 96
desk accessories. See also Apple menu; application
programs; fonts; software; system software;
specific desk accessories
creating file of 260-263
description 35
incompatible, as potential cause of system crash
310
list of required and optional 63
managing 253-263
moving 246
removing from System Folder 62
sources of 246
specifying for startup (table) 66
switching with MultiFinder 100

destination disk
specifying in Apple File Exchange procedures
340
destroying. See deleting
detecting viruses 302
devices. See also Apple Desktop Bus (ADB) devices;
cables; disks; drivers; modems; monitors;
outpurt devices; printers; resources; storage
devices
adding 265-287
connecting
non-SCSI 269
SCSI 266
selecting 40
diagnosing problems. See also troubleshooting
disk 297
strategies for
general 313
virus 302
dialog boxes
alert boxes as a type of 28
description and use (figure) 26
pop-up menu use in (figure) 24
dimmed commands
meaning of 22
directories. See also files; folders; hierarchical file
system (HES)
obtaining information about 150
printing 124
directory dialog box
for saving files (figure) 84
moving around folder hicrarchy with 146
using a 26
discarding. See also deleting
icons 14
disconnecting. See also connecring
from a file server volume 199
Disk First Aid
repairing disks with 297
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disk(s). See also floppy disks; hard disks; high-

density disks
backing up 165, 175
creating startup 60-63
drives
installing system software on a one-drive
system G0
managing 155-181
port, connecting floppy disk drives to 273
ejecting 159, 160
erasing 161, 163, 168, 174
exchanging, with MS-DOS computers
336-345
5.25-inch disks 339
floppy
characteristics and use 156-166
creating small systems on 62
installing system software on 60
fragmentation, reducing 315
hard
characteristics and use 166-175
initializing 168-170
partitioning 170
renaming 175
initializing 161, 168
installing fonts on different 247
locking, to protect information 179
managing 155-181
moving
desk accessories between 254, 258
fonts between 250
naming 29, 162, 164, 168
partitioning, hard 170
problems, causes and suggested solutions 307
repairing 297
startup, designatinga 176
testing 297
3.5-inch 288, 289

displaying
background patterns, available 223
character sets for fonts 330
document contents 5
files, information aboutr 150
folders, information about 150
icon contents 5
information, with Ger Info command 151
messages on the screen 26
window contents by the screenful 19
Document Content Architecture.
See DCA-RFT
documents. See also application programs; editing;
fonts; text
changing, names 29
copying
between disks 90, 137
on the same disk 138
text and images between 79
to different folders on the same disk 88
creating 74
hierarchy of 143
multiple versions of 88
displaying the contents of 5
editing 76-83
finding 144
handling, Macintosh tools for 136-153
icons, double-clicking, to start an application
program 74
moving 136
naming
correcting typing errors in 85
in application programs that automarically
save 86
new 85
version conventions 88
opening
from the desktop 76
from within an application program 75
in a directory dialog box 27
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documents (continued)
organizing 135-153
pasting, text and images into 78
placing in folders 142
printing 113-133
failure, causes and suggested solutions 312
on the network 194
renaming 139
when saving 87
without retaining a version 88
replacnw Alert box verification 89
saving 84-93
specifying for startup 66, 98-100
version handling 88
dotted rectangle
significance of 7
double-clicking. See also selecting
icons, to start an application program 73, 74
saving new desktop patterns with 224
speed, setting 206
windows, to make them active 13
downloadable fonts. See afso characters; fonts;
printing
description 119
dragging. See also moving
correcting typing errors with 85
documents 136
ejecting floppy disks by dragging to Trash icon
15
objects 5
pointer
to choose a submenu 23
in menus 22
resizing windows with 11
scroll box 18
selecting part of an icon’s name by 30
windows 10

drawing. See also graphics
with the mouse, adjusting mouse tracking for
205
drivers. See also devices
adding by copying into System Folder 50
finding a list of system- -supplied 52
mstailmg, as preparation for networking 187
printer, msmllmg 114
programmmg, where to find help with 355
removing from System Folder 62
system resources in the System Folder (figure)
49
Duplicate command (File menu) copying
documents with 138
duplicating. See also copying
files 138

E

Easy Access program
characteristics and use 347-349
Easy Install option (Installer program) 52-55
editing. See also adding; Clipboard; copying;
creating; deleting; Scrapbook desk
accessory
canceling most recent action 83
desktop
basic procedures 29
changing document names with 139
patterns 223, 242
renaming disks 164
documents 76-83
on the file server 200
reversing Undo command 83
Scrapbook contents 93
text 77—-83
actions common to all application programs
76-83

selecting while 7
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Edit menu
application programs use of (figure) 20
Clear command
deleting selected text in an icon name with
33
deleting text and images permanently 82
Scrapbook use of 93
Copy command
copying text and images with 77, 79
Scrapbook use of 93
Cut command
compared with Clear command 82
deleting selected text in an icon name with
33
deleting text and images without losing them
82
Scrapbook use of 93
Paste command
copying text and images with 81
inserting text and images into a document
from 78
Scrapbook use of 93
Show Clipboard command 78
Undo command, canceling editing actions with
83
Eject command (File menu)
ejecting floppy disks with 159
ejecting Hoppy disks 159-160
after display of “sad Macintosh” icon 305
failure, causes and suggested solutions 308
from within a program 160
electrical safety. See also maintenance;
troubleshooting
precautions when setting up 290
Empty Trash command (Special menu)
erasing icon contents with 14
ending
macro recording 334
work sessions, good methods for 109-111

384

enlarging. See also resizing
paper size, implications of 119
windows 11
entering. See also characters
optional characters 328
Enter key
initiating actions with 324, 325, 327
primary use, in summary of special keys (figure)
42
environment
clues to finding out where you are 94
Erase Disk command
(File menu, Apple File Exchange), erasing non-
Macintosh disks 344
(Special menu), erasing disks with 163, 174
erasing. See also deleting; editing; removing
disks
floppy 161
hard 168, 174
non-Macintosh 344
with Erase Disk command 163
macros (figure) 333
error messages 20.
See also problems
errors
See changing; correcting; editing; mistakes
Escape
See Esc key
Esc key
primary use, in summary of special keys (figure)
42
program-dependent function key 324, 327
Ethernet
connecting Macintosh to 183
installing 187
everyone
file server access privilege, description 200
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exchanging
disks and files, with MS-DOS computers
336-345
files, reading MS-DOS 3.5-inch disks on
SuperDrive 157
memory modules, as expansion method 287
expansion
cards
designing 355
installing 281-285
slots, NuBus in Macintosh Il models 281, 282
extending
selecred text 31
external floppy disk drives
ejecting floppy disks from 159
reading MS-DOS disks with 5.25-inch drives 339

l?

File menu
application programs use of (figure) 20
Close Command, closing windows with 13
Duplicate command, copying documents with
138
Eject command, ejecting floppy disks with 159
Get Info command
Changing memory allocation for a program with
105
displaying information about icons with 151
locking application programs and documents
with 152
New command, creating new documents with 74
New Folder comniand, creating and naming
folders with 141
Open command
opening icons with 10
starting programs with 74
Page Setup command, oprions, choosing 118-120
Print command
application programs use of 194
options 121
printing on a network 194

Print Directory command 125
Put Away command 149
Quit command 74, 109
Save As command, saving revised documents, by
changing the document name 87
Save command 85, 86
file(s). See also application programs; documents;
folders; hierarchical file system (HFS);
nerworks
backing up 110, 150
copying desk accessories between 258
exchanging
reading MS-DOS 3.5-inch disks with
SuperDrive 157
with MS-DOS computers 336-345
font
copying fonts from one file to another 250
using 247
managing, methods for 84-93
naming 85, 86, 88
opening in a directory dialog box 27
organizing, with View menu 150
printing a directory of 124
private, creating on a file server 200
receiving across a network 201
renaming 139
saving 84-93
disk problems, causes and suggested solutions
307
in application programs 84-93
Serapbook, handling 93
sending across a network 201
servers
selecting with the Chooser 39
using 196-200
sharing across a network 183
translating
creating a log 344
non-Macintosh files 339

versions 88
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file system
managing documents with 140-153
Finder. See also MultiFinder; system soltware
obtaining information about 103
specifying items to be opened under 66
Find File desk accessory. See also desk accessories
Apple Menu, using 144-146
finding. See also organizing
documents 144
files, limiting search 146
folders 144
5.25 inch disks (MS-DOS). See also devices; disks
reading from an external floppy drive 339
flipped image
LaserWriter Page Setup option 119
floppy disks. See also devices; disks
capacities 156
characteristics and use 156-166
creating small systems on 62
drives
connecting 273
protecting during transport 292
cjecting 15, 159
5.25-inch 339
handling precautions 292
installing system software on 60
locking 179
managing 156-166
MS-DOS format, initializing 3.5-inch 337
repairing 297
testing 297
folders. See also documents; files; hierarchical file
system (HFS)
contents, viewing 150
moving through levels of 24
opening in a directory dialog box 27
organizing documents with 140-149
protecting the contents of 181

380

Font/DA Mover. See also desk accessories; fonrs;
system software
creating files of fonts and desk accessories 260
installing, desk accessories with 189, 253
moving fonts and desk accessories with
246-263
removing
desk accessories with 258
fonts wich 251, 252
window layout description (figure) 246
fonts. See also desk accessories; documents; editing;
text
downloadable 119
managing 246-263
removing, from System Folder 62
substitution, LaserWriter Page Setup option
119
formarted disk.
See initializing
fragmentation
disk, reducing 315
memory, handling 104
freezing pointer
causes and suggested solutions 311
Function keys
Apple Extended Keyboard, alternative operating
system usc of 327
creating macros for, using MacroMaker 331
primary use, in summary of special keys (figure)
42

G

General Control Panel.
See Control Panel, General
Get Info command (File menu)
changing memory allocation with 105
displaying information abourt icons with 150,
151
locking application programs and documents
with 152
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global macros 335. See also MacroMaker
glossary
term and concept definitions 357-371
graphics. See also Apple Desktop Bus (ADB);
images; text
cards, NuBus, installing 281
tablets
adjusting mouse tracking for operation with
205
connecting 273
graphic smoothing
LaserWriter enhancement 119
grave accent (*)
entering with Option-' 330
grayed-out commands
meaning of 22
gray shades. See also color; monitors
changing 242, 244
specifying the number of 235
viewing icons by 245
grounding. See also maintenance
electrical, importance of 290
group. See also security
file server access privilege, description 200
guidelines
programming and user interface design for the
Macintosh, where to find 355

H

handicapped
physically, Easy Access features for 346-349
visually, aids for 350-352

“happy Macintosh” icon
meaning of 305

hard disks. See also devices; disks
connecting non-SCSI 273
connecting SCSI 266-269
drives 266
managing 166-175
problems, diagnosing 309
repairing 297
testing 297

hardware. See also devices; software
design, finding information on Macintosh 355
developers, assistance for 356
HD SC Setup program
testing SCSI hard disks with 299
headphones. See also Apple Desktop Bus (ADB)
devices; sound
connecting to the Macintosh 276
help
Macintosh organizations, user groups, and
literature 354
technical information 354
HES.
See hierarchical file system
hierarchical file system (HFS). See also directories;
files; folders; organizing
using 140-149
high-density disks. See also devices; disks
characteristics and use 157
highlighted commands
meaning of 22
highlighting. See also selecting
color
brightness of 240
changing 244
objects 5
removing 8
hooking up. See connecting
horizontal tab character.
See characters
humidity. See alse maintenance
optimal for Macintosh operation 293
HyperCard
automatic save feature of 86

Ld

[-beam pointer. See also pointers
description 30
inserting text with 34
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icons. See also user interface

im

Apple Desktop Bus 274

application program, starting by double-clicking

bomb, causes and suggested solutions 309
color 239, 244
deselecting 30, 33
dimmed, meaning of 9
discarding 14
disk
with blinking question mark 305
with X character 305
disk drive port 272
displaying the contents of 5
examples of (figure) 1
listing the contents of a folder by 150
modem (figure) 272
name
changing 29-34
deleting selected textin 33
inserting text in 34
selecting text in 29
opening 9
retrieving from the Trash 15
selecting 6
color or gray shade for 235
multiple icons 7
viewing by color 245
ages. See also graphics
copying 77,79, 91
deleting 82
inserting, from Clipboard into a document 78
pasting, into a document 78
saving, Scrapbook desk accessory use for 91

ImageWriter printers. See also devices; LaserWriter

388

printers; printers
background printing not available on 130
choosing 118
connecting to 269
network use of 192
printing options for 120, 121
problems, causes and suggested solutions 312

INIT files
as potential cause of software incompatibility
315
initializing disks
floppy 161
hard 168
MS-DOS 3.5 inch 337
normal-density, in MS-DOS formar 339
initiating. See starting
input devices. See also devices
connecting 273
inserting
floppy disks, in a disk drive 158
text, in an icon name 34
and images, into a document 78
insertion point. See also pointers
arrow keys as alternative to mouse for moving 42
changing the blinking speed 225
deleting character to the left of with Delete key
325
description 29
[nstaller program
Customize options 56-60
Easy Install option 52-55
options for 51
installing. See also connecting; devices; maintenance;
software
32-Bit QuickDraw 64
application programs 72
CloseView 350
customized systems 56-60
desk accessories 253
expansion cards, on Macintosh Il models 281
fonts 247
MacroMaker 331
memory cache cards 286
network software 188
NuBus cards, procedures and ventilation
warnings 282
printer drivers 114
system software 51-56

on floppy disks 60
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insurance. See also security
saving documents as 84-93
interface
NuBus, description 281
interference. See also maintenance
radio and television 293
international language characters. See also
characters
typing 330
internet. See also networks; zones
connecting multiple networks into 192
inverted image
LaserWriter page setup option 119

K
keyboard. See also Apple Desktop Bus (ADB)
devices; Control Panel
adjusting character repetition 209
connecting 273
Control Panel, changing keyboard parameters
with 208-210
diagnosing cable problems 306
equivalents, for commands, displayed in menu
22
handicapped assistance 347
handling spills 291
layouts and character sets 321-330
Macintosh Plus, connecting to the Macintosh
275
one-handed use 347
problems, diagnosing 306
shortcuts
Copy command (Command-C) 78
Get Info command (Command-1) 152
Duplicate command (Command-D) 138
New Folder command (Command-N) 141
Paste command (Command-V) 79
Print command (Command-P) 122
printing with Return key 123
Quit command (Command-Q) 74
Return key, shorteut for Save button in Save
dialog box 87

Save command (Command-S) 86
Undo command (Command-7) 83
special keys, using (figure) 42
keys. See also specific keys
arrow, alternative to mouse for pointer
movement 323, 325
Mouse Keys 348-349
repeating by holding down 209
Key Caps desk accessory
using 328

L

LAN (local area nerwork).
See Local Talk; networks
languages
entering international characters 330
LaserWriter printers. See also devices, ImageWriter
printers; printers
connecting 269
network use of 192
Page Setup options for (figure) 119
problems, causes and suggested solutions 312
light pens. See also Apple Desktop Bus (ADB)
connecting 273
lights
locking key indicators, (figure) 42
linking. See connecting
list
selecting itemsina 7, 8
loading. See also installing; starting
macros (figure) 333
local area network (LAN).
See Local Talk; networks
LocalTalk. See also AppleTalk; networks
connecting to 184-186
description
as an AppleTalk network type 183
as a work group network 269
locating. See finding
location
clues to 94
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locking (and unlocking). See also protecting; security
application programs, with Get Info command
152, 180
disks
as cause of inability to save to disk 307
to protect information 179
documents
effect on discarding icons 15
with Get Info command 152, 180
implications of 179
log
translated files, creating 344
M
Macintosh
expanding the system 265-287
format, converting non-Macinrosh files and disks
to 345
operations, description of standard 1-45
ready to run, how to recognize 49
setting up the system 47-69
shutting down 110
startup, specifying items to automatically open on
65-69
technical help, where to find 354
turning on and off’ 43-45
user groups, names and addresses 354
MacroMaker
command files, creating and using 331-335
macros. See also customizing
creating and using 331-335
MacWrite format
converting to and from MS-DOS 339
magnetic tape. See also devices
connecting to the Macintosh 266
magnification
screen, increasing and decreasing with CloseView
352
maintenance. See also security
avoiding trouble, positioning of monitors 281
maintaining a safe and reliable operating
environment 289-319

managing. See also maintenance; organizing
application programs 71-111
desk accessories 253-263
disks and disk drives 155-181
files 84-93
fonts 246-263
multiple application programs 97
printing jobs
with a spooler 195
with PrintMonitor 131-133
system memory 102
work environment
backing up files 110
maintaining a safe and reliable operaring
environment 289-319
manipulating
mouse, Mouse Keys as alternative to 348
manual paper feed. See also printing
handling with PrintMonitor 132
mathematical symbols
Numeric keys used for 325
memory. See also devices
allocating for programs 105
cache cards, installing 286
cards, installing on a Macintosh II-family
computer 281
expanding on the main circuit board 287
fragmentation, handling 104
installing 287
insufficient
MultiFinder alert that reports 102
suggested solutions 314
MulciFinder
checking the amount available 104
RAM cache, adjusting for efficient use 106
requirements 97, 103
system
clearing 104
managing 102
reserving for additional monitors 277
verifying the amount in your system 103
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where you are on the Macintosh

finding out 94
windows. See also user interface

activating 12

changing shape of 11

closing 13

components of (figure) 9

enlarging with zoom box 12

listing the contents of 150

moving 9, 12

opening 5

printing a directory of the files in 124

resizing 11

scrolling 16

viewing contents by scrolling 16
work groups. See also networks

connecting printers to networks 269

setting up virus-detection stations in 303
work sessions. See also maintenance; managing

good methods for ending 109-111
world. See also protecting

file server access privilege, description 200
wristwatch. See also pointers

pointer change to, during save operation 86
write-protect. See locking

7T

2y

X character. See also troubleshooting
on disk icon 305

Z

zones (network). See also networks

dividing a multiple network internet into 192

meaning of (figure) 39
sclecting 40
printers within 117
sharing files through 197
zoom box
enlarging windows with 12
meaning of (figure) 9
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[ viewing. See also organizing

umlaut (%) desk accessory sizes 256
entering using Option-u 330 fonts and font sizes 249
Undo command (Edit menu). See abo editing icons by color 245
canceling editing actions with 83 optional characters with Key Caps 328
Unix. See A/UX window contents 16, 150
unlocking, Seelocking View menu )
unreadable disk displaying information about directory contents
repairing with Disk First Aid 297 with 150
updating viewing icons by color 245
system sofeware 63, 310 viruses. See also maintenance; security;
uppercase letters troubleshooting
typing with Caps Lock key 322 strategies for prevention and elimination 302, 303
user interface. vision. See also handicapped
See deslctop; icons; menus; mouse; title bar; aids for visually handicapped 350
windows volume. See also sound
user name sound, changing 211
changing with the Chooser (figure) 41
V warnings. See also maintenance; troubleshooting
ventilation. See afio maintenance alert box use for 28
K = % & ! " et T ka1 1ele
monitor, warning against b]ockmg 291 A/UX, against lmuahung disk 48
NuBus cards 282, 286 auromatic emptying of "l"_ra_sh_ 14-
opening, warning against blocking 281 data loss during disk initialization 161
o . . . . . ~e .
verifying disk programs, diagnosing with Disk First Aid
memory amount in a particular system 103 _297
System Folder contents 49 electrical 290, 295
versions. See also editing; saving Hloppy drives 292
document, creating 88 hard disk care ]-67
Scrapbook, handling of 93 memory expansion 287
a = 3 . = ay 4t A 3 ¢ C
video. See also color; graphics; gray shades; monitors overwriting d"L“mL“_t-‘ 89
capability, effect on number of colors and gray MONITOTs, position of large 291
shades 236 power requirements, NuBus cards 283
ssitcls screen damage 291
connecting a monitor to 276, 279 SuperDrive, plastic placeholder should not be used
- . [§
listing those in use 236 2)2‘ .
monitor number determined by 227 system .\‘Ofm.'arc upgrade, importance of 310
NuBus, installing 281 ventilation, importance of 281, 282

port, connecting a monitor o 276 for monitors and Macintosh 281

socket, monitor number determined by 227
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terminating
work sessions, good methods for 109-111
terminators
connecting SCSI devices with 267
guidelines for using with SCSI devices (table)
268
testing. See also maintenance
disks 297
text. See also documents; editing
copying 77,79, 91
deleting 33, 82
deskrop editing operations 29
editing 77
icon name 29
extending selected 31
inserting, in an icon name 34
pasting, into a document 78
saving, Scrapbook desk accessory use for 91
selecting, while editing 7
smoothing, LaserWriter capability 119
translation, Apple File Exchange use for 339
32-Bit QuickDraw
installing 64
3.5 inch disks (MS-DQOS). See also devices; disks
initializing 337
reading with Apple SuperDrive 336
throwing away. See also deleting
unwanted applications, documents, and icons in
Trash 14
tilde (-). See also characters
entering with Option-n 330
time. See also date
changing 38, 215, 216
setting alert with Alarm Clock desk accessory
218
title
pop-up menus, meaning of 24
title bar, See also user interface
meaning of 9
moving windows with 10
trackball. See also Apple Desktop Bus (ADB);
devices
connecting 273

tracking
mouse, adjusting 204
transferring, See copying
ranslating
files 339
translator. See also Apple File Exchange
active 341, 344
files, description 337
options, saving 344
selecting a 343
transmission. See also networks
of data, by modems 201
Trash
discarding icon contents with 14
disconnecting from a file server with 199
ejecting floppy disks by dragging to 15, 159
icon meaning 14
triangle
in menu, meaning of 23
troubleshooting. See also maintenance
keyboard, handling spills 291
maintenance and 289-319
problems, causes and solutions 302-317
scrategies 302
turning off
alarm 221
Macintosh 43, 45
effect on Trash 14
turning on
alarm 218
Macintosh 43
MultiFinder 98
12-hour clock
setting and location 214, 215
24-hour clock
setting and location 214, 215
type fonts, sources of 246
typing. See also characters
accented characters 330
difficulties, using Easy Access to help with 347
errors, correcting 85
touch, adjusting for 210

Index 401



storing
documents, in folders 142
files, on the file server 200
floppy disks 292
folders, within folders 143
macros (figure) 333
strategies. See also maintenance; problems,
troubleshooting
problem solving 313
submenus. See also menus
opening and using 23
sunlight. See also maintenance
precaution against 293
SuperDrive
characterisrics and use 157
support. See also troubleshooring
Apple, information about 318
swapping
disks 160
Scrapbook files 93
switching
application programs or desk accessories, with
MulciFinder 100
disks 160
system
clock, purpose of 300
components, setting up 290
crash, strategies for handling 309
creating
customized 56-60
small 62
standard 52
files
finding a list of system-supplied 52
system resources in the System Folder (figure)
49
verifying what you need 49
memory
clearing 104
managing 102
System Additions disk

needed for installation 51

400

System 6.0
minimum recommended configuration 51
System Folder
contents
description and verification 49
for a Macintosh with a separate monitor
(figure) 50
driver installation, printers 114
importance of having only one version on hard disks
315
PrintMonitor location 132
system software. See also application programs; desk
accessories; software
installing 48, 49, 51-56
network, using 183
preparing for use 48
updating 63
upgrade, importance of 310
System Startup disk
needed for installation 51

i
Tab key
moving the insertion point horizontally to the right
322, 324, 327
wablet. See also Apple Desktop Bus (ADB); devices
graphics, adjusting mouse tracking for operation
with 205
tape backup. See also devices
connecting to the Macintosh 266
technical documentation
Macintosh, where to find 354
telecommunications. See also networks
connecting with another computer by 201
linking the Macintosh in telephone networks 271
telephone
lines, sending data to other computers by 201
networks, linking the Macintosh into 271
television. See also maintenance
interference on, handling of 293
temperature. See also maintenance
safe range 293

Index



shutting down. See also screen saving; turning off
effect on Trash 14
procedures for 110-111
SIMM (single-in-line memory module) 287
size
box
resizing windows with 11
(figure) 9
desk accessories, obtaining the 256
fonts, obtaining the 249
listing folder contents by 150
windows, changing the 11
slots
NuBus, description of 281
socket.
See port
software. See also application programs; desk accessories;
system software
developers, assistance for 356
problems

bomb icon, causes and suggested solutions 309

pointer freezing, causes and suggested solutions
311 N
version, incompatibilities as source of problems
314
sound
changing
volume 211
type of alert 213
connecting audio devices 276
Control Panel, changing sound settings with
211-214
speaker. See also sound
built-in, adjusting the sound volume of 211
volume, changing (figure) 38
Special keys
Apple Extended Keyboard, alternative operating
system keys 327
Special menu
Empty Trash command, erasing icon contents
with 14
Erase Disk command 163, 174

Restart command, changing startup device with
179
Set Startup command
specifying items to be opened with (figure)
65-6Y
turning MultiFinder on with 98
Shur Down command 45, 111
specifying. See designating
spooler 195. See also printers; PrintMonitor
starting. See also startup; stopping
application programs 5, 73
by opening documents 76
with MultiFinder 101
Font/DA Mover with Desk Accessories option
selected 257
Macintosh
preparing system for use 47-69
with MultiFinder on 98-100
macro script recording (figure) 333
operations with the mouse 2
printing 120
startup. See also starting
disks
adding network software to 188
creating 48, 60-63
designating 176
making more room on 258
removing fonts restrictions 251
problems with, causes and suggested solutions
309
specifying, items to be opened on 65-69
stereo miniplug. See also devices; sound
connecting audio devices with 276
Sticky Keys. See also handicapped
turning on and off 348
stopping. See also starting
macro recording 334
work sessions, good methods for 109-111
storage devices. See devices
storage media
disks, managing 155-181

Index
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SCSI (Small Computer Systems Interface) devices.
See also devices
connecting 266-269
ID number duplicated, as cause of failure o
recognize a hard disk 309
Search Here command (Find File menu) 146
searching. See also Find File command
for documents 144-146
security. See also access protection; locking; passwords
password protection in AppleShare 198
selected
menu item, blinking rate, adjusting the 225
objects, deselecting 8
text, extending 31
selecting. See also choosing; designating; editing
colors, number 233
commands 21
devices 40, 116
fonts to install 249
gray shades, number of 235
icons 6
colors 244
list
group of items ina 7
scparate items ina 8
monitors 231-233
multiple
desk accessories 256
files for translation 341
icons and objects 7
startup items 68
networks 190
objects 6
printers 40, 193
text
in an icon name 29
while editing 7
translators 343
sending. See also networks
data to other computers by modems 201
files across a network 201
serial
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ports, description 269, 271
transmission 269
service
Apple, information about 318
setting. See also changing; Control Panel
SCSI device number 266
Set Startup command (Special menu)
specifying items to be opened with (figure) 65-69
turning MultiFinder on with 98
setting up
monitors 281
networks 183
pages 118
printers 114, 187
system components 290
system software 48
720K
MS-DOS normal-density floppy disk, initializing
339
sharing
computers and other resources with network users
183
files 183, 196
shift-clicking 8. See also sclecting
Shift-Left Arrow
deselecting characters with 31
Shift-Right Arrow
extending selected texe with 31
Shift key
deselecting objects with 8
entering optional characters with 328
producing uppercase letters 322, 324, 327
Sticky Keys combinations 347
shortcurs
keyboard. See keyboard shortcuts
Show Clipboard command (Edit menu) 78
Shut Down command (Special menu) 111
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Return key
Enter key use for some functions 42
keyboard shortcut for Save button in Save dialog
box 87
moving the insertion point to the next line 323,
325, 327
reversing. See also editing
Undo command use for 83
revised. See also editing
documents, saving methods 86
RGB monitor.
See color; monirtors
ringing alarm icon
significance of 220

5

“sad Macintosh™ icon
meaning of 305
Save As command (File menu)
saving revised documents by changing the
document name 85, 87
Save command (File menu)
saving new documents with 85
saving revised documents, by overwriting previous
versions 86
saving. See also backing up; editing
automatically, HyperCard feature 86
desktop patterns 224
desk accessories 258
documents 84-93
files
disk problems, causes and suggested solutions
307
on the file server 200
fonts 251
icon name changes 30-32
images, Scrapbook desk accessory use for 91
information for quick retrieval. See Clipboard
macros 335
text, Scrapbook desk accessory use for 91
rranslator settings 344

version handling
documents 88
Scrapbook files 93
scanner. See also devices; SCSI
connecting to the Macintosh 266
scanning order 176
Serapbook desk accessory. See also desk accessories
editing
contents of 93
operations in 91
saving text and images in 91
version handling 93
screen. See also devices; monitors
changing
brightness level 234
highlight color on 244
cleaning 294
designating color or gray shade 235
magnification with CloseView 352
messages
displaying 26
responding to 26
moving pointer on, adjusting the speed 204
problems, causes and solutions 304
saving
precautions 291
programs for 304
turning down brightness control 234
viewing
enhancing through magnification 350
icons by color 245
scripts 331. See also MacroMaker
initiating recording of (figure) 333
scroll arrows
displaying window contents with 16
scroll bar
clicking to display window contents 19
description and use 16
scroll box
dragging to display window contents 18
scrolling 16. See also user interface; windows
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propeller key or symbol.
See Command key
protecting
data. See backing up; copying; locking; saving
hardware. See maintenance
software. See backing up; locking; security; viruses
pull-down menus 21. See also menus
pulling the power plug.
See roubleshooting
Put Away command (File menu)
putting away items on the desktop with 149

Q

question mark
on disk icon, meaning 305
Quit command (File menu)
copying between application programs, use of 80
quitting application programs with 74, 109
quitting
application programs 74, 109

R

radio
interference, handling 293
RAM (random access memory). See also memory
chips, SIMMs as a group of 287
expanding 287
RAM cache
MultiFinder use 106
setting in General Control Panel 106
random access memory. See RAM
rebuilding. See also maintenance
desktop, avoiding problems by 317
receiving. See alse networks
files across a network 201
recording. See also MacroMaker
keystrokes in a macro 331
recovery. See also troubleshooting
crash 309
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rectangle
dotted, significance of 7
reducing, See also printing
paper size 119
removing. See also deleting; erasing
desk accessories 62, 258
device drivers, from System Folder 62
floppy disks 14
fonts 62, 251
highlighting 8
icons 14
MacroMaker 332
resources, from System Folder 62
renaming. See also naming
disks 164, 175
documents 86, 139
non-Macintosh files 344
repairing. See also troubleshooting
disks, with Disk First Aid 297
repeating characters. See also characters; customizing
setting the rate and delay before 209
replacing. See also copying
desktop patterns, without saving 224
documents, Alert box verification 89
selected text, in an icon name 32
resizing, See also windows
windows 11, 19
resources. See also devices; drivers
description (figure) 49
removing from System Folder 62
sharing by use of a network 183
Restart command (Special menu)
changing startup device with 179
Restore settings command
(File menu, Apple File Exchange) 344
restoring. See also maintenance; troubleshooting
editing actions 83
translator settings 344
rt:trlC\'mg
files on the file server 200
icons from the trash 15
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printers. See also devices; ImageWriter printers;
LaserWriter printers
choosing 40, 116, 193
color, installing drivers for 114
connecting to the Macintosh 266, 269
drivers
installing 114, 187
supplied with system software (figure) 114
nerwork use of 187, 192, 193, 194
Page Setup options 118-120
port
connecting printers to 269, 271
connecting to a Local Talk network through the
184
print
area, implications of large 119
quality setting for ImageWriter 121
server description 195
problems, causes and suggested solutions 312
sharing by usc of a network 183
printing. See also documents
background printing
procedures for 130
rning on and off (figure) 41
direction of, setting for ImageWriter 121
directories 124-125
documents 113-133
on a network printer 194
keyboard shorteut,
Command-P 122
monitoring the status of 132
options 122
problems, causes and suggested solutions 312
time, setting the 132
PrintMonitor. See also MultiFinder
using 131-133
print server 195
priority
modem port compared with the printer port 271
SCSI devices, setting the 266

privileges. See also access protection; password;
protecting; security
file server access, description and use 200
problems. See also troubleshooting
computer operation, causes and suggested solutions
304
desktop doesn't appear, causes and suggested
solutions 304
disk not initialized message 307
disk unusable, causes and suggested solutions 307
disk won't eject, causes and suggested solutions
308
floppy disks, causes and suggested solutions 308
hard disk, causes and suggested solutions 309
keyboard, causes and suggested solutions 306
memory, not enough 314
mouse doesn’t move the pointer, causes and
suggested solutions 306
pointer freezing, causes and suggested solutions
311
printers, causes and suggested solutions 312
screen, causes and suggested solutions 304
software, symptoms, causes and suggested
solutions 309
startup, causes and suggested solutions 309
straregies for solving 313
viruses, strategies for preventing 302
processor-direct slot. See also cards; customizing
installing memory cache cards in 286
ProDOS operating system. See also alternative
operating systems
for Apple I computers, converting files from 345
products
new, where to see demonstrations 354
program.
See application programs; system software
programming
help with 355
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Paste command (Edit menu)
application programs use of (figure) 20
copying text and images with 81
inserting text and images into a document from
78
Scrapbook use of 93
pasting. See Paste command
pattern (desktop). See also customizing
changing
bit pattern 223
colors and gray shades 242
(figure) 38
displaying available 223
personalizing.
See customizing
pixels
background, editing the color of 243
description 224
playing
macros (figure) 333
pointers
arrow 2
crosshair, use in changing Control Panel
parameters (figures) 209-245
diagnosing problems 306, 311
dragging
to choose a command 22
to open a submenu 23
freezing, causes and suggested solutions 306,
311
I-beam
description 32
inserting text with 34
manipulating pointers with Mouse Keys 348
movement
between monitors, changing 227
changing the speed of 204
picking up mouse, effect on 4
wristwatch, indicator of save operation 86

394

pointing
description of 3
pop-up menus. See also menus
moving to a new folder level with 148
opening and using 24
seeing items that extend up from the tite 25
ports. See also Apple Desktop Bus (ADB); devices
modem 269, 271
non-SCSI, how to recognize 269
printer 184, 269, 271
SCSI description 266
positioning
monitors 281
power (electric). See also installing; maintenance
consumprion, NuBus cards 283
limits, NuBus cards 283
requirements 273, 283
switch, location of on different models 43
powering down. See also shutting down
effect on Trash 14
Power On key
Macintosh Il model, turning on computer with
45
primary use, in summary of special keys (figure)
42
starting system with 324, 327
precautions. See also maintenance; managing;
problems; troubleshooting
clectrical 290
floppy disks 292
power requirements, NuBus cards 283
system upgrade, importance of 310
preventing virus damage 302
Print command (File menu)
application programs use of 194
options 121
printing on a network 194
Print Directory command (File menu) 124-125
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opening. See also closing; starting
application program(s)
icons 73
with MultiFinder 101
Chooser 39
documents 75, 76
General Control Panel 36
icons 9
with Open command in File menu 10
on startup, specifying 65-69
menus 21
pop-up menus 24
submenus 23
windows, by double-clicking 5
operating systems. See also alternative operating
systems
multiple, running on the Macintosh 170
operations
initiating with the mouse 2, 3
standard Macintosh 1-45
Option key
primary use, in summary of special keys (figure)
42
special characters
Chicago font (figure) 329
producing 322, 324, 328
starting Font/DA Mover with 257
Sticky Keys combinations 347
typing accented characters with 330
Option-’
grave accent, entering with 330
Option-c
cedilla (¢), entering with 330
Option-Command-Down Arrow
decreasing screen magniﬁcation with 352
Option-Command-Up Arrow
increasing screen magnification with 352
Option-Command-X
turning screen magnification on and off with
352
Option-¢
acute accent, entering with 330

Option-i
circumflex (), entering with 330
Option-Shift key combination
entering optional characters with 328
special characters produced in Chicago font
(figure) 329
Option-u
umlaut (*), entering with 330
optional characters. See adso characters
entering 328
organizing. See also hierarchical file system (HES);
managing
documents 135-153
files
by icon color 245
with View menu 150
outline
of object, significance of 5
output devices. See also devices; printers
selecting 116
overheating. See also maintenance
precautions on 293
overwriting. See also replacing; saving
documents 86, 89
selected text in an icon name 32
owner
file server access privilege, description 200

P
Page Setup command (File menu)
choosing options 118-120
paper. See also printing
clip, as a hardware troubleshooting tool 308
positioning, LaserWriter page setup options for
119
size, ImageWriter LQ options 120
supply, monitoring the 132
partitioning
hard disks 170
passwords. See also access protection; security

entering in AppleShare 198
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MS-DOS. See also alternative operating systems
3.5-inch disks
reading on the SuperDrive 157, 336
converting files
on a file server 343
to and from MacWrite format 339
MulrtiFinder
capabilities 97
clues to finding out where you are 94
copying between application programs 80
installing
desk accessories 257
fonts 250
memory requirements and availability 103, 104
pointer freezing, possible cause 311
printing from the background 41, 130
RAM cache, adjusting for efficient MultiFinder
use 106
required for
printing from the background 41, 130
running multiple applications 97, 101
starting up with mulrtiple open documents
68
specifying items to be opening under 66
turning on and off 98-100
multiple application programs
managing, with MultiFinder 97

N

naming. See also renaming
disks 162, 168
documents 85
folders 141
icons 29
nesting. See also hierarchical file system (HFS);
organizing

folders 143

392

networks 183-201. See also AppleShare;
communications; modems
AppleTalk, selecting devices with the Chooser
39
Control Panel, changing networks with 190
devices, selecting with the Chooser 40
EtherTalk cards, installing 187
files, sharing on 196
interface cards, installing 187, 281
LocalTalk 185
printers
connecting to 269
print spoolers on 195
selecting within zones 40, 117
specifying with the Chooser 193
software, installing 187, 188
virus prevention when using 303
New command (File menu)
creating new documents with 74
New Folder command (File menu)
creating and naming folders with 141
NuBus. See also hardware
cards, installing 282-285
numeric keypad
keyboard descriptions 324, 325, 327
Mouse Keys defined on 348

O

objects
manipulating 5
selecting multiple objects in
one area 7
separate areas 8
office filing system
Macintosh metaphor, components of 135
Open command (File menu)
dialog box, (figure) 26
opening icons with 10
starting programs with 74
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menu bar
clues to finding out where you are (figure) 94
using 20-21
menus. See also user interface
accessing 20-21
pop-up 24
pull-down 21
application programs use of (figure) 20
choosing commands from 7, 21
commands, avoid using in global macros 335
in dialog boxes, recognizing 26
submenus, using 23
messages 26. See also problems; troubleshooting
microprocessor
exchanging signals with 281
mistakes. See also problems
strategies for correcting problems 313
typing, correcting 85
modem port
connecting printers to 269
use and advantages 271
modems. See alse devices; networks
connecting 201, 271
modifier keys. See also keyboards
entering optional characters with 328
including in a macro 334
modifying. See changing

monitors. See also Control Panel; devices; graphics;

video
adding additional 276
adjusting the brightness of 234
connecting to
compact Macintosh models 280
video cards 279
Control Panel, changing monitor parameters
with 227-245
maintenance of 291, 293
multiple
avoiding interference among 281
changing pointer movement between 227
designating the main monitor 231-233
indicating relative positions of 227
specifying color characteristics of 237

mouse. See also Apple Desktop Bus (ADB);

pointers
arrow keys as alternative for moving the mouse
42,323
button
description of 2
double-clicking speed 206
changing mouse operation 204-207
cleaning the 294
Control Panel, changing mouse operaton with
204-207
Macintosh Plus, connecting to the Macintosh
275
Mouse Keys, as alternative to 348
moving (figure) 2
picking up, effect on pointer 4
pointer
changing mouse movement relationship 204
moving mouse relative to 2
picking up mouse, effect on pointer 4
port
connecting mouse to Apple Desktop Bus
(ADB) port 273
Macintosh Plus different from the Apple
Deskrop Bus (ADB) port 275
problems, diagnosing 306
tracking, options for 204

Mouse Keys 348
moving. See also dragging; shift-clicking

around the
desktop 9
folder hierarchy 146
desk accessories 246
documents 136, 142
folders 143
fonts 246
insertion point
horizontally, with Tab key 327
to the beginning of the next line with Return
key 325
objects on the screen, by dragging 5
pointer (figure) 2
to a new folder level 148
windows 10, 12
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Sang To save the current screen as 88-Shift-3. The document is placed
screen images an t‘d‘lﬁblf’ and printable paint on the startup disk. You can take up
document* to 10 screen shots (automatically
named Screen Othrough Screen 9),
or more if you rename these.

To print the content of 98-Shift-4
the active window on !
Frat (i & i ¥ 8
an ImageWriter” printer® S
To print an image of the current With Caps
screen on an ImageWriter printer®  saShift-4 0% Y -
*Owners of modular Macintosh mocels: This works only | 2,{0!6# {

Monitors Control Panel.)

Ejec[ing To eject a s_clcctcc ] . %L =
ﬂOPPY disks (useoncof these 1. ods) . (}.hoose Eject from the
File menu.
» Drag the disk icon to the
Trash, (This also removes
the disk icon.)

To eject a disk from 32-Shift-1 :

the first drive . 2

To eject a disk from 32-Shift-2

he second drive

To eject a disk from 32-Shift-0

a third drive

To cject disks while using Click Drive until the name of the

a directory dialog box disk appears above the buttons,
Then click Eject.

To eject all floppy disks Choose Shut Down from the
Special menu.

Prmting To cancel a printing job in - &-Period ()

progress when not using il

background printing w1

‘ j A T AR uirbosde 8 Anxn L

l'o cancel a printing job g ~ aMonitor (by using the

in progress when using qu or clicking the icon at

background printing de of the menu bar) and

' Printing,

S



Keyboard shortcuts
on the desktop

Managing windows

& Macintosh Quick Reference Card

From the File menu
10 ucatc anew f()l(lu 38-N
To open a selected icon -0

l() close [hc

active window 3g-\V

To get information

about a selected icon $8-1
To duplicate

selected icons $-D

To eject a selected

floppy disk ®-E

From the Edtt menu

To undo the most 1Lcent
edit/change 8-7
To cut an item
to the Clipboard 8-X
To copy an item
to the Cliphoard 38-C
To paste an item
from the Clipboard 8-V
To select all items in
the active window %-A

To close all windows
on the desktop

To move an inactive window
without making it active

To activate a2 window hidden
behind other windows

To align all icons left to right, top
to bottom in the active window

To close all windows upon
returning to the desktop from
a program’

To open nested folders without
cluttering the desktop

‘MultiFinder® must be turned off.

© Apple Computer, Inc., 1990

Press Option while you choose
Close from the File menu or click
the active window's close h()\

Press 8 while vou (luo the
window by its title bar.

Find the dimmed icon related to
the hidden window (a disk or
folder icon), then double-click

1]](. dimmed i icon.

Press Option w hile you choose
Clean Up from the Special menu.
Press Option while you choose
Quit from the File menu.

Press Option while you open
successive levels of folders.

As you open each new folder,
the previous folder's window

automatically closes.

Apple. the Apple logo. TmageWriter, Macintosh, and MultiFinder are registered trademarks

of Apple Computer, Inc,
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14 How useful were the {llustrations in the Maci nlosh

Reference for performing step-hy-step actions?
notatall 1 2 3 & 5 6 vey useful

1) How useful was the index in the Macintosh

Reference?
1 havent used it
2 couldnt find what I needed
3 found some information I needed
4 usually find what I need
5 always find what I need

16 How useful was the glossary in the Macintosh

Reference?
1 haventused it
2 couldnt find what I needed
3 found some information I needed
4 usually find what I need
5 always find what I need

17. tave you kept the Special Features of Your

Macinosh hooklet?
1 no 2 yes

18.1 you could make one suggestion for improving

your Macintosh computer, what would it be?

Contact your authorized Apple dealer when you have
questions about Apple products. Dealers are trained by
Apple Computer and are given the resources (o handle
service and support. If you need the name of an Apple
dealer in your area, call toll-free 800-538-9696.

Thank you!

16 Or lape.)

*and seal, (P



g
’-x TGH Apple about your Macintosh 8.

What type of expansion cards are installed in your

and the documentation you received with it by answering the Macintosh?
questions below. Detach, fold, and seal this postage-paid 1 none
form and mail it to Apple. 2 video
Please circle the number of your answers below. If you 3 memory
have more than one answer to a question, circle all the 4 coprocessor
numbers that apply. 5 performance accelerator

6 communications or network
7 other
8 don't know

1. with which model of Macintosh computer did you
receive the Macintosh Reference (and this
questionnaire)?.

1 Macintosh Classic

6 Macintosh Ilci 9 To what type of network is your Macintosh connected?

2 Macintosh SE 7 Macintosh Ilcx 1 none 4 TokenTalk

3 Macintosh SE/30 8 Macintosh ilfx 2 localTalk 5 other

4 Macintosh LG 9 Macintosh Portable 3 EtherTalk 6 dont know
5 Macintosh ITsi 2

10. 1 you share information electronically, what method

2. How would you rate your Macintosh overall? do you use?

poor 1 2 3 4 5 6 excellent 1 don' share electronically
2 electronic mail
3. Which Apple computer model did you own bef 3 3 AppleShare file server
buying this Macintosh? . 4 TOPS
1 none 3 Macintosh family 5 other

2 Apple II family 4 other 6 don't know
11. How did you learn to use your Macintosh?
1 Macintosh Basics tour disk
2 Getting Started With Your Macintosh
3 Macintosh Reference

4 knowledgeable friend or co-worker

4. How long have you been using Macintosh comput
1 lessthan Imonth 4 1to 2 years
2 1106 months 5 2to3vyears
- 3 6Gmonthsto1year 6 morethan3ye .

-
D. How would you rate your level of expertise with 5 other non-Apple documentation
Macintosh computers ? 6 class
beginner 1 2 3 4 5 6 expen 7 trial and error

6. How much memory (RAM) do you have in your

Macintosh computer?
1 1to4MB
3 more than 8 MB

2 5108MB
4 don't know how much

What type and size hard disk drives are part of your
Macintosh system?

1 none 6 8( MP hard disk

2 internal hard disk 7 ot ard disk

3 external hard Jis' o s slorage
4 20 MB hard disk

5 40 MB hard disk

12 When you have questions as you work with your
Macintosh, where do you go for help?
1 Gerting Started With Your Macintosh
2 Macintosh Reference
3 knowledgeable friend or co-worker
4 application software manual
5 other non-Apple documentation
6 authorized Apple dealer

15 If you used the Macintosh Basics tour disk, how much

did it help vou learn to use your computer?
notatal 1 2 3 4 5 6 veryhelpful
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The Apple Publishing System
This Apple® manual was written, edited,
ancl composed on a desktop publishing
system using Apple Macintosh®
computers and Microsoft Word. Proof
pages were created on Apple
LaserWriter® printers and the QMS
ColorScript 100. Final pages were
produced in QuarkXPress and output
directly to film ona Linotronic 300, Line
art and chapter openers were created
using Adobe Illustrator 88,

Display type is Apple’s corporate font, a
condensed version of Garamond Text
type is Adobe Garamond. Omaments are
[TC Zapf Dingbats.

PostSeript, the LaserWriter page-
description language, was developed by
Adobe Systems Incorporated.
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